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CHAPTER ONE 

AN OVERVIEW 

WINDOWS 10 COMBINES THE BEST OF WINDOWS 7 AND WINDOWS 8.1 

Windows 10 is designed to be intuitive for users of both Windows 7 and Windows 8.1, incorporating the “best of 

both worlds” to enhance your experience and help you be more productive. 

A GUIDE TO THE BARE-BONES BASICS OF WINDOWS 10 

If you have just downloaded and installed Windows 10, you might find the following list of questions and answers 

will give you a “jump start” to your basic understanding of your new operating system. 

Where’s the Start Button? 

It’s in the lower-left corner of the Desktop. Click once to open and see the Start Menu. 

How do I find things? 

Type the name of the program, file, setting or webpage that you’re looking for into the Search Box that is located 

to the immediate right of the Start button. Then click once on the result to go to the program, file, or web page. 

How do I browse files or drives? 

Click on the Start button, then click File Explorer. (or use Windows key + E) 

How do I browse for an application? 

Click on the Start button. You can browse all of your programs alphabetically by scrolling through all of the 

applications that will appear above the Start button. Click on the target application and it will open. 

How do I browse the Internet? 
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Click the E icon on your desktop to open the new Edge browser. From there, you can type in your search request or 

website just like you did in earlier versions of Internet Explorer. 

What if want to use Internet Explorer (rather than Edge) as your browser? 

Click on the Start button, then Windows Accessories, then Internet Explorer. If you want, right-click on Internet 

Explorer, then click on More, then Pin to Taskbar. 

How do I get E-mail? 

You can open the Edge browser and go to your e-mail online, or type Mail in the search box and click on the result 

to open the Mail e-mail client that comes with Windows 10. Or browse under M to find Mail. If you have 

transferred Windows Live Mail from an earlier Windows version, you will find it listed under W. The same thing 

holds true with Gmail, except that you would find it listed under G. 

How do I write a document? 

Type WordPad into the search box and click on the result. You can also browse All Apps under W. (Wordpad is 

the only word processing app that is built into Windows 10. It has been that way since Windows 95.) If you had an 

authenticated copy of Word on your system before you upgraded, it will be available to you in Windows 10. If you 

have transferred Microsoft Word from a previous edition of Windows, type “word” into the search box. 

Where can I view and edit photos? 

Go to File Explorer (Winkey + E) and double-click on the Pictures folder. You’ll be able to view and organize the 

photos on your PC or click on the individual photo to share or edit. 

How do I play music? 

You can type Groove Music into the search box and click on the result, or you can type Windows Media Player and 

click on the result. Either app will allow you to play music on your PC.  
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What’s the Windows Store and how do I find it? 

The Windows Store is where you can download applications for Windows 10 as well as purchase music and 

videos. Click the Store icon (shopping bag) on your taskbar. Or type Store in your search box and click on the 

result. Once the store is open, you can search for apps by category or name. You’ll find both free and paid apps 

here. (You must be signed in to your Microsoft account to download any apps to your computer from the Store.) 

How do I get older programs to work with Windows 10? 

Type compatibility into your search box, then click on the result. The Program Compatibility Troubleshooter will 

open and walk you through ways to fix compatibility problems. 

How do I find such applications as Internet Explorer, Paint, Character Map, Notepad, and the Snipping 

Tool? They are not listed individually in the alphabetical list of applications. 

From Start, go to Windows Accessories, where you will find many of the classic legacy apps. Any of these can be 

pinned to the Taskbar or pinned to Start. 

How do I make Windows easier to read/hear/use? 

Type ease of access into the search box and click on the result. You’ll take a quick survey and Windows will then 

make suggestions for changing settings. Check the changes you’d like to make and choose apply. 

How do I turn off my PC? 

Click on the Start button which will cause the Power icon to appear. After clicking on the Power icon, you will be 

able to choose between Sleep, Shut down and Restart. 

Caveat: The Shutdown button is not obvious (it’s hidden in the Power button on Start) plus the font size can be 

quite small. 
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You might find it advantageous to create a shortcut icon for Shutdown and place it on the Taskbar. To do so, right-

click on the Desktop, go to New, then Shortcut. Enter shutdown /p as the location of the item, and press Next. Now 

name the shortcut Shutdown and press Finish. Right-click the shortcut that now appears on your Desktop and 

navigate to Properties. Choose Change Icon in the Shortcut tab, and then OK to exit the warning box. Choose 

(click) an icon of your choice from the list.  Finally, click OK. Right-click the shortcut again, and select Pin to 

Taskbar.   
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CHAPTER TWO 

WINDOWS 10’s BACKUP AND RECOVERY TOOLS 

Windows 10 includes many different backup tools. Microsoft has restored the old Windows Backup tool that was 

present in Windows 7, and File History is still around. But those are just the tips of the iceberg. 

The latest version of Windows also includes a way to back up and restore system images, wipe your computer to 

its default state, store files online, and make recovery drives you can use in case of emergency. 

FILE HISTORY (see Chapter Three for additional details) 

File History is the recommended way to back up your data files and is integrated into the Settings app (Winkey + 

I), then Update and Security, then Backup. 

This feature is limited in that it only backs up files located in the six major folders: Desktop, Documents, Backups, 

Pictures, Music, and Videos. Any data files that fall outside one of these folders will not be included in File 

History. 

Once you have set up your File History, Windows can automatically create backup copies of your files. You can 

use it to restore all your files if you ever lose them, restore a single file, or roll back a file to an earlier version. 
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RECOVERY DRIVE CREATOR 

The “recovery drive” that comes with most computers (but is hidden) is a clone of the computer's hard drive as it 

was at the time it was shipped by the manufacturer. Restoring the contents of the recovery drive returns the hard 

drive to its factory-new state. Of course, all your personal settings; user-installed software; and personal data files 

are not restored. But at least you have a working system that's not fouled up with malware or registry errors. 

You can create a USB recovery drive (must be at least 8GB) that will allow you to access advanced startup 

options, even if your Windows 10 installation becomes completely damaged in the future. To create a recovery 

drive, open the Search box, type RecoveryDrive.exe into the box, and press Enter. (see the first clip that appears 
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on the next page). This procedure will allow you to create the recovery drive. Once it has been created, you will be 

able to boot from this drive to access the five Advanced Options (see blue background clip on next page) if 

Windows won’t allow you to access them normally. 
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SYSTEM RESTORE FEATURE 

Windows 10 includes other troubleshooting features found in previous versions of Windows, too. If your computer 

becomes unstable, you can use the system restore feature (notice that it is one of the five Advanced Options) to 

revert your system files and settings back to a known-good state. 

SYSTEM IMAGE RECOVERY 

To utilize this feature, you must have created a clone or image of your entire system. This must be done when your 

computer is running in a good state. Go to Control Panel (Windows + X, then P), then Category View, then System 

and Security. Finally, Backup and Restore (Windows 7). 
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Microsoft has included the old Backup and Restore feature from Windows 7. This was removed from Windows 

8.1, but it’s back now in Windows 10. It’s also known as “Windows Backup.” As mentioned above, you will find it 

in the Control Panel’s Category View, under System and Security: Backup and Restore (Windows 7). 

This feature allows you to create an entire image of your current Windows system, including your operating 

system, installed programs, settings, and user files. This backup can be stored on an external hard drive provided 

that the external drive has a capacity that is at least as large as the size of the primary drive. (The backup is too 

large for a USB drive.) Note that this feature is far more important to reclaiming your entire system than the 

recovery drive feature. 

The steps to create a system image are captured by the program that is represented by the clip on the following 

page. 
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THIRD-PARTY IMAGING/CLONING PROGRAMS THAT ARE HIGHLY RECOMMENDED 

EASEUS TODO BACKUP FREE is widely touted as a top choice for free backup software. Aimed at Windows 

home users, and designed for ease of use, Todo Backup Free offers "one-click backup and restore" to protect your 

files and help you recover in the event of a data disaster. The software backs up your entire hard drive including the 

operating system and installed software. You can schedule your complete backups to run automatically, or backup 

only selected files and folders on a daily, weekly or monthly basis.  

MACRIUM REFLECT FREE is best known as a tool to make system images, but it's also an excellent backup 

software option. It can clone a hard drive (make an exact file-for-file copy) or create a backup image with optional 

incremental updates. Computer guru Bob Rankin uses Macrium Reflect to create a weekly backup image and daily 

incrementals, so that his backup is never more than one day old. You can also use it to backup just selected files or 

folders. The scheduling feature lets you automate your backups. For even the novice or intermediate user, the 

program is quite intuitive and offers outstanding flexibility in making both clones and images. 

ACRONIS TRUE IMAGE is probably the “Cadillac” of the cloning/imaging/backup industry. The cloning 

operation copies the entire contents of one disk drive to another to get two identical drives with the same file 

structure. The "Disk Clone" tool effectively copies all of the contents (including the operating system and installed 

programs) of one hard disk drive onto another hard disk drive. Therefore, you don’t have to reinstall and 

reconfigure all of your software. 

RESET THIS PC (just one step above using the Recovery Drive. 

Rather than relying on system image backups, some people use the “Reset this PC” feature to restore your 

computer to its default operating system state. This also replaces the need to ever reinstall Windows from scratch 

using an installer DVD or USB drive — just tell Windows to reset your PC and it’ll go back to its factory default 

settings. One caution: This procedure will allow you to keep your personal data files, but all your applications 

and settings that you have added since setting up your machine will be deleted. 

http://www.todo-backup.com/products/home/free-backup-software.htm
http://www.macrium.com/reflectfree.aspx
http://www.ugr.com/Products.html
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To accomplish a reset, open Settings (Windows + I), select Update & Security, select Recovery, and click the “Get 

started” button under “Reset this PC.” 

You can tell Windows to keep your user files and reset the operating system and installed programs to their default 

state, or remove everything. If you remove everything, you can tell Windows to securely erase the drive — 

something you should do before getting rid of a Windows 10 computer or any other device. 

 

ADVANCED STARTUP OPTIONS 

To access the advanced Startup options, open Settings, select Update & security, select Recovery, and click 

“Restart now” under Advanced startup.  

From here, you can restore Windows from a system image you created earlier, use system restore to correct 

problems, and perform other maintenance tasks. This menu should also appear if your computer attempts to boot 

properly and can’t. 
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A CLEAN REINSTALL OF WINDOWS  

Reinstalling Windows is an important strategy for anyone who wants to start over with a clean copy of the 

operating system. By doing so, you can remove bloatware, wipe out malware, and fix other system problems. 

A full, clean reinstall is different from the Reset This PC option, or a manufacturer’s recovery partition. Those 

built-in options will set your PC back to its factory-default state—which could include some vendor-installed junk 

you never wanted anyway. A clean install uses the generic Windows installation media that you can download 
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from Microsoft (https://www.microsoft.com/en-us/software-download/windows10/), and it’ll have just the OS, no 

other frills. 

You shouldn’t need to regularly reinstall Windows to keep it performing well. But, if a computer is bogged down 

by startup programs, context menu items, and years of junk, reinstalling Windows may be the quickest way to 

speed it up again. 

Reinstalling Windows can also save a computer infected with malware and other system problems caused by 

software issues. 

Before you begin, back up all of your personal data. While you should back up your data regularly, it is especially 

important to do so before reinstalling an operating system. 

In Windows 10's Anniversary Update (July 29, 2016), Microsoft is experimenting with a new "Give your PC a 

fresh start" tool that will allow you to reinstall Windows directly from a tool, erasing even all that manufacturer-

provided junk. It should be just as good as installing Windows 10 from scratch. Look for a "Learn how to start 

fresh with a clean installation of Windows" option at the bottom of the Recovery pane after upgrading to the 

Anniversary Update. 

Below is what the screen will look like! 

https://www.microsoft.com/en-us/software-download/windows10/
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CHAPTER THREE 

BACKUP YOUR IMPORTANT FILES WITH  

WINDOWS 10’S FILE HISTORY 
(a second drive is required) 

This is a decidedly handy feature that's worth devoting a large-capacity flash drive to, if only to preserve your most 

precious documents. 

UNDERSTANDING WINDOWS 10′S FILE HISTORY BACKUP SYSTEM 

The trouble with traditional backups. Until relatively recently, the best backup tools for Windows came from 

third parties — not Microsoft. But that’s changing. Although Windows XP included a basic backup applet and 

Vista had a better one, it was not until Windows 7 that Microsoft shipped a complete, built-in backup and recovery 

system with its desktop operating system. And there’s also still a myriad of top-quality, free and commercial, third-

party backup tools available. 

Unfortunately, a wealth of backup options hasn’t convinced most Windows users to make regular backups. For 

many, the process is still too much of a hassle. 

Windows 10′s goal: No-effort system backups. File History is a backup application that continuously protects 

your personal files stored in Documents, Pictures, Music, Videos, Desktop, Favorites, and Contacts folders. It 

periodically (by default every hour) scans the file system for changes and copies changed files to another location. 

Every time any of your personal files have changed, its copy will be stored on a dedicated, storage device selected 

by you. Over time, File History builds a complete history of changes made to any personal file. 

File History works and it’s undeniably easy to use. Its all-but-invisible, automatic backups will be a boon to the 

majority of users who never before bothered to make backups. 
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BACK UP YOUR FILES WITH FILE HISTORY 

With File History, you can back up the files in your Documents, Pictures, and Music folders, Contacts folder, 

Favorites folder, and the Desktop. After File History is turned on and a backup location is established, Windows 

handles the backups automatically.  

File History backs up only your aforementioned folders. If you have some folders elsewhere and want to also back 

them up, you can include them in one of your folders mentioned in the paragraph above. 

File History also stores all the file versions you create, depending on how you set it to work. By default, File 

History keeps all versions of all files it backs up, forever. However, it can be set to keep files either until space is 

needed or for a limited time period (such as a month or three months). You can then use File History to revert to a 

previous version of a file, if you need to. This feature works best with external storage devices such as hard disks 

or large USB memory drives that have sufficient space for the copied files. File copies can be restored at any time 

on the same computer or on other Windows devices and computers, which can be useful if your system crashes or 

encounters problems with corrupted data.  

By using File History, you can ensure that your important data are always backed up and available.  

TO TURN ON FILE HISTORY 

To turn on File History and use it to back up your data files, plug an external hard disk into your computer, then 

follow these steps:  

1. Go to Settings (Windows + I), then Update and Security, then Backup 

2. A window as shown below will appear 

3. Wait for File History to detect suitable drives for use; then click Turn On.  
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CONFIGURE FILE HISTORY 

You can configure how File History works and adjust settings such as how often File History saves copies of your 

files and how long it keeps saved versions of your files.  

To set how it works, follow these steps:  

1. Using Step 1 in the section above, arrive at the Backup using File History window. 

2. Click More options. The Backup Options window appears. 

3. Establish how you want File History to work by setting how often it should save copies of files and for how 

long it should keep saved versions. (Note that the default is to save every one hour.) 
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4. Now move down to the Backup These Folders section. Click on the + sign to add a folder. 

5. Click on any folder that you wish to exclude from File History and then click on the related remove button. 

6. Close File History. 

USING FILE HISTORY TO RESTORE FILES AND FOLDERS 

Just as it’s easy to get File History started, it’s also easy to recover your data from File History.  

Here’s the short-form “how-to”: Just return to the File History window (Windows + I, Update and Security, then 

Backup) and click More Options, then Restore files from a current backup that appears at the bottom of the page.  

 

This is a representation of the “current backup folders” on Bill’s computer as of a specific date.  
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CHAPTER FOUR 

YOUR USER ACCOUNTS 

FIRST QUESTION DURING INSTALLATION: USE A MICROSOFT ACCOUNT? 

Please note: You do not need a Microsoft account to access your Windows 10 computer. Nor do you need a 

password. However, a Microsoft account must have a username and password/pin to access Windows 10. 

When you set up Windows 10, the first thing you’ll be asked is whether you want to log into your Windows system 

with a Microsoft account.  Your Microsoft account will require a username and password (or pin) and can be any 

email account of your choice. It’s probably best to use a Web-based account such as Gmail so that you can easily 

access it from any computer anywhere in the world. 

If you log in with a Microsoft account, many desktop settings (including your wallpaper) will sync between all 

your PCs that have the same Microsoft account. You’ll be automatically logged into Microsoft services like the 

OneDrive client integrated into Windows. A Microsoft account is required if you want to use some of the features, 

such as acquiring apps from the Windows Store. 

WHY HAVE A MICROSOFT ACCOUNT 

When you sign in to your PC with a Microsoft account, you can obtain apps from the Windows Store, back up your 

important data and files (up to 5 GB) using OneDrive cloud storage, and keep all your favorite stuff—devices, 

photos, friends, games, settings, music, and so on—up to date and in sync. 

To check whether you're signed in with a Microsoft account: 

1. Press Windows + I. 

2. Click Accounts. This action will take you to Your email and Accounts. 
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3. If you're already signed in with a Microsoft account, your name and email address will appear above your 

account picture. (see snip immediately below.) If you're signed in with a local account (see snip on next 

page), you'll see the words Local Account below your name, along with a sign in with a Microsoft account 

instead link. 
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IF YOU DON’T WANT A MICROSOFT ACCOUNT 

If you don’t want to use a Microsoft account, that’s fine — there’s a small link that allows you to set up a 

traditional local account (see following paragraph). However, it is advantageous to have both a Microsoft account 
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and a local account available for yourself. (These two accounts will be identical in every way, except that a 

Microsoft account requires a username and password/pin and provides access to the Store and OneDrive.) 

SIGN INTO WINDOWS 10 WITHOUT USING A MICROSOFT ACCOUNT 

When you set up the Windows 10 operating system for the first time, you can choose to not use a Microsoft Account. 

During setup, when you are prompted to sign in with your Microsoft account, scroll to the bottom of the screen to find 

two small options: Skip this step or Sign in without a Microsoft account. Simply choose one of those. 

If more than one person uses your PC, each person should have his own local account. Each can sign in and 

personalize the PC with their own background colors, favorite apps, account picture, a separate email inbox, and 

more.  

HOW TO REMOVE YOUR MICROSOFT ACCOUNT 

If you’ve already set up Windows with a Microsoft account, you can still undo that. Here’s how: 

1. Go to Start > Settings > Accounts > Your email and accounts (or use the keyboard shortcut Windows key + I 

and choose Accounts). 

2. Click Sign in with a local account instead if you are not already there. 

3. Follow the steps to set up a local account. Sign out, reboot. 

4. At reboot, you will be logged in with your local account, go back to Start > Settings > Accounts > Your email 

and accounts. 

5. Scroll down to find your old Microsoft account in Other accounts you use. 

6. Click it, and click Remove. 

LOCAL USER ACCOUNTS 

Local user accounts make it possible for more than one person to share a computer, with each person having a 

private Documents folder, apps, email inbox, and Windows settings. When you have your own account, you can do 

https://www.thurrott.com/windows/windows-10/4260/windows-10-drops-reliance-on-microsoft-account
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all the customization you want to your Windows environment without affecting other user accounts. Other users 

will have their own visual customization, their own app settings, and so forth. 

Local user accounts can be used only on your local computer. If you have multiple devices, you must create a 

separate local account for each device and they will not be in sync. A local account is the same as any account 

you’ve ever used to log in to a Windows 7 or Windows XP operating system. A local account grants you access to 

the system’s resources in your own user environment. You can install desktop apps, change settings, and work as 

usual. Although with local accounts you won’t miss out on any familiar features in older versions of Windows, you 

can’t access many new features that Windows 10 has to offer, because local accounts can’t use services like 

OneDrive, free online Office applications, or Skype, unless you manually enter a Microsoft account’s username 

and password.  

USER ACCOUNT TYPES AND ADMINISTRATOR PERMISSIONS 

User accounts can be administrator accounts or standard user accounts. Accounts with administrator permissions 

are specified by the word “Administrator” in the Accounts section of the Settings window. Administrators have full 

access to all user accounts. They can create and delete user accounts and change the name, password, and account 

types for other accounts. The administrator can also install software and hardware and configure every aspect of 

the operating system. As a rule, every computer must have at least one administrator. A user account that isn’t an 

administrator account is considered a standard user account and has limited permissions. Generally, a user with 

standard privileges has access to apps that have already been installed on the computer but cannot install other 

software without the administrator password. Standard users can change their own passwords but can’t change the 

account name or type without the administrator password. In most circumstances, it’s best that all accounts have 

administrator permissions. 

SIGN IN TO YOUR MICROSOFT ACCOUNT 

A Microsoft account is an email address and password that you use to sign in to the Windows Store. It's free and 

easy to set up, and you can do so with any email address you choose, or get a new email address. (For example, 
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you can use your Cox username and password or your Gmail username and password to access your Microsoft 

account.) 

Important note: If you boot to your Microsoft account, you will need to have your password (or pin) to access the 

account. There are four purposes for having a Microsoft account: shopping in the Microsoft Store, access to 

OneDrive and its 5 GB of cloud storage, access to free Microsoft Office online apps, and synching files between 

computers. 

If more than one person uses your PC, each person should have his own local account. They can sign in and 

personalize the PC with their own background colors, favorite apps, account picture, a separate email inbox, and 

more. 

To check whether you're already signed in with a Microsoft account (your first clue will be if you need to sign-in 

with a password or 4-digit pin): Press Windows + I, then click Accounts. If you're already signed in with a 

Microsoft account, your name and email address appear above your account picture. If you're signed in with a local 

account, you'll see the words Local Account below your name, along with the Connect to a Microsoft account link. 

SIGNING IN TO A MICROSOFT ACCOUNT FROM A LOCAL ACCOUNT 

If you're signed in to Windows 10 with a local account, it’s easy to switch to a Microsoft account on your PC. Press 

Windows + I, then Settings. Click Accounts and then click Sign in with a Microsoft account instead. You will be 

asked for your email address and password that you used to establish your Microsoft account. 

If you don’t have a Microsoft account, you can use any email address that you already have. It can be your email 

address from Cox, CenturyLink, Gmail, Yahoo, AOL, or any others. In any case, you should enter the password for 

your chosen email address. 

If you haven’t accessed your Microsoft account recently, you will be asked to verify your identity by inserting a 

seven digit numeric code. You can have the code sent to you in one of several ways:  

1. To the inbox of your email address.  
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2. To your home telephone number, or  

3. To your cell phone.  

You will determine your choices when you set up your Microsoft account the first time. 

SWITCH FROM ONE ACCOUNT TO ANOTHER ON THE FLY 

If you are signed on to a Local Account and want to convert to your Microsoft Account (or vice-versa), click the 

Start button, then click your avatar at the top of the Start menu. Select Change account settings.  

This will bring up the Accounts window in Settings. In the Your email and accounts tab, click Sign in with a 

Microsoft account instead.  

CREATE A LOCAL USER ACCOUNT FOR A FAMILY MEMBER 

Creating a new account for a family member isn’t difficult, but like many Windows 10 features, it’s tucked away in 

a spot that’s not easy to find at first. 

To create a new account in Windows 10: 

1. Press Windows + I to access the Setting menu and then select Accounts. In the left column, click on Family 

and Other Users.  

2. DO NOT CLICK ON ADD A FAMILY MEMBER, BUT RATHER CLICK ON OTHER USERS. 

3. After selecting Other Users, click on the + sign beside Add Someone Else to This PC. 

4. When you are asked “How will this person sign in?” Click I don’t have this person’s signin information. 

5. At the Let’s Create Your Account screen, click on Add a user without a Microsoft account. 

6. At the Who’s going to use this PC? screen give the new account a name (suggestion: Extra Account). DO 

NOT ENTER A PASSWORD!  Click Next. 
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7. The “Extra Account” will now be listed under Other Users.  Change the account type to Administrator and 

click OK. 

8. Close the Settings window and go back to the Desktop. 

9. Click on the Start Button and then click on the account button that appears at the top of the Start Menu. 

10. Click on the “Extra Account” or the name of the account you just created.  

11. Click on the sign-in function for the new account. 

12. Windows 10 will now establish the new account! 

SET UP A PIN FOR YOUR MICROSOFT ACCOUNT 

To simplify how you log on to your computer via your Microsoft account, Windows 10 allows you to create a four-

digit PIN associated with your Microsoft account. After you create a PIN, you can use it to log on quickly to your 

account.  

Here’s how to set up a pin for your Microsoft account:  

1. Open Settings (Windows + I).  

2. Click Accounts. The settings for user accounts are shown. 

3. Click Sign-In Options. Your sign-in settings are shown.  

4. Click the Add button in the PIN section. You’re asked to verify your account.  

5. Enter your user account password.  

6. Click Sign In. The Set Up a PIN window opens.  

7. Type the PIN that you want in the New PIN and Confirm PIN boxes. 

8. Click OK.  

9. Close Settings.  

If you forget your PIN, you will have to reset it. To reset the PIN, follow the preceding steps and at Step 4, click I 

Forgot My PIN; then follow the wizard’s instructions for resetting the PIN. 
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TURN THE KEYBOARD NUMBER LOCK ON 

If you access your Microsoft account by using a four-digit pin, you probably know that it’s best to have the 

NumLock turned on. Otherwise, you will need to remember to tap the NumLock key every time you want to access 

your pin number. 
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Standard warning: Registry Editor is a powerful tool and misusing it can render your system unstable or even 

inoperable. This is a pretty straight-forward hack and as long as you stick to the steps, you shouldn’t have any 

problem. 

Follow these steps to open the Registry Editor: 

1. Press Windows+R on your keyboard. 

2. Type regedit in the search box and press Enter. 

3. Click yes at User Account Control. 

Navigate to the following key in the left column: 

(Note: You only need to make this change once.) 

Expand HKEY_USERS 

Go down the list to find and Expand DEFAULT 

Go down the list to find and Expand CONTROL PANEL 

Go down the list to find and Expand KEYBOARD 

Go down the list to find and open InitialKeyboardIndicators 

Set the value to 2. 

 

Close regedit and reboot the computer to have this change take place. 

 

SET UP A PICTURE PASSWORD  FOR YOUR MICROSOFT ACCOUNT 

The concept of picture passwords was first introduced in Windows 8. A picture password has two complementary 

parts: a picture and gestures that you draw on it. These gestures can be taps, clicks, circles, or lines. If your user 
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account has a complicated password, using a picture password can make it easier to log on to your Windows 10 

devices.  

Even though this feature is particularly recommended for use on touch-enabled devices such as tablets, you can 

also employ it on a desktop computer by using a mouse.  

To create a picture password for your user account, follow these steps:  

1. Open Settings.  

2. Click Accounts. The settings for user accounts are shown.  

3. Click Sign-In Options. Your sign-in settings are shown.  

4. In the Picture Password section, click the Add button. You’re asked to first verify your account info and type 

your password.  

5. Type your password as requested; then click OK. The wizard for setting the picture password appears. 

6. Click Choose Picture. A browsing window opens. 

7. Navigate to where you stored the picture you want to use for the password and select it. 

8. Click Open. The selected picture is now open.  

9. Drag the picture to the position that you want. You can use your mouse or your finger (if you use touch).  

10. Click Use This Picture. You’re asked to set up three gestures as your picture password.  

11. Draw three gestures on your picture. You can use any combination of circles, straight lines, and taps.  

12. Confirm the three gestures by drawing them again. You receive a message that you successfully created your 

picture password.  

13. Click Finish.  

14. Close Settings. 

SWITCH BETWEEN SIGN-IN OPTIONS TO YOUR MICROSOFT ACCOUNT 
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After you set up more than one way to sign in to Windows 10, you need to know how to switch between them 

when signing into Windows. When you’re at the sign-in screen and you want to use a way to sign in other than 

with your password, here’s what to do:  

1. Select your user account from the list of available accounts. Your user account picture appears. 

2. Click the Sign-In Options link. A list of icons appears. Each icon represents a sign-in option. From left to 

right, they are picture password, password, and PIN. 

3. Click the icon for the sign-in option that you want to use. 

4. Sign in using the option that you selected. 

CHANGE YOUR USER ACCOUNT PICTURE 

You can set a picture for your user account, and you can change it at any time. The picture you use is shown when 

you sign in to Windows 10, on the Start Menu, in apps that use this picture, and so on. 

To change the picture that you’re using for your account, follow these steps: 

1. Open Settings.  

2. Click Accounts. The settings for user accounts are shown.  

3. In Your Account, click the Browse button. A browsing window opens. 

4. Navigate to where you stored the picture that you want to use and select it. 

5. Click Choose Picture. The new picture is shown alongside the previous one, if one was set. 

6. Close Settings. 

SET THE SIGN-IN POLICY 

You can set Windows 10 to require you to sign in again if you stop using it for a certain period of time. You can 

also set it to never ask you to sign in. 

Setting Windows 10 to always require you to sign in after you’re away from your computer is a very useful 

security precaution. Here’s how to set the sign-in policy: 
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1. Open Settings (Windows + I).  

2. Click Accounts. The settings for user accounts are shown.  

3. Click Sign-In Options. Your sign-in settings are shown. 

4. Click the drop-down list in the “Require Sign-In” section. A list with options appears.  

5. Select the desired sign-in option.  

6. Close Settings. 

CHANGE OR DELETE YOUR PASSWORD(S) FOR YOUR ACCOUNTS 

NOTE: YOUR MICROSOFT ACCOUNT REQUIRES A PASSWORD; YOUR LOCAL ACCOUNTS DO NOT REQUIRE A PASSWORD. 

1. Go to Settings (Winkey + I). 

2. Click on Accounts. 

3. Click on Your Email and Accounts to verify your current active account. 

 

If your Microsoft account is the active account, the screen will look similar to this: 
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If your Local account is the active account, the screen will look similar to this: 

 

4. Click Sign-in options in the left column. 

5. If your Local account has a password, it can be removed here. 

If your Local account has no password, it can be added here. 

Your Microsoft account must have a password. However, it can be changed here; you can also add, change, 

or remove the four-digit pin here. 

 



Page 35 of 271 

 

CHAPTER FIVE 

SOME HANDY KEYBOARD SHORTCUTS IN WINDOWS 10 

 

Windows Key: Shows the Start Menu  

Windows Key + D: Shows the Desktop  

Windows Key + A: Opens Windows Notifications and Action Center 

Windows Key + I: Opens Settings 

Windows Key + E: Opens File Explorer, aka Windows Explorer 

Windows Key + F1: Opens Edge browser 

Windows Key + L: Locks your Lock screen  

Windows Key + Tab: Launches Task View 

Windows Key + X: Opens the Start button’s context menu 

Windows Key + R: Run command 

Windows Key + S: opens Cortana   

Alt + Tab: Switch to previous window 

Alt + F4: Close current window, but if you perform this combination when viewing the desktop, you open 

Power dialogue to shut down or restart Windows, put your device in sleep mode, sign out or switch the current 

user. 
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CHAPTER SIX 
START: THE BUTTON, THE MENU, AND THE START SCREEN 

The Start menu looks a bit different from the one on Windows 7, but it has all the features you would expect — a 

list of all your installed applications as well as power options for shutting down or restarting your PC. Move your 

mouse to the right edge of the Start menu and you’ll be able to access the start screen by simply dragging the 

pointer either left or right. 

TO DISPLAY THE START MENU 

 Click the Start button on the far left corner of the Windows Taskbar, or 

 Press the Windows logo key  on the keyboard. 

The left side of Start features an all-new, yet familiar, design. Easily jump to different locations in Windows, like 

File Explorer and Settings. See the applications you use every day under Most used. If you have a new app from 

the Store, it’ll appear under Recently added or new. For a list of all your applications and programs, select All 

apps.  

THE RIGHT-CLICK CONTEXT MENU PROVIDES SPECIAL OPTIONS JUST LIKE BEFORE. 

Previously, when you right-clicked on an object on the Desktop, a vertical context menu would appear which gave 

you a choice of actions to take. In Windows 10, right-clicking produces the same vertical context menu. 

LAUNCHING AN APPLICATION 

Left-click on an application to open (launch) it. Right-click the application to choose from a broader range of 

options, which, depending on the app, may include the following: 

 Open 

 Run as administrator 

 Uninstall 

 Pin to Start 

 Pin to taskbar 

 Remove from this list 
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LOCK YOUR COMPUTER, CHANGE YOUR ACCOUNT PICTURE, OR SIGN OUT 

1. On the Start menu, select your user name/photo in the upper left corner of the menu. 

2. Choose the option you want:  Change account settings, Lock, or Sign out.  

QUICKLY ACCESS YOUR APPLICATIONS, FILES, AND SETTINGS  

In the left pane of the Start menu, immediately below your user name, you’ll find the following: 

 Links to your most-used and recently added applications  

 Links to File Explorer (aka Windows Explorer) and Settings 

 An All app button—select it to display a list of all the applications installed on your computer 

 The power button is right at the heart of Start, just above the All apps button.  

 Want to sign out of your PC, switch accounts, or change your account picture? Just click on your name in the 

upper-left corner of Start. 

TO CUSTOMIZE THE START MENU  

Windows 10 combines the tiles of Windows 8's All apps screen with the earlier Start menu that held legacy 

(pre-Windows 8) programs. You can have the new Start menu your way:  

Simply click and hold the cursor on the right edge of the Start menu and drag it in a staggered way to the 

size you want. The apps that you have “pinned to start” will be located on the start screen as tiles.  

If you tap All Apps, you'll see a small tile for every single program on the computer, and you can pin to 

start or pin to taskbar any of them with a right-click option. 

You can also pin any application (legacy or modern) to the Desktop. It’s as easy as a left drag and drop! (In 

Windows 8.1, Modern apps could not be pinned to the Desktop without the use of ModernMix, a third -party 

commercial program.) 
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MORE SETTINGS ARE AVAILABLE 

There are even more settings for the Start menu, accessible from the Settings (Windows + I)> 

Personalization > Start. There you will find five start/stop buttons plus an option to choose which folders 

appear on start.  

 

 

 

TO FURTHER PERSONALIZE THE START SCREEN 

 Arrange items into groups, move and resize tiles, even change the size of the Start menu itself. 

 Show live updates for certain tiles, such as real-time weather in Las Vegas and other locations of interest to 

you. Two other apps that are interesting to have live tile on are News and Money. 
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ADJUST YOUR START SCREEN TILES EASILY IN TABLET MODE 

The easiest way to maneuver and resize the tiles on your Start screen is to switch to Tablet Mode. Tablet Mode will 

give you an uninterrupted full screen with which to work. Once you have made your adjustments, you can return to 

a standard Start screen by turning off Tablet Mode.  

One way to get to Tablet Mode: Click on Settings, then System, then Tablet Mode. Turn on Table Mode. Follow 

these steps to turn off Tablet Mode. 

A second way to turn Tablet Mode on/off is to click on the Notification button located on the far right side of the 

Taskbar and click Tablet Mode. 
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HOW TO CREATE TILE GROUPS ON THE START SCREEN  

While using the Windows 10 Start screen, you can organize your tiles by creating groups. (You cannot place tiles 

into folders; however, you can drag and drop the target tiles to the Desktop where they will become shortcuts. As 

shortcuts, they can be collected into Desktop folders.)  

Having your apps contained in a group makes it easier for you to quickly find your favorite apps all in one place.  

To create a new group, all you have to do is left drag and drop your chosen tiles to the far right (or left) side of the 

screen, just until a gray vertical bar appears. After you finish moving your chosen tiles, you should have them 

clustered into a new group.  

HOW TO NAME YOUR APP GROUPS 

To make it even easier to organize and view your groups, you can give each group a name. In the end, every group 

you create will have its name displayed on top of a cluster if you so choose.  Naming a group is a simple task. 

Simply click on a blank space immediately above the target cluster and then enter a name for the group in the name 

bar that will appear. Now click on any blank space on the Start screen and you will be taken back to the normal 

screen. If you want to move the entire group to another location on the Start screen, drag the cluster by its name bar 

and move it to a new location. 

BOOT TO THE START SCREEN FOR YOUR TABLET MODE 

When Windows 8 used to boot to the Start Screen, people wanted to boot directly to the Desktop. Now when 

Windows 10 boots to the desktop, there are some who want to boot to the Start Screen. If you are in Tablet Mode 

when you turn off your computer, your computer will boot to the Start Screen at the next startup. Conversely, if you 

are in standard desktop mode when you turn off your computer, your computer will boot to the Desktop at the next 

startup. 
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To enable a Start Screen boot, you will need to enable Tablet Mode. To enable it, click on the Notifications icon 

on the far right side of the Taskbar (or use Windows + A). You will see the Notifications panel open.  Click on 

Tablet mode. The Start Screen will be enabled. To see the Start Screen, click on the Windows key or your Start 

Button.  

To turn off the Tablet mode, select Windows + A, then click on the Tablet Mode tile. (The tile acts as a toggle 

switch and has a light background when turned on. In addition, the background of the Taskbar changes to black.) 

UNPINNING VS. UNINSTALLING TILES 

Unpinning tiles means that they’ll be hidden from the Start screen but will still be accessible in the All apps view. 

(To access the All apps view, go to the Start Menu and click on All Apps at the bottom of the list.) Uninstalling 

them, however, will remove them from your computer completely. The good news is that many of these apps can 

simply be re-downloaded from the Windows Store if you ever change your mind later on. 
 

If you uninstall a legacy program (a program that predates Windows 8 or Windows 10), you will need to reinstall it 

from the Internet or a disk just like in previous editions of Windows. 

UNINSTALL LEGACY PROGRAMS YOU DON’T USE 

Right-click on the Start button, then left-click on Programs and Features. Find the list of installed programs and 

uninstall programs you don’t use and don’t need. This can help speed up your PC, as those programs might include 

background processes, autostart entries, system services, context menu entries, and other things that can slow down 

your PC. It’ll also save room on your hard drive and improve system security — for example, you definitely 

shouldn’t have Java installed if you’re not using it. 

http://www.howtogeek.com/198300/oracle-cant-secure-the-java-plug-in-so-why-is-it-still-enabled-by-default/
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INSTALL OR UNINSTALL WINDOWS 10 MODERN (STORE) APPS 

Install Windows 10 apps 

If you wish to install Windows Store Apps on your Windows 10 computer, you will have to visit the official 

Windows Store, search for the app, and then download and install it. 

Type ‘store‘ in the search bar and click on Store near the top of the column.  Using the search bar located near the 

upper right corner of the Store’s opening screen, search for the target app. Once the Store app is found, click on the 
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Install button. If the app is free, you will see Free written on the button. The process is rather simple and the 

installation is quick and straightforward, also. 

Uninstall Windows 10 apps 

To remove or uninstall a Windows 10 Apps which was installed from the Windows Store, right-click on its icon 

and select Uninstall.  

The easiest way to uninstall Windows 10 apps is to type the name of the app in the taskbar search. Once its icon 

is displayed in the search result, right-click on it and select Uninstall. 

That is all! The app will be uninstalled in a few moments. 

You can also remove the Store apps via the Settings app, as follows: 

1. Click on Start Menu to open it. 

2. Click on Settings to open the Settings window. 

3. In the Settings Window, click on System. 

4. Click on Apps and Features. The right panel will be populated with the list of preinstalled Windows 10 apps 

that you can remove. 

5. Click on an app to see the options Move and Uninstall. Click on Uninstall to remove the application. 

 

The Uninstall feature is not available for all Windows 10 apps. Microsoft believes that some of them are essential 

to you, and hence you will not see the Uninstall button next to them. 

RESIZE TILES 
Once you’ve decided what apps you want on your Start Screen, it’s time to get them organized. Right clicking on a 

tile on the Start Screen will allow you to resize it and choose if it is a live tile or not. The size of the each tile is 

determined by the app, meaning that some have a large and wide option, while others only have medium or small 

options. 



Page 44 of 271 

 

LIVE TILES 
If an app has the option to be a live tile, it means that it can display pertinent information on the face of the tile 

rather than just a logo. For apps such as Weather or News, this could actually be useful and provide up-to-date 

information. Some apps, though, don’t support any live tile function. (Note that the more live tiles you have 

running, the longer it will take your computer to boot since a live tile consumes system resources.) 

PIN A FOLDER TO THE START SCREEN 

You can right-click on a folder, and pin to start. This action will place the target folder on your Start screen! 

THE RIGHT-CLICK CONTEXT MENU PROVIDES SPECIAL OPTIONS JUST LIKE BEFORE. 

Previously, when you right-clicked on an object on the Desktop, a vertical context menu would appear which gave 

you a choice of actions to take. In the Windows 10, right-clicking produces the same vertical context menu. 

LAUNCHING AN APPLICATION 

Left-click on an application to open (launch) it. Right-click the application to choose from a broader range of 

options, which, depending on the app, may include the following: 

 Open 

 Run as administrator 

 Uninstall 

 Pin to Start 

 Pin to taskbar 

 Remove from this list 

 

Please note: When any application or file is assigned to a Desktop location, that icon becomes a shortcut and 

must be opened with a double-click. 

ADD A SPLASH OF COLOR  

Live Tiles bring the Start Menu to life, but it might not feel personalized to your tastes until you’ve given it a fresh 

coat of paint. By default, the Start Menu is set to ignore the color you chose when you set up your Windows 10 

user account, so the first priority is to amend that option.  To do so, navigate to Settings > Personalization > Colors. 

First, turn off the Automatically pick an accent color from my background. Now, scroll down to the toggle switch 
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marked Show color on Start, taskbar and action center and make sure that it’s set to On. You’ll then be able to 

select from a variety of different swatches.   

You can also opt to Make Start, taskbar and action center transparent with the appropriate toggle switch. These 

options cater to form, rather than function, so feel free to mix and match as you please until you find a setup that 

works for you. 

USE THE WINX (WINDOWS + X) MENU 

In Windows 10, a hidden menu, the WinX menu, produces shortcuts to such useful tools and apps as Computer 

Management, the Control Panel, the Command Prompt, and the Task Manager. The menu’s name comes from the 

keyboard shortcut that you press to open the menu: Windows+X. 

You can also open the WinX menu with the mouse or by using touch (if you have a touch screen): 

• With a mouse, right-click the Windows key on the taskbar. 

• With a touch-sensitive screen, press and hold the Windows key until the WinX menu appears. To start any of the 

tools available in the WinX menu, simply click or tap them. 

WHEN A PROGRAM APPLICATION CRASHES AND WON’T RESTART 

If an application crashes once or twice and then won’t restart, check to make sure it’s not continuing to run. When 

you can’t restart an application after it crashes, it’s often because the application is still running (even though it 

crashed).  

To correct the problem: 

1. Open the Task Manager. (Right-click the Start button, then click Task Manager) 

2. In the Applications Tab, look for the program you’re trying to start. 

3. If it’s listed once or more, right-click each listing and choose End Process. 

4. Once you eliminate all of the listings, you should be able to restart the application. 
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RUN A PROGRAM AUTOMATICALLY AT STARTUP 

If you always open the same application every time you turn on your computer, it might be to your advantage to 

place that program (for example, Edge, Gmail, or Microsoft Word) inside the little-used Startup folder that is 

hidden inside the Windows 10 operating system. 

To do so: 

1. Click on the Start button in the lower left corner of the Taskbar. 

2. Click on All Apps. 

3. Locate the target app that you would like to open at startup. 

4. Right-click on the target app and then click on Open File Location. This action will take you to the location 

of the target’s shortcut icon. 

5. Right-click on the target’s shortcut and click Copy. This action will place the shortcut onto the clipboard. 

6. Now you can close all windows to take you back to the Desktop. 

7. Press Windows-R to display the Run dialog.  

8. Type shell:startup into the Open field and click OK or press Enter. This action will open the Startup folder 

in a new File Explorer window. 

9. Right-click on an empty spot in the Startup folder and select Paste from the context menu to create a 

shortcut that points to the file you copied to the clipboard. 

10. Close all File Explorer windows and return to the Desktop. 

11. When you reboot, the target app that you selected will load. 
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THE TASKBAR IS ALWAYS AVAILABLE—IT’S JUST OUT OF VIEW 

The all-important Desktop Taskbar is always available, no matter what application or window you have open. Just 

move your mouse down towards the bottom of any maximized screen, and the Taskbar will appear! 

If it is out of view, it means that you have checked the Auto-hide the taskbar checkbox in Taskbar properties. Find 

Taskbar properties by right-clicking on the Taskbar and then clicking Properties. 
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CHAPTER SEVEN 
NAVIGATING THE DESKTOP AND TASKBAR 

 
When you boot your computer you are taken to the Desktop, just like you were in Windows 7 or Windows 8.1. The 

Windows 10 Desktop is where you can place shortcuts to both legacy programs and modern programs. Earlier 

editions of Windows did not allow the placement of modern programs on the Desktop. (Windows 8.1 modern app 

shortcuts could be placed on the Desktop only via a third-party commercial product called Modern Mix.) 

Many other desktop improvements from Windows 8 are still here, but you won’t have seen them if you’ve been 

using Windows 7. The Task Manager (Windows + X, then T) was given an upgrade, so it’s easier to see what’s 

using your system resources and managing startup programs. 

NAVIGATING THE DESKTOP (WINDOWS KEY + D) 

Just like in earlier versions of Windows, you can drag individual icons to any location using the familiar “drag and 

drop” routine of your left mouse button. 

CHANGE THE ICONS DISPLAYED ON THE DESKTOP 

You can change the icons shown on the desktop. For example, you can enable or disable any of the following 

icons: This PC, Users’ Files, Network, Recycle Bin, and Control Panel. You can also create your own shortcuts on 

the desktop, just like in previous versions of Windows.  

To enable or disable a standard icon on the desktop, follow these steps:  

1. Open Settings.  

2. Click Personalization. All the available personalization settings are shown.  

3. Click Themes. The themes-related settings are shown. 
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4. Click Desktop Icon Settings. A window by the same name opens. 

5. Check the desktop icons that you want to enable. 

6. Uncheck the desktop icons that you want to disable.  

7. Click OK.  

8. Close Settings. 

PIN ANY FILE OR FOLDER TO THE DESKTOP VIA FILE EXPLORER 

Also, just like in previous versions of Windows, it is easy to send to: desktop (create shortcut) any folder or file 

that you will find in File Explorer (Windows key + E). Just right-click on the target folder or file. 

PIN ANY APPLICATION TO THE DESKTOP 

While in All apps from the Start Menu, you can select and left-drag and drop any application (legacy or modern) to 

the Desktop screen where it will automatically become a shortcut icon. Legacy applications are those that were 

available for Windows 7 and earlier. Modern applications are those that were developed for Windows 8.1 or 

Windows 10 and are available only through the Microsoft Store. (Many of the apps that come pre-installed on 

Windows 10 are Modern apps.) 

CREATE A DESKTOP SHORTCUT FOR A FAVORITE WEB PAGE 

Windows provides a variety of ways to let you work more efficiently. One way is through shortcuts. You can 

create shortcuts to run programs, open files, go to Web pages, etc. In addition, you can place these shortcuts on the 

desktop or the Taskbar so that they're easily accessible whenever you need them. 

Say that you frequent a certain Website, such as http://www.scsccbkk.org. Instead of having to launch your 

browser, type the address in its locator bar, and tell it to go, you'd rather have a desktop shortcut that you can 

simply double-click and be taken directly to the Saturday Seminar page with its more than 1000 documents. 

To do this, right-click on an empty space on your desktop and choose New | Shortcut from the pop-up Context 

menu.  
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When you click Shortcut, you'll be led through a two-step wizard that allows you to create a shortcut for your 

Website. You are first asked for the location of the item. This is where you type the URL of your Website. Make 

sure you include the full URL, such as this: 

http://www.scsccbkk.org 

Clicking Next takes you to the second (and last) step of the wizard, where you are prompted to enter a name for the 

shortcut. You might want to call it something descriptive, such as "Saturday Seminar". When you click Finish, 

your new shortcut appears on the desktop. Right-click on the shortcut, then Open and you'll be immediately taken 

to the target Website. As an alternative, you can double-left click. 

PIN WEB PAGES TO THE START MENU USING INTERNET EXPLORER 

Open Internet Explorer from the Taskbar. Type the address of the target Website in the address bar (Ctrl + L) at 

the top of the screen. When the Website has been fully accessed, click on the cog wheel located near the upper 

right corner of the window. Now click on Add site to Apps. 

After closing the browser window, go to the Apps menu where you will find a tile that represents your favorite site. 

Right-click on it and then Pin to Start or Pin to Taskbar You can also left-drag the App to the Desktop. 

CHANGE THE NAME OF A LEGACY (PRE-WINDOWS 8 OR 10) TILE 

1. Right-click on the target tile. An “open file location” button will appear in the dropdown menu. (If the “open 

file location” button is absent, the tile name cannot be changed.) 

2. Click on the “open file location” button. A shortcut for the target application will appear. 

3. Right-click on the shortcut and then click on rename.  Modify or change the name of the shortcut and then 

close the window. 

4. The tile name change will now appear on the Start Screen or Taskbar.  
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Please note that the names of dedicated Windows 10 Apps cannot be changed. However, if a Windows 10 App has 

been dragged from the Start Menu to the Desktop, it will automatically appear as a shortcut icon. Therefore, its 

name can generally be changed by right-clicking on the shortcut icon and then clicking on rename. 

WHAT TO DO WHEN A PROGRAM LOCKS UP 

Close the program by pressing Windows + X. 

Then press T. (Note that Task Manager has the T underlined.) 

When the Task Manager appears, click on the application causing the trouble and then click End task. 

HOW TO REMOVE MULTIPLE SHORTCUTS FROM THE DESKTOP IN ONE MOTION. 

Click on each of the shortcut icons you wish to remove while holding down on the Control key. This action will 

highlight or select all that you have selected. Finally, press the Delete key on your keyboard. The deleted items will 

be sent to the Recycle Bin. Unfortunately, Microsoft has not provided a way to remove tiles from the Start Screen 

except one-at-a-time. 

HOW TO CHANGE THE DESKTOP’S BACKGROUND 

The default desktop background or wallpaper in Windows 10 is impressive, but not all users want to keep the same 

desktop background forever, and many want to change the default desktop background to an image of their choice 

(including family photos).   

When you right-click on the desktop and click the Personalize option, the Background link will open. From there, 

you can designate your desktop background as a single picture, solid color, or slideshow. 

To set up a desktop slideshow or change the desktop background, follow the instructions below:  

Tip: By default, Windows 10 syncs your current desktop background across all your PCs if you’re using the same Microsoft account 

on all PCs. You can turn off this feature under Settings app to avoid having the same desktop background on all your PCs. (Windows 

+ I > Accounts > Synch your settings. 

Method 1 Change Windows 10’s desktop background 
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Windows 10 allows you to change the desktop background to another picture that’s bundled with the operating 

system or with a picture of your own. To change the desktop background, follow these steps: 

1. Open Settings (Windows + I).  

2. Click Personalization. All available personalization settings are shown.  

3. In the Background section, choose a picture from those included in Windows 10 by clicking on it. 

4. Click the down-pointing arrow in the Choose a Fit dropdown list. A list is shown with such choices and Fill, 

Fit, Stretch, Tile, Center, and Span. 

5. From the drop-down list, choose how you want the picture to fit your desktop.  

6. Close the Settings window. If you want to use your own picture, at Step 3 click Browse, navigate to the 

picture that you want to use, and click Choose Picture; continue with Steps 4, 5 and 6. 

Method 2: Another easy method to change wallpaper 

1. Open File Explorer (Windows +E) and then navigate to the folder containing the picture that you want to set 

as your desktop background. 

2. Right-click on the target picture and then click Set as desktop background. 

Method 3: Set up a desktop slideshow 

You can use your Pictures folder (or any other folder with pictures) to create a “slide show” background on your 

desktop. When you do that, at regular intervals, Windows 10 automatically shows a rotating series of the pictures 

in your Pictures folder. In order to create a slideshow with your own pictures as the desktop background, follow 

these steps:  

1. Open Settings (Windows + I). 

2. Click Personalization. All available personalization settings are shown.  

3. Click the down-pointing arrow in the Background dropdown list. A list is shown with such choices as 

Picture, Solid color, and Slideshow.  
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4. In the drop-down list that appears, select Slideshow. By default, the Pictures folder is used as the source for 

the slideshow. 

5. To choose another folder, click Browse. The Select Folder window appears. 

6. Browse through the folders on your computer and select the one that you want to use; then click Choose This 

Folder. The selected folder is used for the slide show.  

7. Click the down-pointing arrow in the Change Picture Every drop-down list. A list is shown with several 

choices for the time interval at which the pictures should change. 

8. In the drop-down list that appears, select the time interval at which you want the pictures to change. 

9. Click the down-pointing arrow in the Choose a Fit drop-down list. A list is shown with such choices as Fill, 

Fit, Stretch, Tile, Center, and Span.  

10. From the drop-down list, choose how you want the picture to fit your desktop. 

11. Close the Settings window. 

CHANGE THE WINDOWS THEME 

A Windows theme includes the wallpaper used on the desktop as well as settings such as the standard desktop 

icons (for example, Computer, Network, and Recycle Bin), the visual styles applied to Windows and apps, the 

mouse cursors, the screensaver that runs when the computer isn’t in use, and the sound scheme applied to the 

operating system. If you get bored with any of the items that are included in the theme, you can change the theme 

and freshen things up a bit. 

To change the Windows theme, follow these steps:  

1. Open Settings.  

2. Click Personalization. All the available personalization settings are shown.  

3. Click Themes. The themes-related settings are shown.  

4. Click Theme Settings. The Personalization window opens. 

5. In the Personalization window, click the new theme that you want to apply. 
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6. Close the Personalization window.  

7. Close Settings. 

If you want access to more diverse Windows themes, try the gallery provided by Microsoft at 

http://windows.microsoft.com/en-US/windows/themes?ocid=w8_client_themes 

 

 

http://windows.microsoft.com/en-US/windows/themes?ocid=w8_client_themes
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SET THE COLORS USED BY WINDOWS 10 

Windows 10 allows you to change the main color that’s used throughout the operating system. By default, this 

color is chosen from the desktop background. Windows 10 simply picks the desktop’s accent color and uses it 

automatically. 

You can override this setting and choose your own accent color. Black is the default color for the Start Menu, the 

taskbar, and the Action Center. You can change this setting and have these elements use the accent color that you 

set. You can also make the Start Menu, the taskbar, and the Action Center transparent, so that you can see through 

them.  

Here’s how to change the color-related settings in Windows 10: (see snip on next page) 

1. Open Settings. 

2. Click Personalization. All the available personalization settings are shown.  

3. Click Colors. The color-related settings are shown.  

4. To pick a custom accent color, set the Automatically Pick an Accent Color from My Background switch to 

Off; then choose your accent color from the list of options. 

5. Set the Show Color on Start, Taskbar, and Action Center switch to On or Off, depending on what you want. 

6. Set the Make Start, Taskbar, and Action Center Transparent switch to On or Off, depending on what you 

want.  

7. Close the Settings window. 
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ADJUSTING THE SOUNDS LINK 

Clicking the "Sounds" link in the Themes dialog box takes you to a dialog box where you can modify what sounds 

Windows plays for different events. When you are satisfied with your settings (you can hear the selected sound by 

clicking the Test button), clicking Save As saves the settings as a new sound scheme and OK dismisses the dialog 

box.  

SETTING THE SCREEN SAVER 

Clicking the "Screen Saver" link in the Themes dialog box takes you to a dialog box that allows you to modify the 

screen saver used by the theme. Here, you can select what screen saver you want to be displayed upon a given 

number of minutes of inactivity. If you want to see what the screen saver will look like, click the Preview button. 

Some screen savers have additional settings you can access by clicking the Settings button. For example, a Photos 

screen saver may have additional settings to allow you to specify what folder contains the pictures to be used and 

also control a possible slide show of the pictures. The Screen Saver Settings dialog box also lets you indicate 

whether the system will prompt the user with login information, thus applying password protection to an idle 

system. Clicking OK saves your settings and dismisses the dialog box.  

 

CHANGE THE RESOLUTION OF THE SCREEN 

Windows 10 can detect the default screen resolution for your monitor and graphics card and adjust accordingly. 

This doesn’t mean that what Windows chooses is always the best option, but now it works better than it did. As 

you expect, you can change the resolution manually. When you do that, you get a preview of what it looks like; 

you can decide whether you want to keep the new screen resolution. (see snip below) 
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Here’s how to change the resolution of your screen:  

1. Open Settings.  

2. Click System. The list of available system settings appears.  

3. In the Display section, click Advanced Display Settings. The Advanced Display Settings window appears. 

4. Click the down-pointing arrow in the Resolution dropdown list. A list appears with multiple resolutions you 

can choose from. Your options vary according to your display’s size and specifications.  

5. In the list of available options, select the resolution that you want to use by clicking on it.  

6. Click Apply. The new resolution is applied. You’re asked whether you want to keep these displayed settings.  

7. Click Keep Changes.  

8. Close the Advanced Display Settings window. 

CHANGE THE MOUSE POINTER SIZE AND COLOR 

If you want, you can make the mouse pointer bigger and also change its color from white to black. Here’s how: 

1. Open Settings.  

2. Click Ease of Access. The list of available ease of access settings appears.  

3. Click Mouse. The available mouse-related settings appear. 

4. In the Pointer Size section, click the size that you want to use.  

5. In the Pointer Color section, click the color that you want to use. 

6. Close Settings. 

PLACE SHORTCUTS FOR SHUTDOWN, RESTART, AND SLEEP ON YOUR DESKTOP 

Thanks to a series of shortcut tricks, you can affix Shutdown, Restart, and Sleep buttons to your Desktop for easy 

access. Just follow these steps.  

To create a shortcut icon for Shutdown: 

1. Right-click on an open area of the Desktop. 
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2. Go to New, then Shortcut.  

3. Enter shutdown /p as the location of the item and press Next.  

4. Now name the shortcut Shutdown and press Finish. 

5. Right-click the shortcut that now appears on your Desktop and navigate to Properties. 

6. Choose Change Icon in the Shortcut tab and then OK to leave the warning box. 

7. Choose (click) an icon of your choice from the list. 

8. Finally, click OK.  

 

To create a shortcut icon for Restart:  

Follow the instructions in the section immediately above, except have the script read shutdown /r /t 0. Now name 

the shortcut Restart and press Finish. 

To create a shortcut icon for Sleep:  

Follow the instructions above, except have the script read:  

Rundll32.exe Powrprof.dll,SetSuspendState Sleep. Now name the shortcut Sleep and press Finish.  

CHANGE HOW TASKS APPEAR ON THE TASKBAR 

The Windows Taskbar is much improved over what it was in the early days of Windows. It now can sport bigger 

icons, provide thumbnail previews, and support pinning and jump lists. With all this extra functionality built into 

the Taskbar, it's no surprise that you can also customize it to change how tasks appear. 

By default, each of your windows has "large" icon in the Taskbar. Multiple windows from the same application 

(e.g., if you have several Windows Explorer windows open) are grouped together instead of individually stretching 

out across the Taskbar. Hovering your mouse pointer over a Taskbar icon brings up a live preview of the window. 

If an application has multiple windows, all of their previews are presented, and you can click any of the previews 

to be taken to that window. 
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You can change the Taskbar to some extent. For example, if you want smaller icons to represent your windows, 

right-click an empty space on the Taskbar and select Properties from the pop-up menu. Windows displays the 

Taskbar and Start Menu Properties dialog box.  

Click the "Use small icons" checkbox and OK to change the size of the Taskbar icons. Regardless of the size of the 

icons, hovering over an icon presents the same-sized thumbnail previews. 

As was mentioned earlier, windows from the same application are grouped together in the Taskbar. This is because 

of the "Always combine, hide labels" setting for the Taskbar Buttons drop-down list in the Taskbar and Start Menu 

Properties dialog box. If you don't want this behavior, you can change it by dropping down the list box and 

selecting either Combine when Taskbar is Full or Never Combine. Once you select a setting, click OK to have it 

take effect and dismiss the dialog box. 

Icons come and go from the Taskbar as you open and close windows. You can "pin" applications to the Taskbar, 

though, so they're always there regardless of whether the application is currently running. In this way, a simple 

click of the pinned icon will launch the application. 

For example, let's say that you want to pin Microsoft Word (a part of Microsoft Office) to the Taskbar. You first 

navigate to the application (on the All Programs list on the Start menu) and then right-click Word. From the 

Context menu, select Pin to Taskbar and the Word icon is pinned to the Taskbar. Now, whenever you want to 

launch Word, just click the icon. To unpin an application, right-click the icon in the Taskbar and select Unpin this 

Program from Taskbar. 

If you don’t like the location of the Taskbar, you can drag it to one of the remaining three sides. Just hold down on 

the left button of your mouse as you drag. 

In addition, you can change the position of each Taskbar icon by simply left-dragging the target(s) to a new 

position. 
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SWITCH BETWEEN MULTIPLE DESKTOPS 

Switching between Desktops is as easy as switching between apps. Just use the Task View, like this: 

1. Click the Task View button. The Task View appears. 

2. Click the Desktop that you want to use. 

SEND AN APP TO ANOTHER DESKTOP 

As you start populating each Desktop with open apps, you may want to move an app from one Desktop to another. 

Here’s how: 

1. Click the Task View button. The Task View appears. (If the Task View button is missing from the Taskbar, 

right-click a blank area of the Taskbar and click Show Task View button.) 

2. Right-click the app that you want to move to another Desktop. The right-click menu appears. 

3. Click Move To. 

4. Click the Desktop that you want to move the app to. 

5. Click the Desktop that you want to use. 

CLOSE A DESKTOP 

You can close any Desktop that you’ve opened at any time. When you close a Desktop, the apps that were open on 

it are moved to the remaining Desktops. To close a Desktop, follow these steps: 

1. Click the Task View button. The Task View appears. 

2. Move the mouse to the top-right corner of the thumbnail of the Desktop that you want to close. 

3. Click the X (exit) button at its top-right corner.  

4. Click the Desktop that you want to use. 
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FIND YOUR INSTALLED APPS 

1. Windows 10 no longer pins newly installed apps to your Start screen. So you need to know where to find them, 

and then how to pin them to the Start screen—or to your taskbar. 

2. No tiles appear on the Start screen when you install a Modern or legacy app in Windows 10. So you must 

instead access the All Apps view, which is found within the Start button. To get there, move down to the lower 

left corner of the Desktop and click the Windows button. 

3. Apps you have recently installed have the text "NEW" next to their name.  

4. To pin the App to the Start screen or taskbar, right-click the app and then choose Pin to Start or Pin to Taskbar 

from the app bar that appears. You can left-drag an App from the Start menu to the Desktop where it takes on 

the form of a shortcut that can be renamed. 

 

CUSTOMIZE THE BEHAVIOR OF THE START MENU 

The Start Menu is more customizable in Windows 10 than it was in Windows 7 and Windows XP. In Settings, 

there’s a big section of settings that allow you to decide whether to  

 Show your most used apps.  

 Show your recently added apps. 

 Use the full-screen Start Menu.  

 Show recently opened items in Jump Lists on Start or on the taskbar. 

 Show which folders appear on Start. (which is mostly a list of simple switches that you can turn on or off.)  
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To access the settings that allow you to customize how the Start Menu works, follow these steps:  

1. Open Settings.  

2. Click Personalization. All of the available personalization settings are shown.  

3. Click Start. The previous Start Menu customization options are shown. 

4. Set the Start Menu as you want it to behave, using the available switches.  

5. When done, close Settings. If you want to set which folders appear on the Start Menu, start the preceding 

steps. At Step 4, click Choose Which Folders Appear On Start, then set the folders that you want to appear 

to On and those that you don’t want to appear to Off. 
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CUSTOMIZE THE TASKBAR 

Just as in older versions of Windows, you can customize the taskbar in Windows 10 in the following ways:  

 Lock the taskbar so that other users can’t change it.  

 Set the taskbar to auto-hide.  

 Set the taskbar to use small buttons.  

 Change the taskbar’s location on the screen from the bottom to the top, 

or to the left or right of the screen.  

 Set how taskbar buttons appear (either always combined with the labels 

hidden, or combined only when the taskbar is full, or never combined).  

 Set whether to use the Peek feature to preview the desktop when you 

move your mouse to the Show Desktop button at the end of the taskbar.  

To customize the taskbar, follow these steps:  

1. Right-click the taskbar. The right-click menu appears.  

2. Click Properties. The Taskbar and Start Menu Properties window 

appears.  

3. In the Taskbar tab, set how you want the taskbar to behave by checking 

the available settings.  

4. Click OK. 

SET WHICH ICONS APPEAR ON THE TASKBAR’S FAR RIGHT SIDE 

You can customize the settings to show more or fewer icons on the right side of the taskbar. Here’s how:  

1. Open Settings.  

2. Click System. The list of available system settings appears.  

3. Click Notifications & Actions. The settings for notifications and quick actions are shown.  
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4. In the Quick Actions section on the Taskbar, click Select Which Icons Appear. A long list of icons is shown. 

Each has a switch to turn it On or Off. 

5. In the list of icons that appears, set the icons you want displayed to On and the icons you don’t want 

displayed to Off. The icons that you set to On are immediately shown in the Taskbar. 

6. Click the left-pointing arrow (the Back arrow) to go back. The settings for notifications and quick actions are 

shown.  

7. Click Turn System Icons On or Off in the Quick Actions section. A list of system icons is shown.  

8. In the list of icons that appears, set the icons you want displayed to On and the icons you don’t want 

displayed to Off. The icons that you set to On are immediately shown in the Taskbar. 

9.  Close the Settings window. 

CHANGE THE SOUND VOLUME 

If you want to change the volume of the speakers to be louder or softer, follow these steps:  

1. Click the Volume icon at the right side of the taskbar. A volume slider appears above the taskbar. 

2. With the mouse, set the slider to the desired sound level. 

3. Click anywhere outside the slider to hide it. If you want to mute the sound, click the Volume icon shown to 

the left of the slider. An X will appear, indicating that the sound is mute. 

4. ADJUST THE VOLUME OF YOUR SPEAKERS. 

5. The volume control for the desktop is in its familiar spot in the System Tray (located on the right side of the 

Desktop’s Taskbar). 

6. An alternative approach: Type volume in the search box near the lower left corner and then click Adjust 

system volume. You will be taken to this setting. 
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SET THE DATE AND TIME MANUALLY 

Windows 10 automatically sets the date and time with servers on the Internet. However, you can also manually 

change the date and time, like this:  

1. Open Settings. 

2. Click Time & Language. The list of time- and language-related settings appears.  

3. In the Date & Time section, set the Set Time Automatically switch to Off and click Change. The Change 

Date and Time window appears.  

4. Set the date and time you want to use; then click Change.  

5. Close the Settings window. 
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SET THE TIME ZONE 

If you travel with a laptop or tablet, you can change the time zone when you arrive in a new country or in an area 

with a different time zone than your usual one. To change the time zone, follow these steps:  

1. Open Settings.  

2. Click Time & Language. The list of time and language related settings appears. 

3. In the Date & Time section, click the down-pointing arrow in Time Zone drop-down list. A list appears with 

all the time zones.  

4. Click the time zone that you want to use. The time zone is now changed. 

5. Close the Settings window. When you get back home, change the time zone again so that Windows and its 

apps use and display the correct time. 

 

TIME, DATE, AND CALENDAR 

We are all familiar with time and date button that appears in the right side of the Desktop’s Taskbar. By clicking on 

the button, you will be able to change the date and time settings. 

You will also see a calendar for the current month with the current date highlighted. If you want to see a monthly 

calendar for a future month, simply click on the right arrow at the top of the calendar to move forward to the future, 

month by month.  

Here’s another trick: click on the current month and you will able to scan through entire years, one at a time, 

through the next one hundred years. 
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CHAPTER EIGHT 

SEARCH BOX, TASK VIEW, AND VIRTUAL DESKTOPS 

Windows 10 has two additions to the task bar. The first is a search box, which can be reduced to a button, and the 

other is an odd new icon that looks vaguely like the face of a robot monkey. (The keyboard equivalent for the Task 

View is Alt-Tab or Windows + Tab.)  

SEARCH BOX: SEARCH ONLY YOUR COMPUTER OR SEARCH BOTH THE INTERNET AND 

WINDOWS 

You can set your Search Box to search your entire computer plus the Internet, or just search your computer.  Click 

on the Search Box, click on the cog wheel that appears in the narrow column on the left, and either select or 

deselect Search online and include web results.  

Many users have discovered that searching both the Internet and one’s local computer can provide too much 

information! You may wish to use the Search Box for exclusive searches of your computer files and use your 

browser’s search engine to search for a topic on the Internet. 

SHOW THE SEARCH BOX AS EITHER A BOX OR AN ICON THE SHAPE OF A SMALL 

MAGNIFYING GLASS. 

Right-click on the one that is showing, move up to Search, then over to Show search icon or Show search box. 

If neither the search box or search icon is showing, right-click on the Taskbar area immediately to the right of the 

Start button, move up to Search, and select either the search box or the search icon. 

FIND AN APPLICATION, A SETTING, OR A FILE 

From the Search box that’s tucked into the left corner of the Taskbar, you can simply start typing the name of an 

application, setting, or file in order to access it. For example, type the word "Windows," and you’ll see tiles among 
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the search results for Windows Defender, Windows Media Player, Windows Firewall, and similar applications 

with the name “windows” contained within. The search results will appear in the column immediately above the 

search box. 

Note that across the top of the column, you will have seven filters (apps, settings, documents, folders, photos, 

videos, and music) that will assist you in refining your search. 

TASK VIEW 

If you click on the Task View button, you will open a screen that displays previews of all open windows in a grid. 

Click on any one of them to open it, or click on the X at the top-right of a window to close it.  

This is the just the beginning of what this new view has to offer. On the bottom-left corner of this Task View is a 

button with a plus icon labelled ‘New Desktop’. This is where the new virtual desktops functionality of Windows 

10 kicks in. 

HIDE THE TASK VIEW FROM THE TASKBAR 

In Windows 10, there is a Task View button that provides an overview of all your open windows and virtual 

desktop features. When it is enabled, the Task View button will always appear to the immediate right of the search 

bar/icon. 

This feature is enabled by default. If you’d like to disable it, just right-click a blank area of the taskbar and deselect 

the Show Task View button. 

VIRTUAL DESKTOPS 

The concept of virtual desktop is to give users the ability to organize open windows into individual groups often 

called virtual desktops and then switch between those groups at any time. You could group your windows by task 

(open word processing files, for example), by project, or by any criterion that makes sense to you. When you 

switch from one desktop to another, only the windows belonging in the current desktop are shown, and the rest are 

hidden away.  



Page 71 of 271 

 

In Windows 10, you start with a single regular desktop, however you can create an additional desktop and switch 

to it using the ‘New Desktop’ button in the Task View. [keyboard shortcut is Ctrl+Win+D]. You can use the task 

view to left-drag one open window from one desktop to another. You can also switch between desktops and close 

desktops from the Task View.  

VIEWING (SNAPPING) TWO WINDOWS SIDE BY SIDE (THIS WORKS WITH BOTH LEGACY APPS 

AND MODERN APPS) 

To arrange two windows side by side on the screen: 

1. Drag the title bar of an open window to the left or right side of the screen, until a half-screen outline of the 

window appears. 

2. Release the mouse button to snap the window into position. 

3. Repeat steps 1 and 2 for the other window, using the other side of the screen. 

QUADRANT SNAP 

To arrange four windows in a two-by-two configuration on the screen: 

1. Drag the title bar of the first window to the left or right side of the screen near a corner, until a quarter-screen 

outline of the window appears. 

2. Release the mouse to snap the window into position. 

3. Repeat steps 1 and 2 for the other three windows, using the other corners of the screen. 

SNAP ASSIST 

When you snap an application to the left or right, Snap Assist displays thumbnails of your other open 

applications—just select one to snap it to the other half of your screen. 
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With Snap Assist, when you snap a window to half-screen, you get a helpful UI to pick another open window to 

place in the other half. This also pops up when you have only a quarter of the screen left. It simply makes working 

with multiple open windows a lot more efficient. 

It’s now also possible to snap windows to a quadrant of the screen; moving windows to a corner snaps them to that 

quarter. In fact, snapping is now more flexible rather than just working with half of the screen. To see it in action, 

snap a window then resize it a bit. Now when you try to snap another window next to it, it will use up the available 

space rather than always snapping to half the screen. All of these features are a huge boon to those who tend to go 

overboard with open windows.  

Windows 10 adds support for virtual desktops, so you can keep your open applications better organized. For 

example, if you need to research travel plans for an upcoming trip, you could create a second virtual desktop that 

contains the application you’re using to research and plan your trip. 

 

TO CREATE ONE OR MORE NEW VIRTUAL DESKTOPS: 

1. Click on the Task View  button on the Windows Taskbar. (If the Task View is missing, 

right-click on a blank space on the Taskbar and then click on Show task view button.) 

2. Click on New desktop near the lower-right corner of the screen. 

3. And if you really enjoy virtual desktops, Windows 10 supports an unlimited number of them.  

TO SWITCH BETWEEN VIRTUAL DESKTOPS: 

1. Click on the Task View button on the Taskbar. 

2. Click on the thumbnail for the virtual desktop you want. 
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TO MOVE AN APP FROM ONE VIRTUAL DESKTOP TO ANOTHER: 

1. Click on the Task View button on the Taskbar. 

2. Click on the virtual desktop thumbnail containing the app you want to move. This action displays thumbnails 

for all open application within that virtual desktop. 

3. Right-click the thumbnail for the app you want to move. 

4. Select Move to, and then select the virtual desktop into which you want to move the app. 

TO CLOSE A VIRTUAL DESKTOP:  

Click on the Task View button on the Taskbar. Then click on the thumbnail for the virtual 

desktop you want to close, and finally click the Close button that appears in the upper-right 

corner of the thumbnail. 

NOTE: When you close a virtual desktop containing open applications, those applications are moved into the virtual 

desktop that you created most recently. 
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CHAPTER NINE 
MODERN APPS AND LEGACY APPS 

 

In Windows 10, Microsoft improved how windows works for modern applications. You can now minimize, 

maximize, resize, and position modern application on your desktop, just as you can with traditional legacy 

applications (those created for Windows 7 and earlier). However, a modern app that has been positioned (dragged) 

to the Desktop becomes a shortcut icon and cannot be resized or made to be “live.” 

CREATE A RESTORE POINT IN WINDOWS 10 

Before making any changes to original system files or installing 

a new application that edits original system files, you should 

create a restore point so that you can easily revert all changes 

with a few mouse clicks if anything goes wrong. 

Note: When you install an application or a driver that Windows 

recognizes as a Microsoft product, the operating system will 

automatically create a system restore point before the 

application or driver is downloaded. 

Simply follow the directions mentioned in one of the given 

methods below to create a restore point in Windows 10. 

Using the Software Built into Windows 10 

In the Start menu search box, type Create a restore point and 

press Enter to open System Properties dialog. 

Once System Properties is launched, under System Protection 

tab, you should see Create button. 
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If the Create button is greyed out, under Protection Settings, select your Windows 10 installed drive, which is 

usually “C”, click Configure, select Turn on system protection option in the resulting dialog, allocate at least 2% of 

drive’s space by moving the slider before clicking Apply button. 

Under System Protection tab, click Create button, enter a name or description for your new restore point, and then 

click Create button again to create restore point in Windows 10. 

Once the restore point is created, you will see The Restore point was created successfully message. You can close 

System Properties dialog now. 

Restore Windows 10 using an existing restore point 

Click Next button to view all previously created restore points, select a target restore point, and then click Next 

button. 

Tip: If you want to know what programs will be removed, select a restore point and then click Scan for affected 

programs. A Restore point only deletes applications that have been installed after creating the selected restore 

point. 

Your documents, pictures, and other files will be preserved. 

Finally, click the Finish button. When you get the confirmation dialog, click Yes button to restart your PC and 

restore Windows 10 to the selected restore point. 

HOW CAN YOU TELL WHETHER THE APP IS A LEGACY APP (PRE-WIN8) OR A MODERN APP 

(WIN8 OR LATER)? 

The easiest way to tell is to look on the far left side of the target app’s title bar once it has been opened. If you see 

the Menu  button, you have accessed a modern app. The Menu button will provide options such as search, print, 

or change settings. The options you see will vary by app. (Experiment with the Weather app and the Money app to 

see how this works.) 

Minimizing, maximizing, and closing modern applications  
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Windows behavior for modern applications can be controlled by selecting the dedicated window controls 

(informally called the resizing tools) displayed on the upper right corner of the app’s title bar—just like for legacy 

applications. 

Change the name of a Legacy (Pre-Windows 8 or 10) Tile 

1. Right-click on the target tile. An “open file location” button will appear in the dropdown menu. (If the “open 

file location” button is absent, the tile name cannot be changed.) 

2. Click on the “open file location” button. A shortcut for the target application will appear. 

3. Right-click on the shortcut and then click on rename.  Modify or change the name of the shortcut and then 

close the window. 

4. The tile name change will now appear on the Start Screen or Taskbar.  

Please note that the names of dedicated Windows 10 Apps cannot be changed. However, if a Windows 10 has been 

dragged from the Start Menu to the Desktop, it will 

automatically appear as a shortcut icon. Therefore, its 

name can generally be changed by right-clicking on 

the shortcut icon and then clicking on rename. 

CONTACT MICROSOFT SUPPORT APP 

Windows 10 includes a new “Contact Support” app 

that points you toward resolutions if you run into 

trouble. (You will find it under Contact Support in 

the All Apps section.) You can arrange to chat online 

with Microsoft agents or schedule a support call from 

right within the app—which even displays the current 

wait time for your callback. 
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HOW TO REPAIR A MODERN APP 

The Windows 10 operating system offers an easy way to repair a Win10 app, should it not function properly. If 

there is some problem with any Modern app (post-Win7):  

1. When you click on it, you will find that it simply crashes and closes down, and you will be taken back to the 

start menu again. 

2. This time, however, you will see a small ‘x’ sign on the bottom right corner of the App, indicating that 

something is wrong with this particular program.  

3. Click on it again. This time, it will display a This app can’t open message. To exit, you may click on Close. 

To repair it, you should click on the Go to the Store link. 

4. You will now see a message stating that This app needs to be repaired. 

5. Click on Repair to repair the app. The app is re-installed with all it default settings intact. 

6. Once the app is repaired, you will see a notification in the top right side stating that the app was installed. 

7. Now if you try to open the app, you will see that it opens properly. 

REINSTALL A WINDOWS 10 (MODERN) APPLICATION 

1. Navigate to your Store. 

2. Click on the Account button at the top of the page. 

3. Click on the My Apps button at the top of the page. 

4. You will find a listing for all the Win10 apps that you have previously uninstalled. 

5. Right-click on the application you want to reinstall. You can reinstall multiple apps by holding down on the 

CTRL key as you right-click on your choices. 

6. Click on the Install button at the bottom of the page. 

7. You will be able to monitor the installation by observing the information in the upper right corner of the 

Store page. 

8. The app will now appear in the All Apps column of the Start menu. From there it can be pinned to the Start 

screen or the Taskbar, or it can be dragged from All Apps to the Desktop.. 
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HOW TO REPAIR A LEGACY APP 

If a Legacy program is not functioning properly, you may want to go to the application’s website and see if there is 

an updated download available. If it was installed originally from a CD/DVD, try reinstalling the program from the 

disc.  

HOW TO CHANGE YOUR DEFAULT APPS 

Just because you installed your favorite application on your computer doesn’t mean Microsoft will turn it into the 

default app for a certain type of file. For example, if you would like Internet Explorer to be your default browser 

(rather than Microsoft Edge) or prefer to use Photo Gallery as your default image viewer and editor (rather than 

Photos, here’s how to do it: 

1. Go to Start > Settings > System (or use the keyboard shortcut Windows key + I and choose System). 

2. Click Default apps in the pane on the left. 

3. You can set defaults for certain types of files right here, like photos, music, videos, and documents. 

The app you want to set as Default should ideally already be installed on your computer, but if it isn’t, you can find 

apps directly in the Windows Store. 

Scroll down in that list and you will get advanced controls to set apps as default based on the file type, or check an 

app’s settings to find which file types it opens by default. 

Note that you can reset all of your defaults to the Microsoft recommendations with a click on the button at the 

bottom of the list. 
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WHERE DID WINDOWS 10 PHOTOS PUT MY PICTURES? 
(AND WHAT HAPPENED TO PHOTO VIEWER?) 

One common complaint from people who moved to Windows 10 is that they can't find their pictures. Your photo 

files have not moved, but the Photos app hides the complexities of your photo folder names by default. The app 

automatically catalogs every image file it finds in the C:\Users\yourname\Pictures on your computer.   

If you store photos in other folders, you will have to add those folders to the Pictures folder before the Photos app 

will catalog them.  

Add Folders to the Photos App 

1. Open the Photos app (from the All Apps menu). 

2. Go to Settings (the cog wheel in the lower left corner). 

3. Under the Sources section, click Add a folder. 

4. Find the folder you want to add, select it, and click Add this folder to Pictures. The new folder will appear as 

a Source, complete with its original path name.  

Note that if you have a Microsoft OneDrive cloud storage account, the Photos app will probably catalog its image 

contents too. If you don’t want OneDrive images to appear in Photos, go to Settings and turn off that option.  

Can You get Win 7’s Photo Viewer back?  

If you upgraded from Win 7 or 8.1 to Win 10, the familiar Photo Viewer is still there, hidden as an option. Here is 

how to make Photo Viewer your default app for viewing images in Windows 10 instead of the Photos app:  

1. Open File Explorer (Windows + E). 

2. Navigate to the folder where your pictures are stored. 

3. Open the target pictures folder.  

4. Right-click on any individual image. Move to “Open with.”  

5. Select “Choose Another App” from the dropdown menu. 
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6. Click the “More apps” option.  

7. Select “Photo Viewer” from the list of apps.  

8. Click on the “Always use this app to open image files” checkbox to leave it checked.  

9. Then click OK.  

If you have a computer that came with Win 10 already installed, or if you did a “clean installation” on your 

existing computer, then you won’t see Photo Viewer anywhere. Microsoft really, really wants you to use Photos, so 

it omitted from Windows 10 the registry keys that point to the old Photo Viewer. Getting Photo Viewer back can 

be a challenge that may not be worth it, since the process includes making modifications to the registry. There is 

always a risk in attempting to change the registry. 

Many Windows 7 and 8.1 users preferred Photo Gallery to manage and edit their pictures. It is still available for 

Windows 10. You can get it by downloading Windows Essentials. (this is a hyperlink) 

HOW TO CHANGE YOUR AUTOPLAY DEFAULTS 

Does your PC automatically open the folder when you plug in a USB drive? Does it auto-play a DVD as soon as 

it’s popped in? Well, you can change all that behavior and much more. This is called AutoPlay, and Windows 10 

lets you customize it to your heart’s content. Here’s the easy option: 

1. Go to Start > Settings > Devices (or use the keyboard short Windows key + I and choose Devices). 

2. Click AutoPlay in the pane on the left. 

3. Choose the default action when a removable drive is plugged in. 

4. Choose the default action when a memory card is plugged in. 

 

Note the shortcut to changing Default app settings at the bottom. 

http://windows.microsoft.com/en-us/windows/essentials
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However, you can get much more control over your autoplay settings through the Control Panel, if you so desire. 

Right-click the Start button, open Control Panel, and go to View Large Icons > AutoPlay. 

Here, you can choose default actions for each type of file on a removable drive (like photos, music, video, and 

such), for each type of DVD, CD, and Blu-Ray disc you insert, as well as other types of devices you connect. Like 

with default apps, you get much better, specific control over elements here, so make sure you know what you’re 

doing. 
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If nothing else, you should definitely change what Windows does for flash drives, since auto-running files from 

flash or thumb drives is one of the easiest ways to get a malware infection. 

 

SECURING YOUR LEGACY SOFTWARE FROM ATTACK 

Tens of millions of people read PDF files using Adobe Reader. Unfortunately, hackers have found ways to embed 

malware in PDF files sent through Adobe Reader that can spring to life when you view the document. Sumatra 

PDF (hyperlink) is a good alternative and is not subject to as much malware. Two other high-profile hacks have 

involved Adobe’s Flash Player and the Java software, which for years had been touted as a secure cross-platform 

http://fileforum.betanews.com/detail/Sumatra-PDF-64bit/1177957646/2
http://fileforum.betanews.com/detail/Sumatra-PDF-64bit/1177957646/2
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application environment. Some serious security holes in Java prompted many pundits to recommend removing it 

altogether. It seems that new vulnerabilities are discovered in these three pieces of software almost every day.  

The new Edge browser can control Flash Player by turning it ON and OFF on demand. The secret is having it 

turned off all the time until you need to use it to “read” a program that requires Flash. 

Software developers issue patches and updates that close these doors to hackers in a never-ending game of us 

against them. A vulnerability pops up here, hit it with a patch. Another pops up over there, hit it with another patch. 

Developers provide the patches, but it's up to us to know about these updates and download and apply the patches 

in a timely manner. 

The average computer holds about 80 application programs! Some are pre-installed, and some are downloaded 

from the Internet. These applications are vulnerable to attack from the cybercriminals. 

A good solution is to check all the software on your computer for vulnerabilities using the Secunia Personal 

Software Inspector (PSI) (hyperlink). This free program comes from a trusted security site, and scans your 

software for known vulnerabilities. It will tell you which programs need updating and provide links to sites where 

you can download patches.  

CHANGING A PROGRAM'S COMPATIBILITY SETTINGS 

If an old Windows program doesn't run in Windows 7, or if it runs poorly, you may want to try changing its 

compatibility settings. You can do this by using the Compatibility Wizard. To start the wizard click the Start 

button, type compatibility, and press Enter. You'll shortly notice that the wizard starts.  

http://www.majorgeeks.com/files/details/secunia_personal_software_inspector_(psi).html
http://www.majorgeeks.com/files/details/secunia_personal_software_inspector_(psi).html
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Clicking the Next button causes your computer to scan for programs that may have compatibility issues. Select the 

program you're having problems with and click the Next button. The wizard gives you the opportunity to decide 

how to troubleshoot the problem. 
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Click the Try Recommended Settings option to try running the program using the recommended compatibility 

settings. Based upon the particular program, the wizard applies certain settings and prompts you to start the 

program. 
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Click the Start the Program button to run the program. Test it to see if it's working properly, then click the Next 

button. This takes you to the final screen of the wizard.  
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If the program is working properly, click the top link of the final screen. If it's not working properly and you want 

to try it again with different compatibility settings, click the second link of the final screen. If it's not working 

properly and you want to search for a solution online, click the third link of the final screen. Depending upon what 

you click, the Wizard will either exit or enter a troubleshooting dialog whereupon you can answer a variety of 

questions determined by what particular problems you're having. At the end, settings appropriate to the program 

will either have been established, or it's likely that the program simply cannot be made to run properly.  

CHECK THE SIZE OF INDIVIDUAL APPLICATIONS 

The release of Windows 8 brought the concept of "apps" (long a staple in the smartphone and tablet world) to the 

desktop. As you install apps on your Windows 10 system, you discover that it can be very easy to amass quite a 

collection. 
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Obviously, apps take space on your device, whether it be mobile or desktop. Windows provides a quick way that 

you can get an overview of how much space your apps consume. This information is accessible through the PC 

Settings area.  

1. Press Win+I and then choose the System link.  

2. Click on the Apps and Features link. 

3. If you want to uninstall an app from the list, left-click on it and then click on uninstall. 

WORK WITH MORE THAN ONE APP AT A TIME 

Clicking a shortcut or a tile from the Start Menu starts the app that the shortcut represents. 

On a desktop/laptop computer, these apps are opened one by one, and their icons appear on the taskbar. To switch 

to another app that’s open, click its icon in the taskbar. On a device that’s running in Tablet mode, you switch 

between apps using the Task View.  

To switch between apps very quickly, you can also press Alt+Tab on your keyboard. This accesses a list with all 

opened apps. Keep the Alt key pressed and then press Tab to navigate between apps. When you reach the app you 

want to switch to, release both keys. 

Switch Between Apps with the Task View 

 The Task View is like a more advanced Alt+Tab list that shows you the Desktops that are open and the apps that 

are open in each Desktop.  

Here’s how to use the Task View to switch between apps:  

1. On the taskbar, click the Task View button near the Search bar. The Task View button looks like two 

rectangles stacked on each other. (If the Task View button is not showing, right-click on a blank space on the 

Taskbar and then click on the Show Task View button. 
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2. In the list of apps that appears, click the app that you want to switch to. On a touch-enabled device, you can 

access the Task View by flicking from the left side of the screen to the right. 

PIN A WEBSITE TO THE ALL APPS MENU 

Using Microsoft Edge: 

1. Open Edge from the Taskbar. 

2. Click on the X tab at the top of the Edge window (or press CTRL + T). 

3. Access the target website. 

4. Click on the three horizontal dots in the upper right corner of the page. 

5. Click on Open with Internet Explorer. 

6. Click Add site to apps. 

7. Click Add. 

8. Click on Start button (lower left corner of Taskbar). 

9. Click All apps. 

10. The target website is now listed in alphabetical order on the All apps list. 

Using Internet Explorer: 

1. Open Internet Explorer. 

2. Press CTRL + T to access a new tab. 

3. Access the target website. 

4. Click on the Cog Wheel in the upper right corner of the window. 

5. Click Add site to apps. 

6. Click Add. 

7. Click on Start button (lower left corner of Taskbar). 

8. Click All apps. 

9. The target website is now listed in alphabetical order on the All apps list. 
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Using Google Chrome: (this action will place the icon only on the Taskbar) 

1. Open Google Chrome. 

2. From within the search bar, access the target website. 

3. Click on the three horizontal bars in the upper right corner of the page. 

4. Click on More tools. 

5. Click on Add to Desktop. 

6. Click Add. 

7. Click Windows + D to return to the Desktop. 

8. Left drag the new target icon to the Taskbar. You can now delete the shortcut icon from the Desktop if you 

wish. 

SET WHICH APPS SHOW YOU NOTIFICATIONS 

In Windows 10, you get notifications not only from the operating system but also from the apps that you’re using. 

If you want to set which apps are allowed to show notifications, follow these steps:  

1. Open Settings.  

2. Click System. The list of system settings appears.  

3. Click Notifications & Actions. A list of settings appears for configuring notifications and quick actions.  

4. Scroll down to the Show Notifications from These Apps section. 

5. Set the switch to On for the apps that you want to show notifications.  

6. Set the switch to Off for the apps that you don’t want to show notifications.  

7. Close the Settings window. 
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UNINSTALL UNWANTED APPLICATIONS TO FREE UP DISK SPACE 

You probably have several applications that appear in your All Apps menu  that were placed there by either 

Microsoft or your hardware manufacturer that you know you will never use. If these unwanted applications appear 

on your Start screen or Taskbar, you can simply unpin them and they can be retrieved at a later date from All Apps. 

However, if these unwanted applications are cluttering up your All Apps menu and taking up room on your hard 

drive, you probably will want to do some housecleaning by uninstalling them. 

You can uninstall them one at a time by right-clicking on each one and selecting uninstall. The option may be 

listed under more. Note that legacy programs must be uninstalled via Programs and Features (Winkey + X) and 

reinstalled via the Internet. Modern programs can be uninstalled via the All Apps menu and reinstalled via the 

Microsoft Store. 

Another convenient method: 

1. Type Winkey + I. 

2. Click on Settings. 

3. Click on System. 

4. Click on Apps and Features. 

5. There you will find dozens of apps that can be either moved or uninstalled.  

SET THE DEFAULT APPS 

You can set the default apps for functions like the Calendar, Email, Maps, playing music, and viewing pictures. If 

you prefer using something other than the apps Windows assigns for these tasks, you can switch to other apps by 

following these steps:  

1. Open Settings.  

2. Click System. The list of system settings appears.  

3. Click Default Apps. The list of default apps appears. 
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4. Click the default app that you want to change. A list shows other apps that you can set as the default.  

5. Click the new app that you want to set as the default.  

6. Close the Settings window. 

SNAP APPS SIDE BY SIDE 

If you need to work with two apps at the same time, it’s a good idea to snap them side by side so that each 

consumes half of the screen. To snap one app to the left, use the mouse to drag the title bar of the first app to the 

left side of the screen. A transparent overlay appears, showing you where the window will be placed. Release the 

mouse button to snap the window there. Now, click the app that you want to see on the right side. You can see two 

apps, snapped side by side. 

When you snap an app with the mouse, the new Snap Assist feature pops up. Windows 10 displays a thumbnail list 

of your open windows. Click one thumbnail, and its app snaps to the unfiled side of the screen. You can also press 

Windows+left arrow or Windows+right arrow to snap an app to the left or right half of your screen. Windows 10 

adds support for vertical window snapping, but. you can’t do this with the mouse; you must use keyboard 

shortcuts: • Snap the current app to the top half of the screen by pressing Windows+up arrow. • Snap the current 

app to the bottom half of the screen by pressing Windows+down arrow. • Maximize the window by pressing 

Windows+up arrow twice. • Minimize the window by pressing Windows+down arrow twice. 

Windows 10 also gives you the ability to snap four windows at a time in a 2 x 2 grid. To snap a window in a 2 x 2 

grid with the mouse, drag and drop it into one of the four corners of the screen. Drag-and-drop several windows in 

this way to get your 2 x 2 grid of open windows.  
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PIN APPS TO THE TASKBAR 

If you use certain apps frequently, you may want to pin them to the taskbar so that you can access them as quickly 

as possible. Here’s how to pin an app to the taskbar: 

1. Right-click the app’s icon.  

2. In the pop-up menu that appears, click to More, then Pin to Taskbar. 

3. To unpin an app from the taskbar, at Step 2, select Unpin from Taskbar. 
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CHAPTER TEN 

FILE EXPLORER 
New features in File Explorer (Windows key + E) help you organize better and find things faster, with quick access 

to your files from any PC or tablet. 

QUICK ACCESS TO THE FILES THAT MATTER MOST 

The Quick access page is the shortest route to files you've been working on and folders you often use.  

To make sure a folder shows up in Quick access, right-click the target folder, and then select Pin to Quick access. 

A pin icon shows you which folders you’ve pinned, so it’s easy to tell them apart from the rest.  

UNPIN FOLDERS FROM QUICK ACCESS 

To unpin a folder from the Quick Access section, Open File Explorer (Windows +E) and follow these steps:  

1. Click the Quick Access section.  

2. Right-click the folder that you want to unpin.  

3. In the right-click menu, click Unpin from Quick Access. The selected folder is no longer listed in Quick 

Access. 

CHANGE THE FILE EXPLORER START LOCATION 

When you start File Explorer, by default, it opens Quick Access. You can change the start location to This PC by 

opening File Explorer and following these steps: 

1. Click the File tab on the Ribbon.  

2. Click on the Options tab. 

3. Click Change Folder and Search Options. 
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4. A list with two options is shown: Quick access and This PC. 

5. Select This PC . 

6. Click OK.  

7. Close File Explorer. The next time you Open File Explorer (Windows +E), it displays This PC rather than 

Quick Access. 

HOW TO MAKE WINDOWS EXPLORER ALWAYS SHOW THE FULL PATH  

By default, the Title Bar will display your current location in the file system. However, if it does not, follow these 

steps: 

1. Press the Windows + E keyboard combination to open Windows Explorer.  

2. Switch to the View tab.  

3. On the right-hand side click on options and then select Change folder and search options from the drop-

down menu.  

4. When the Folder Options dialog opens, switch over to the View options.  

5. Here you will need to click the Display the full path in the title bar check box.  
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ENABLE AND USE THE PREVIEW PANE 

In File Explorer, you can enable a Preview pane that is shown on the right side of the window. As the name 

implies, you can use it to preview the contents of certain types of files (text, images, and videos). For example, if 
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you select an image file in File Explorer, you can see a preview of it; if you select a text file, you can preview its 

contents.  

To enable the Preview pane, Open File Explorer (Windows +E) and follow these steps: 

1. In the File Explorer window, click the View tab. 

2. In the Panes section, click the Preview Pane button. The Preview pane is added to the right side of the File 

Explorer window. 

3. Select several files one by one. You can preview their contents in the Preview Pane, if they are text, images, 

or videos.  

To disable the Preview pane, just follow the preceding steps.  
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ENABLE THE DETAILS PANE 

You can enable a Details pane that is shown on the right side of the File Explorer window. As its name implies, 

you can use the Details pane to find more information about each file, such as its size, the date it was created, and 
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the date it was last modified. The fields of data shown in this pane vary from file to file. For some files, such as 

pictures, you see lots of data; whereas for other files, such as PDF files, you see less data. 

To enable the Details pane, Open File Explorer (Windows +E) and follow these steps:  

1. In the File Explorer window, click the View tab. 

2. In the Panes section, click the Details Pane button. The Details pane is added to the right side of the File 

Explorer window. 

3. To see a file’s details, click it to select it.  

To disable the Details pane, just follow the preceding steps. The Details pane button is an on/off toggle. 
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DISABLE OR ENABLE THE NAVIGATION PANE 

The Navigation pane is shown by default on the left side of the window. As the name implies, you can use it to 

quickly jump to different locations on your computer. When the Navigation pane is disabled and you start File 

Explorer, either Quick Access or This PC is loaded, depending on your start location for File Explorer. It is not 
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advisable to disable the Navigation pane because doing so makes navigation more difficult. If you decide to disable 

the Navigation pane, follow these steps:  

1. Open File Explorer (Windows +E).  

2. Click the View tab. 

3. In the Panes section, click the Navigation Pane button. The Navigation Pane menu appears.  

4. In the menu, click Navigation Pane.  It is an on/off toggle. The Navigation pane (the entire left column) no 

longer appears at the left side of the File Explorer window. 

5. To enable the Navigation pane, follow the preceding steps. 

ENABLE THE LIBRARIES SECTION IN THE NAVIGATION PANE 

By default, the Navigation pane doesn’t show the Libraries in Windows 10, as it did in Windows 7. Fortunately, 

the libraries aren’t gone; they’re just hidden. To enable and use the libraries, Open File Explorer (Windows +E) 

and follow these steps:  

1. In the File Explorer window, click the View tab.  

2. In the Panes section, click the Navigation Pane button.  

3. In the menu, click Show Libraries. The Libraries are now added to File Explorer.  

4. Click the Libraries shortcut in the Navigation Pane to view your libraries. 

USE VIEWS TO BETTER EXAMINE YOUR FOLDERS’ CONTENTS 

When you first browse a folder, File Explorer automatically applies a view that’s optimized for the contents of that 

folder. However, the Ribbon has a number of view options in the Layout section of the View tab:  

 Details: For each file and folder, the Details view shows several columns with information, such as Name, 

Date Modified, Type, and Size. Each file has its own small icon that represents the file type.  
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 Content: Each file and folder appears on a separate row, where you see detailed information about it, such as 

the date the file was last modified, its size, its author, and its length (for audio and video files). For picture 

and video files, you see a small preview of the content rather than a file icon. 

 List: Displays a simple list of folders and files, each with an identifying icon.  

 Tiles: Displays a medium-size icon representing each file and folder, along with information about their 

types and sizes. 

 Extra-large icons: Displays extra-large icons that are representative of the contents of each file. For pictures 

and video, you see a preview of each file.  

 Large icons: Displays large icons that are representative of the contents of each file. For pictures and video 

you see a preview of each file.  

 Medium icons: Displays medium icons that are representative of the contents of each file. For pictures and 

video you see a preview of each file.  

 Small icons: Displays small icons that are representative of the contents of each file. You can easily switch 

between these views by clicking on them. 

File Explorer remembers the last view that you used for a folder and applies it the next time you open it. 

ALWAYS SHOW THE MENU BAR IN ALL YOUR WINDOWS  

A feature that Microsoft left out of Windows 7 that was in previous versions of Windows going way back to 

Windows 95 was the Menu Bar with “File, Edit, View, etc.” options that appeared at the top of each window. 

Apparently, the Microsoft engineers didn’t think we would want to use it. They were wrong! 

Fortunately, there are a couple ways to recover the Menu Bar in all your windows and make it stick. 

Just click the Search Box and type Folder Options and then press <Enter>. Click on the View tab if it’s not 

already selected, and under the Advanced Settings area, check “Always show Menus”. Click OK. 
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You only have to make this adjustment once. From that point on, the change will “stick.” 

While we’re on the subject, you have probably noticed that the Menu Bar does not appear in Internet Explorer by 

default. To add the Menu Bar to IE, just open your browser and right-click on the colored band across the top of 

the window. When you click on the Menu Bar button (it is an on/off toggle), the Menu Bar will appear. From this 

point forward, your browser will show the Menu Bar at the top of the window.  

SORT FILES AND FOLDERS 

File Explorer offers the Sort tool for sorting the files and folders that you’re viewing based on criteria such as their 

name, type, size, authors, and more. To sort the files within a folder, Open File Explorer (Windows +E) and follow 

these steps:  

1. Navigate to the folder that you want to sort.  

2. Click the View tab on the Ribbon.  

3. In the Current View section, click the Sort By button.  

4. Click the sorting criteria that you want to use to apply it. The files and folders for your current location are 

now sorted using the criteria you selected. 

GROUP FILES AND FOLDERS 

With File Explorer, you can group the files and folders that you’re viewing based on criteria such as their name, 

type, size, authors, date, and more. To group the files within a folder, Open File Explorer (Windows +E) and 

follow these steps: 

1. Navigate to the folder whose contents you want to group.  

2. Click the View tab on the Ribbon. The View tab is shown. 

3. In the Current View section, click the Group By button. The Group By menu appears. 

4. Click the grouping criteria that you want to use to apply it. The files and folders for your current location are 

now grouped using the criteria you selected. 
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CUSTOMIZE FILE EXPLORER WITH FOLDER OPTIONS 

You can reconfigure certain ways that File Explorer works. All the configuration settings are in a window named 

Folder Options. This window has three tabs filled with settings. Here’s how to access the Folder Options window, 

browse its settings, change them, and apply your desired configuration: 

1. Open File Explorer (Windows +E).  

2. Click File. The File menu appears.  

3. Click Change Folder and Search Options. The Folder Options window appears at the General tab. Here are 

settings for browsing folders in File Explorer, opening an item in File Explorer, and whether to show 

recently used files and folders in Quick Access.  

4. In the General tab, change the settings that you are interested in. 

5. Click the View tab. Here you will find settings for viewing files and folders in File Explorer. The list of 

settings is long. Browse through the list and read what they do. Each name is self-explanatory. 

6. Change any advanced settings that you want.  

7. Click the Search tab. Here you find settings for using search in Windows 10 and in File Explorer.  

8. Change how search works. 

9. To apply your settings, click OK. 

USE CHECK BOXES TO SELECT FILES AND FOLDERS 

You can set File Explorer to display check boxes near the name of each file and folder. You can then use these 

check boxes to select files and folders.  

To enable check boxes in File Explorer, follow these steps:  

1. Open File Explorer (Windows +E).  

2. Click the View tab on the Ribbon.  
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3. In the Show/Hide section, click Item Check Boxes. Check boxes are now shown each time you move your 

cursor on top of a file or folder. Click the check box to select that item. 

4. To disable the check boxes, follow the preceding steps. 

5. The Item Check Boxes will be either On or Off, depending upon how you have set it. 

6. Close File Explorer. 

CLEAR FILE EXPLORER’S HISTORY OF RECENTLY USED FILES AND FOLDERS 

By default, File Explorer remembers all the files and folders that you’ve accessed and displays them in different 

places, like in Quick Access. If you want to clear your history of accessed files and folders, Open File Explorer 

(Windows +E) and follow these steps:  

1. Click File. The File menu appears.  

2. Click Change Folder and Search Options. The Folder Options window appears. 

3. In the third panel from the top (Privacy), click on the Clear button. 

4. Click OK. 

MAXIMIZE OR MINIMIZE THE RIBBON IN FILE EXPLORER 

By default, the Ribbon is minimized in File Explorer. If you find it useful and you want to have it available, you 

may want to maximize it all the time.  

Here’s how to maximize and minimize the Ribbon in File Explorer:  

1. Open File Explorer. 

2. Double-click the Computer tab on the Ribbon. The File Explorer window changes to make room for the 

maximized Ribbon. 

3. Close File Explorer. 

4. To minimize the Ribbon, open File Explorer again and double-click on the Computer tab. This procedure 

will minimize the Ribbon.  From now on, the Ribbon is minimized each time you open File Explorer.  
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5. Double-click the Computer tab on the Ribbon. The File Explorer window now minimizes the Ribbon.  

6. Close File Explorer. 

7. Open File Explorer again. Now the Ribbon is minimized when you open File Explorer. File Explorer 

remembers whether the Ribbon was minimized or maximized the last time you closed it and will open it that 

way the next time you open File Explorer. 
 

FIND FILES IN FILE EXPLORER USING SEARCH 

The name of the search bar, which is located in the upper-right corner of the File Explorer window, always starts 

with “Search,” followed by your current location in File Explorer. This search bar functions differently from the 

search bar found on the taskbar. First, you can use File Explorer’s search bar only to search for files and folders. 

Also, the search is performed only in your current location. For example, if you’re in Quick Access and you type 

the name of a file, Windows 10 searches for it only in the locations found in Quick Access. Similarly, if you go to 

the Pictures folder and you type the name of a file, Windows 10 searches for it only in the Pictures folder.  

Here’s an example of a search:  

1. Click on This PC in File Explorer’s left column. 

2. Double-click the C drive, usually named Local Disk (C). 

3. In the search bar at the top-right corner of the File Explorer window, type wordpad.  

4. Press Enter. A progress bar appears at the top of the File Explorer window until the search finishes. The 

results returned are all from the C drive of your computer  

5. Click the Documents folder in the Quick Access section.  

6. In the search bar, type a different filename, one that’s found in your documents. 

7. Press Enter. The results returned are from the Documents folder, not from other locations on your computer. 

Also, because you’re searching in a location that’s indexed by Windows 10, you receive the results much 

faster than you did in the previous search.  

8. Close File Explorer. 
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MOVE A FILE OR FOLDER IN FILE EXPLORER 

You can move one or more files or folders to another location several ways. One way is to use the Cut and Paste 

commands. To do so, open File Explorer and follow these steps:  

1. Browse to the file’s or folder’s location and select it by clicking on it.  

2. In the dropdown menu that appears, click on the Cut button. 

3. Browse and right-click on the folder where you want to move that file. 

4. In the dropdown menu that appears, click on the Paste button 

5. The selected file is now in the new folder.  

6. Close File Explorer.  

 

CREATE A FOLDER IN FILE EXPLORER 

You can create as many folders as you want, either directly on a drive on your computer or within other folders. 

Using multiple folders enables you to better organize your files, so create as many as you need. To create a folder, 

open File Explorer and follow these steps:  

1. Go to the location where you want to create the folder. It can be a drive on your computer or another folder.  

2. Right-click on the target folder and then click on New Folder from the dropdown menu. 

3. A new folder is created with the name New Folder.  

4. Type the name that you want for the newly created folder. 

5. Press Enter or click somewhere else in the File Explorer window. The newly created folder now has the 

name that you typed.  

6. Close File Explorer. 
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CREATE A SHORTCUT TO A FILE OR FOLDER IN FILE EXPLORER 

You may want to create a shortcut to a file or folder and place it on the Desktop for quick access or in some other 

location that you go to frequently. To create a shortcut, open File Explorer and follow these steps:  

1. Locate the file for which you want to create a shortcut. 

2. Right-click on that file and in the menu that appears, select one of these options: 

• Click Create Shortcut. This creates a shortcut in the folder where the file is found. You can then move the 

shortcut to another folder.  

• Click Send To; then click Desktop (Create Shortcut). This creates a shortcut to the file on the Desktop. 

Shortcuts are references to the files and folders that they point to. When you delete a shortcut, the item it points to 

remains on your computer. On the other hand, if you delete or move the file or folder it points to, the shortcut 

doesn’t work. 

SELECT MULTIPLE FILES OR FOLDERS IN FILE EXPLORER 

When you are working with files and folders in File Explorer, sometimes you may want to select more than one 

item. For example, you may want to select a group of files and delete them or select multiple folders and move 

them to another folder. Here’s the quickest way to select items in File Explorer:  

1. Click the first file or folder that you want to select.  

2. Press and hold the Ctrl key on your keyboard.  

3. With the Ctrl key still pressed, click each file and folder that you want to select. 

4. Release the Ctrl key after you select the items. Each of the selected items is highlighted with a blue 

bar in File Explorer. Now you can apply commands (via right-click on one of them) like Cut, Copy, or 

Delete to all selected items. 
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VIEW OR HIDE FILES OR FOLDERS 

The operating system, as well as some apps, install folders and files that are hidden from File Explorer. They exist 

and can be used, but they aren’t shown unless you “unhide” them. Also, you can mark some files as hidden so that 

others can’t see them. Luckily, File Explorer enables you to set whether to view or hide items. For example, you 

may wish to hide from view your income tax records.  

Let’s say you have a file folder on your Desktop that contains your tax records. You want to hide it from view until 

you are ready to use its contents. 

Just follow these steps:  

1. Open File Explorer (Window + E). 

2. From the left column, double-click on Desktop. In this example, that’s where your Tax Records folder is 

housed. 

3. Click on the Tax Records folder. 

4. Click the View tab on the Ribbon. 

5. Click on Hide selected items. 

6. The Confirm attribute changes window will open along the left edge. (see snip of this window below) 

7. Click the bullet for Apply changes to this folder, subfolder, and files. 

8. Click OK. 

9. Now uncheck the Hidden items button. 

10. The Tax Records folder has disappeared from view on the Desktop. 
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To return the Tax Records folder to its normal state: 

1. Open File Explorer (Windows + E). 

2. Double-click on the Desktop folder. 

3. Click the View tab on the Ribbon. 

4. Check the Hidden items button. This action will cause the Tax Records icon to return to view in the Desktop 

folder. 

5. Click on the Tax Records icon. 

6. Click on Hide selected items. 

7. The Confirm attribute changes window will open. 

8. Click the bullet for Apply changes to this folder, subfolder, and files. 

9. Click OK. 

10. Now uncheck the Hidden items button. 
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11. The Tax Records folder has now reappeared on the Desktop 

CHECK FOLDER SIZES AT A GLANCE 

When you view Windows Explorer (Windows key + E) in Details view, the Size column shows the space 

consumed by individual files but provides no information on the size of folders.  

To find the total size of any folder (or nested folder) contents, right-click on the target folder, and then click on 

Properties. The total size of that folder’s contents will appear.  

This information is especially important if you are planning to copy the entire contents of a folder to another 

medium, e.g., a flash drive. 

PASSWORD PROTECT IMPORTANT FILES IN WIN10 

The first thing you should do is to create a folder on your Desktop that will contain your password-protected 

subfolder. Call the folder Private, or some other name of your choosing. 

Once that new folder is created, navigate inside the folder and create a text document. (Right-click on a blank 

space inside the folder, click on New, then click on text. A new text document will appear.) 

There is no need to give this text document a unique name because you will be deleting it after everything is done. 

Once this new text document is created, just open it and paste the following inside: 

cls 

@ECHO OFF 

title Folder Locker 

if EXIST "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" goto UNLOCK 

if NOT EXIST Locker goto MDLOCKER 
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:CONFIRM 

echo Are you sure u want to Lock the folder(Y/N) 

set/p "cho=>" 

if %cho%==Y goto LOCK 

if %cho%==y goto LOCK 

if %cho%==n goto END 

if %cho%==N goto END 

echo Invalid choice. 

goto CONFIRM 

:LOCK 

ren Locker "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" 

attrib +h +s "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" 

echo Folder locked 

goto End 

:UNLOCK 

echo Enter password to Unlock folder 

set/p "pass=>" 

if NOT %pass%==Your-Password-Here goto FAIL 

attrib -h -s "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" 

ren "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" Locker 

echo Folder Unlocked successfully 

goto End 

:FAIL 

echo Invalid password 

goto end 

:MDLOCKER 

md Locker 

echo Locker created successfully 
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goto End 

:End 

 

You will now need to add your required password to gain access to your private file whenever you need them. To 

do this, locate “Your-Password-Here” in the script you just copied and pasted in the text document. Delete “Your-

Password-Here” and type in your desired password. (the line is located in the lower one-third of the script). 

Within the text document, click on File, and then Save as. After that, you should see something called Save as type, 

click the drop down menu and choose All files. Once done, save the document as FolderLocker.bat and close it. 

You should now see a file with the name, “FolderLocker”. Double click on it and it should automatically create a 

folder called Locker. This is where you will be storing all your sensitive data. Open it and place your files inside, 

when you’re done, return to the file called FolderLocker and double-click it. You should see the following: 

 

Type “Y” and press Enter. This will lock the Locker folder, which will force it to disappear. If you would like to 

see it again, double-click FolderLocker again, but this time you’ll need to type the password you have chosen. 

Next, press Enter. 

You can now safely store your sensitive files in a password-protected folder without using a third party software. 

You should try using this trick on empty folders, till you get a hang of it. Don’t go on and password-protect your 

important data right-away. Once you get the hang of it, you can use it on your important folders with a high level 
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of confidence. Also if you were to forget your password, simply right-click the FolderLocker.bat file and select 

Edit. You will be able to see the password there.  

DISPLAY FILE EXTENSIONS FOR CLARITY 

By default, Windows is configured so that file extensions are not displayed—at least they aren't displayed for 

extensions that Windows recognizes. So instead of seeing a file whose name is "MyFile.txt," Windows only 

displays "MyFile." This could get confusing if you have different types of files with the same name, like 

"MyFile.txt," "MyFile.docx," "MyFile.jpg," etc. Each of these—because Windows recognizes the extension—

would be displayed simply as "MyFile." 

To eliminate the possibility for confusion, many users change how Windows is configured so that it displays the 

file extensions. This allows you to see the full name of every file with which you work. 

To turn on the display of file extensions, start by opening File Explorer (Winkey + E).  Click on the View tab, then 

the Options icon located near the right side. This action will bring up the Folder Options dialogue. Finally, click on 

the View tab. 
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The Hide Extensions for Known File Types checkbox determines whether the system should hide extensions for 

known file types. The checkbox is selected by default, so file extensions are not displayed. You should clear the 

checkbox if you want to see full file names. Once your selection is made, click the OK button and the extensions 

are immediately unhidden. 
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ARCHIVE FILES AND FOLDERS IN A ZIP FILE 

Archives are useful when you want to send multiple files to someone by email. Instead of attaching several large 

files, archive them into one file. That file takes less space than sending all the files separately, and it’s easier to 

attach and send by email. The most popular format for archiving files is .zip and Windows 10 can automatically 

work with this type of archive without having to install a third-party app. 

To archive several files and folders into a .zip file, open File Explorer and follow these steps: 

1. Select the files and folders that you want to archive.  

2. Right-click on one of the selected items. 

3. From the dropdown menu, click on Send to: Compressed (zipped) folder. 

4. The target files and folders will be combined into a single zipped folder. 

5. An archive is automatically created in the same folder as the files and folders that you selected. You can edit 

the name of the archive. 

6. Type the name that you want for the archive file.  

7. Press Enter or click somewhere else in the File Explorer window. You can now use the newly created .zip 

archive and send it by email or store it where you want on your computer. If you want to save space on your 

hard disk, it’s a good idea to delete the files and folders that you placed in an archive, as you can always 

extract them from the archive. 

 

VIEW AND EXTRACT THE CONTENTS OF A ZIP FILE 

When you receive an archive in the .zip format, you can view its contents and extract it in File Explorer. Here’s 

how: 

1. Open File Explorer.  

2. Go to the location of the archive file.  

3. Double-click the file to view its contents.  
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4. Click the Extract tab on the File Explorer Ribbon. 

5. Click the Extract All button. A wizard appears asking you to select where to extract the files.  

6. Click Browse. 

7. Select where you want to extract the files.  

8. Click Select Folder.  

9. Click Extract. The files are extracted. File Explorer opens the folder that you specified, where you can view 

all the files and folders that were in the archive.  

10. Close File Explorer and the archive you just extracted. The Extract tab on the File Explorer Ribbon also 

gives you options for extracting individual files to standard user folders like Documents, Pictures, and 

Downloads. 
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CHAPTER ELEVEN 

ONEDRIVE: MICROSOFT’S CLOUD STORAGE SOLUTION 

OneDrive is Microsoft’s cloud storage solution. It’s similar to products like Google Drive or Dropbox and is 

embedded in Windows 10. With OneDrive, you can synchronize your files and folders across all Windows devices 

as well as devices using Android or iOS. The files you store in your OneDrive folder are automatically uploaded to 

Microsoft’s servers and then synchronized across all your devices on which OneDrive is installed and set up.  

OneDrive offers 5GB of free storage space for every Microsoft account. You can also purchase more storage or 

take advantage of offers like the 1TB of storage space available to Office 365 subscribers. 

In this chapter, you will find out how to use the OneDrive app that’s bundled with Windows 10, which includes 

tasks such as uploading files, choosing which folders to synchronize, sharing files and folders with others, and 

fetching your files remotely. 

ACCESS ONEDRIVE 

You can start OneDrive and access your files in the cloud several ways. This one works on all Windows 10 

devices:  

1. Click the Start button.  

2. Click All Apps. 

3. Scroll down the list of apps until you find those starting with the letter O.  

4. Find and click on OneDrive. 

UPLOAD FILES 

Uploading your files to OneDrive is as easy as copying them to the OneDrive folder. Here’s how:  

1. Open File Explorer (Windows + E). 
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2. Browse to the file that you want to upload to OneDrive.  

3. Right-click on the target file and select copy from the dropdown menu. 

4. Move to the Navigation pane on the left side of the File Explorer window and right-click on OneDrive.  

5. From the menu that opens, click on paste.  

 

VIEW A FILE OR FOLDER ON ONEDRIVE.COM 

If you want to view the contents of a file or folder on the OneDrive website instead of viewing it locally, you can 

do so.  

Follow these steps:  

1. Open a browser. 

2. Access your favorite search engine. 

3. Search for onedrive.com.  

4. If you are not signed on to your Microsoft account, you will need to do so to access your OneDrive account.  

 

SHARE A ONEDRIVE LINK 

To share a file or folder with someone, you can generate a sharing link on OneDrive. OneDrive automatically 

generates this link and stores it on the Clipboard. You can paste it anywhere you want; for example, in an email 

message. If you share a file, anyone who receives the link can edit that file; if you share a folder, anyone who 

receives the link can view that folder.  

Here’s how to quickly generate a sharing link on OneDrive and share it with others:  

1. Open OneDrive.  

2. Browse to the OneDrive file or folder that you want to share.  

3. Right-click the file or folder you want to share.  
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4. In the menu that appears, click Share a OneDrive link. A notification appears showing that the link is ready 

to paste.  

5. Open the email app where you want to use this link. 

6. Paste the link into that app and send the link to the intended person. 

  



Page 121 of 271 

 

 

CHAPTER TWELVE 
WINDOWS DEFENDER AND FIREWALL 

Windows Defender is included with Windows 10 and helps keep malware from infecting your PC in two ways:  

 Providing real-time protection. Windows Defender notifies you when malware tries to install itself or run on 

your PC. It also notifies you when apps try to change important settings. 

 Providing anytime scanning options. Windows Defender automatically scans your PC for installed malware on 

a regular basis, but you can also start a scan whenever you want. Windows Defender automatically removes (or 

temporarily quarantines) anything that's detected during a scan. A Quick scan is usually adequate. However, if 

you suspect trouble that’s causing your computer to hiccup, do a manual Full scan. Just remember that a Full 

scan can take a couple hours to complete. 

 

To access Windows Defender, type defender in the search box/icon to the right of the Start menu, then click on the 

either Windows Defender or Windows Defender Settings that appear at the top of the list. 

PIN THE WINDOWS DEFENDER TILE TO THE START SCREEN FOR EASY ACCESS 

1. Access Settings (Windows + I) 

2. Click on the Updates and Security tile. 

3. Right-click on Windows Defender. 

4. Click on Pin to Start. 

5. Click Yes. 

6. From now on, you can check on Windows Defender by clicking on the appropriate tile that appears on the 

Start Screen. 
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CONFIGURE WINDOWS DEFENDER 

Here’s how to access Windows Defender’s settings and how to change them: 

1. Open Settings. 

2. Click Update & Security. 

3. In the list of settings that appears, click Windows Defender. All Windows Defender related settings are 

shown.  

4. Set the Real-Time Protection switch to On or Off, depending on whether or not you want to enable this 

feature.  

5. Set the Cloud-Based Protection switch to On or Off, depending on whether or not you want to enable this 

feature. 

6. Set the Sample Submission switch to On or Off, depending on whether or not you want to enable this 

feature. 

7. Close Settings.  

If you don’t have another antivirus installed, don’t disable the real‑time protection offered by Windows Defender. 

Doing so leaves your computer completely unprotected. Always have at least one antivirus product installed and 

active on your computer or device to keep you safe from viruses and other types of malware. 

SET EXCLUSIONS FOR WINDOWS DEFENDER 

One of the new and useful features of Windows Defender is that it allows you to set advanced exclusions. These 

exclusions can be files, file locations, file extensions, and processes that you don’t want Windows Defender to scan 

and block.  

Here’s how:  

1. Open Settings.  

2. Click Update & Security. 



Page 123 of 271 

 

3. In the list of settings that appears, click Windows Defender. All Windows Defender related settings are 

shown.  

4. Click Add an Exclusion in the Exclusions section on the right.  

5. Find the type of exclusion that you want to set. If you’re interested in excluding a file, go to the Files section. 

If you’re interested in excluding a folder, go to the Folders section, and so on. 

6. Click the appropriate Exclude button for the type of item that you want to exclude.  

7. Select the item that you want to exclude and confirm your choice. That item is now shown in the list of 

exclusions.  

8. Close Settings.  

Don’t create a long list of exclusions. Doing so lowers the security of your system. Set exclusions only for the files, 

folders, or processes that you’re completely certain are safe, or that Windows Defender has trouble scanning or 

dealing with. 

WINDOWS DEFENDER CAN NOW BE A SECOND LAYER OF PROTECTION 

Windows Defender can now keep protecting your PC by providing a second layer of protection, even if you install 

another antivirus. 

Generally, you aren’t supposed to run two always-on antivirus programs at once. As such, Windows Defender 

normally disables itself if you install another antivirus and gets out of the way. But a new option allows Windows 

Defender to provide some help (called limited periodic scanning) without providing full real-time protection.  

How to Enable Limited Periodic Scanning 

This option is named “limited periodic scanning”. Enable it, and Windows Defender will occasionally perform a 

scan to check for any malware that your primary antivirus product missed. However, it’s not enabled by default. 
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You’ll find this option under Windows Defender’s Settings in the Settings app. To access it, open the Start menu 

and select “Settings” (alternative= Windows key + I). Click on Update & Security, then Windows Defender. From 

there, enable the “Limited Periodic Scanning” feature. 

You can only enable this feature if you’re using another antivirus program. If you haven’t installed another 

antivirus program, Windows Defender is already enabled and helping protect your computer with both real-time 

and scheduled system scans. 

Windows Defender will automatically be updated with the latest antivirus applications through Windows Update. 
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How to Perform a Manual Scan 

You can also perform a manual scan of your entire computer or specific folders with Windows Defender, even if 

you’re using another antivirus program. Windows Defender can provide a second opinion that might catch 

something missed by your normal antivirus program. 

To do this, launch Windows Defender. Go to Settings (Windows + I), then Update & Security, followed by 

Windows Defender, and finally Open Windows Defender. From there, you can launch the application. 

Assuming that you’ve set up limited periodic scanning, you’ll see a message saying “Windows Defender Periodic 

Scanning is ON”, but that real-time protection is handled by another antivirus program. 

To perform a manual scan, select “Quick” for a fast scan, “Full” for a deep system scan, or “Custom” for a scan of 

only the folders of your choose. Click “Scan Now” to start the scan. 

Windows Defender should automatically be updated with the latest antivirus definitions, but you can click the 

“Update” tab here and manually check for updates before scanning, if you like. 

 



Page 126 of 271 

 

 

If Windows Defender Detects Malware… 

If malware is detected through either type of scan, you’ll see a notification (Windows + A) saying potentially 

harmful software was detected. 
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You can view a list of malware found by Windows Defender through the History tab in the Windows Defender 

window. 
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If you regularly notice malware getting through your primary antivirus and being caught be Windows Defender, 

you should probably switch to another primary antivirus program. 

 

 

ADD TWO FREE ANTI-MALWARE APPLICATIONS TO COMPLEMENT WINDOWS DEFENDER 

According to many experts, you should have a "cocktail" of anti-spyware programs installed on your computer, 

including the two highly regarded free applications listed here. It’s not advisable to have them running in the 
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background (at startup). Have them downloaded and installed (pin them to the Taskbar) so that you can run them 

“on demand” on a periodic basis. 

Malwarebytes’ Anti-Malware Free is simple to use and will detect and remove malware from your computer. 

(https://www.malwarebytes.org/antimalware/ ). When you arrive at the website, click on the Download: free 

version button and follow the prompts.  

SUPERAntiSpyware Free Edition can scan hard drives (internal and external), as well as the Registry and 

remove all manner of malware. You can also customize your scans, although you can’t set up automatic scanning. 

(http://superantispyware.com/ ). When you arrive at the website, click on the Free Edition: download button and 

follow the prompts.  

WINDOWS FIREWALL 

Type firewall while you are on the Search box. Click on Windows Firewall at the top of the column. Here you will 

find tools to turn the firewall on or off as well as configure behaviors for public and private networks. Advanced 

settings for the Windows Firewall are also accessed here. 

Windows Firewall helps block unauthorized access to your computer while permitting authorized communications 

to and from your computer. Windows Firewall filters both inbound and outbound network traffic, based on a set of 

applied rules and exceptions and on the type of network to which you’re connected. If you aren’t using a 

third‑party security suite that includes a firewall, it’s highly recommended that you use Windows Firewall because 

it provides a sufficient level of security. By default, Windows Firewall has a predefined set of rules that are applied 

as soon as it’s turned on.  

Windows Firewall allows you to perform tasks such as these: 

 browse the Internet;  

 use instant messaging apps;  

 connect to a HomeGroup, if you’re working from home;  

https://www.malwarebytes.org/antimalware/
http://superantispyware.com/
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 and share files, folders, and devices with other computers.  

CUSTOMIZE APPS THAT ARE ALLOWED THROUGH THE FIREWALL 

Here’s how to customize the apps that are allowed to go through the Windows Firewall:  

1. In the search bar on the taskbar, type the word firewall.  

2. Click the Allow an App Through Windows Firewall search result. The list of Allowed Apps appears.  

3. Click Change Settings. The list is now editable.  

4. Select the app that you want to customize by clicking it. 

5. Check the network profile(s) where you want to allow access and uncheck the network profile(s) where you 

want to block access. 

6. Click OK. 

CUSTOMIZE YOUR PRIVACY 

Windows 10 and your apps can get access to lots of personal data and use that information to show personalized 

information and notifications. For example, apps can access your name, picture, advertising ID, location, contacts, 

calendar, and more. Luckily, Windows 10 gives you the tools you need to control which personal information is 

accessed and by which apps.  

Here’s how to customize several general privacy related settings:  

1. Open Settings.  

2. Click Privacy. The list of privacy‑related settings appears.  

3. Click General. 

4. Set the privacy settings that you want to enable to On. 

5. Set the privacy settings that you want to disable to Off.  

6. Close Settings. 
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CLEAR YOUR LOCATION DATA AND DISABLE LOCATION SERVICES 

By default, Windows 10 apps as well as the operating system can request your location and location history. If you 

don’t want them to access your location, follow these steps to disable location services:  

1. Open Settings.  

2. Click Privacy. The list of privacy‑related settings appears.  

3. Click Location.  

4. Click the Change button under Location for this device is on.  

5. Set the Location for This Device switch to Off. 

6. Close Settings. 

If you want your location history cleared, in the Location window, click the Clear button (it’s below Clear history 

of this device). 

CONTROL APPS THAT ACCESS YOUR CONTACTS 

By default, Windows 10 apps can access your contacts when they need to. You can block some apps from 

accessing your contacts as well as all the apps you install.  

Here’s how:  

1. Open Settings. 

2. Click Privacy. The list of privacy‑related settings appears.  

3. Click Contacts and a list of apps that need access to your contacts is shown. 

4. If you want to disable access to your contacts for all apps, set the available switch to Off for all apps in the 

list. 

5. If you want to block only one app from accessing your contacts, set its switch to Off.  

6. Close Settings. 

CONTROL WHICH APPS CAN ACCESS YOUR CALENDAR 
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By default, Windows 10 apps can access your calendar when they need to. You can block some apps from 

accessing your calendar as well as all the apps you install. Here’s how:  

1. Open Settings.  

2. Click Privacy. The list of privacy‑related settings appears.  

3. Click Calendar and a list of apps that need access to your calendar is shown.  

4. If you want to disable access to your calendar for all apps, set the Calendar switch to Off.  

5. If you want to block only one app from accessing your calendar, set the App’s switch to Off.  

6. Close Settings. 

 

WINDOWS 10’S RELIABILITY MONITOR:  TO FIX AND FINE-TUNE YOUR PC 

Reliability Monitor is a built-in part of Windows that’s been around since the introduction of Windows Vista back 

in January 2007. It’s always been a somewhat hidden feature of the Windows operating system, and therefore easy 

for users to overlook. Nevertheless, it’s a great tool that provides all kinds of interesting insight into system history 

and stability. Reliability Monitor is particularly useful when troubleshooting glitchy systems, and can provide 

insights into possible causes as well as important clues to fixing things.  

UNDERSTANDING RELIABILITY MONITOR 

Reliability Monitor taps into the Windows Event Manager to elicit data about your system, with a focus on events 

that impact reliability, as well as performance counters and configuration data. Reliability monitor tracks five 

different categories of information, namely:  

 Application failures: Tracks application failures or errors (e.g., “MS Outlook … stopped working”) 

 Windows failures: Tracks OS failures or errors (e.g., “Windows hardware error”) 

 Miscellaneous failures: Tracks other failures or errors, typically peripherals (e.g., “Disk failure”) 
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 Warnings: Tracks failures or errors that don’t necessary impact system behavior (e.g., “Unsuccessful driver 

installation”) 

 Information: Tracks system changes and updates (e.g., “Successful Windows Update” and “Successful 

driver installation”) 

Although Reliability Monitor visually tracks errors in the five categories mentioned above, it provides details in 

only three categories in text form at the bottom of its console window, where details or solution lookup is available 

on an item-by-item basis. Those three categories are:  

 Critical events: Lumps Application failures, Windows failures and Miscellaneous failures together in 

chronological order 

 Warnings: All warning messages (marked with a yellow exclamation warning flag) together in 

chronological order 

 Informational events: All information messages (marked with a lower-case “i” on a blue circle) also in 

chronological order 

Launching Reliability Monitor 

Simply type “reli” in the search box, and let Windows produce the “View reliability history” prompt that launches 

this console in response.  

Using Reliability Monitor for troubleshooting 

In general, working with Reliability Monitor requires looking at the causes of errors, and deciding what might be 

done to address them. When fixes are possible, they will usually be fairly easy to figure out. Often, though, one 

must simply steer clear of programs or features that don’t work the way they should so as to avoid unnecessary 

errors. As is so often the case with Windows: “If you can’t fix it, avoid it,” is a watchword to live by.  

KEEP YOUR COMPUTER RUNNING FAST AND RELIABLY 
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Smart users perform PC cleanup and tune-up operations at least once a month. Here's what the experts 

recommend: one or more of these free computer maintenance tools will help you do the job. 

PrivaZer (hyperlink). According to nationally recognized tech expert Bob Rankin, this program is a hard drive 

clean-up utility on steroids. It gets rid of junk files and wipes away traces of activity that could compromise your 

privacy. 

The "clean and optimize your PC" field has been crowded for years with programs like CCleaner, Advanced 

System Care, and many others. PrivaZer leaves them all gasping in its dust. The first time you run PrivaZer, you 

will be impressed by the number of clean-up options it gives you. But you won’t be confused, because they are 

clearly and cogently explained. A recommended option doesn’t just have the word “recommended” next to it; it 

includes a brief explanation of why it’s recommended and what it will do that’s different from other options.  

The first scan and clean-up of your desktop or laptop will probably take several hours, not because PrivaZer is slow 

but because it does an enormous amount of work. Rankin has run Advanced System Care Pro on his machine at 

least once a week for a long time, but PrivaZer still found about a gigabyte of stuff it could fix.  

The Glary Utilities (hyperlink)  is another great PC software product to have on your computer. In addition to 

doing registry, privacy, and junk files cleanup, it’s best known for its UNINSTALLER APPLICATION that allows you to 

tag multiple applications to be uninstalled in one operation. 

USING THE DISK CLEANUP WIZARD 

Although it’s hidden from view, Windows 10 comes with a handy utility called the Disk Cleanup Wizard. With the 

wizard, you can easily delete sets of files that typically collect on your system and consume valuable disk space. 

It's a good idea, therefore, to get into the habit of periodically running the wizard to help keep your disk clean. 

To find this feature, type disk cleanup while at the Search box/icon. Then click on free up disk space by deleting 

unnecessary files from the list that appears in the column above the search box. 

http://privazer.com/
http://privazer.com/
http://www.glarysoft.com/glary-utilities/download/
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On the dialog box that appears, select the drive you want to clean up 

 

When the wizard starts, the first thing it does is to calculate how much space can be reclaimed by executing the 

clean up. This may take a few minutes, and you'll see a progress window like the following as it is doing its 

calculations 

 

When the calculations are finished, the full Disk Cleanup dialog box appears. (See below.) You can now scroll 

down through the various categories, check those files you want to be deleted, and clear the files that you don't 

want to be deleted. As you check and uncheck the boxes, a running total of how much disk space you'll gain is 

presented in the middle of the screen. 
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When you're satisfied with your selections, click OK to have the wizard delete the files you indicated should be 

deleted. Another progress window will display, and when it's finished, the wizard exits. 
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IMPROVE PERFORMANCE BY OPTIMIZING YOUR DRIVE 

One of the best ways you can improve your PC's performance is by optimizing the drive. Windows includes 

features to help optimize the different types of drives that PCs use today. No matter which type of drive your PC 

uses, Windows automatically chooses the optimization that's right for your drive. 

Be default, Optimize Drives, previously called Disk Defragmenter, runs automatically on a weekly schedule. But 

you can also optimize drives on your PC manually. 

To optimize manually: 

1. Type Optimize at the Search box, then click Defragment and optimize your drives from the list that 

appears below.  

2. Under Status, tap or click the drive you want to optimize. (The Media type column tells you what type of 

drive you're optimizing.) 

3. To determine if the drive needs to be optimized, click Analyze.  You might be asked for an admin password 

or to confirm your choice.  

After Windows is finished analyzing the drive, check the Current status column to see whether you need to 

optimize the drive. If the drive is more than 10% fragmented, you should optimize the drive now. 

4. Click Optimize. You might be asked for an admin password or to confirm your choice.  

Optimizing a drive might take anywhere from several minutes to a few hours to finish, depending on the size 

of the drive and degree of optimization needed. You can still use your PC during the optimization process. 

To change the optimize schedule: 

1. Type Optimize while at the Search box/icon, then click Defragment and optimize your drives from the 

list that appears below.  
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2. Click Change settings.  You might be asked for an admin password or to confirm your choice.  

3. Do one of the following: 

 To turn off scheduled optimization, clear the Run on a schedule check box. 

 To change the frequency of scheduled optimization, next to Frequency, click the drop-down list, and 

then click Daily, Weekly, or Monthly. The default schedule for optimization is weekly and runs during 

Automatic Maintenance. 

 To choose the drives you want to include or exclude in scheduled optimization, next to Drives, click 

Choose, select or clear the check boxes next to the drives, and then click OK. You can also clear the 

Automatically optimize new drives check box if you don't want new drives added to scheduled 

optimization. If Windows can't optimize a drive, it won't offer the drive as an option for Automatic 

Maintenance. 

4. Tap or click OK. 

To repair a drive 

1. Open File Explorer (Windows + E). 

2. Right-click the drive you want to repair, and then click Properties. 

3. Click the Tools tab, and then, under Error checking, click Check.  You might be asked for an admin 

password or to confirm your choice.  

4. Follow the instructions. You might need to restart your PC after error checking is complete. 
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CHAPTER THIRTEEN 
WINDOWS UPDATES 

WINDOWS UPDATE IS GONE FROM CONTROL PANEL 

Windows 8.1 offered two avenues for accessing Windows Update — one in PC Settings (Windows + I) and one in 

the older Control Panel. Windows 10 retains most of the old Control Panel, but the Windows Update interface has 

been removed. 

Instead, you’ll find Windows Update in the new Settings app (Windows + I) under Update & security. This is the 

only interface for Windows Update in Windows 10.  

A quick way to access Windows Update: Type windows update in the search box/icon that is located near the left 

corner of the Taskbar and then click on Check for updates that will appear at the top of the column. 

UPDATES INSTALL AUTOMATICALLY, AND YOU CAN’T PICK AND CHOOSE 

Another big change with Window 10 is that there will be automatic updates. So there’s less chance of you missing 

an important security update or bug fix. In addition, all Windows 10 systems will be on the same page at all times, 

whether it’s on a computer, a tablet, or a smart phone. 

Visit the Windows Update interface (type windows updates in the search box) and you’ll find a single button — 

Check for updates. Click this button and Windows will check for available updates. If it finds any, it will 

automatically download and install them. Windows will also check for updates in the background and 

automatically download and install them the moment that they are released by Microsoft. 

Unlike on previous versions of Windows, there’s no way to select individual updates you want to download. All 

updates — from security updates and Windows Defender definition updates to optional updates and driver updates 

— will be installed automatically. 



Page 140 of 271 

 

The only option you can control is to select the “Advanced options” link and uncheck Give me updates for other 

Microsoft products when I update Windows. This will allow you to disable updates for Microsoft Office and other 

Microsoft programs.  

This time around, Microsoft is committed to rolling out both security updates and feature updates. Most of the 

included applications will also automatically update themselves via the Windows Store. Microsoft is thinking of 

Windows 10 as the last version of Windows, so instead of a Windows 11 or Windows 10.1, we should see future 

updates and interface changes appear on an ongoing basis. Accordingly, “Patch Tuesdays” (the second Tuesday of 

each month) will be a thing of the past. 

Microsoft also plans on making more use of the “build” system going forward. While small security updates will 

arrive as individual updates, major upgrades to Windows 10 that include new features will likely arrive as “builds.” 

A Windows 10 PC can upgrade directly to a new build, which means that old cycle of downloading updates and 

rebooting four or five times to ensure you have all the old updates on an out-of-date PC won’t be necessary. 

BUT YOU CAN CHOOSE WHEN TO REBOOT 

Click the “Advanced options” link in the Windows Update interface and you’ll find two Choose how updates are 

installed options. You can pick Automatic, which is the default — Windows will automatically download updates, 

install them, and schedule a reboot for a time when you aren’t using your PC. 

You can also choose Notify to schedule restart, which will prevent your PC from automatically rebooting without 

your confirmation. But, either way, those updates will automatically be downloaded and installed. 

MAKE SURE WINDOWS UPDATE IS TURNED ON  

If you sense that Windows Update is turned off, here are the steps you can take to enable it:  

1. Open Settings (Windows + I). 

2. Click Update & Security. Your Windows update and Windows security settings are loaded.  

http://www.howtogeek.com/221903/how-to-schedule-restarts-for-updates-in-windows-10/
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3. Click Windows Update to access this tool and its settings.  

4. Click Advanced options.  

5. In the Choose How Updates Are Installed drop-down list, select Automatic Install Windows Updates 

YOU CAN MANUALLY CHECK FOR UPDATES AND INSTALL THEM AT ANY TIME 

Once Windows Update is turned on, Windows 10 automatically checks for updates and installs them. However, 

you can manually check for updates and install them anytime you want. Here’s how:  

1. Open Settings. 

2. Click Update & Security, then click Windows Update. Windows Update is now shown on the screen.  

3. Click Check for Updates. If updates are available, they’re automatically downloaded and installed. For some 

updates, a restart may be required, and if so, Windows 10 automatically schedules it for you. 

4. Decide whether to restart now or later: • To restart now, close all open files and programs and click Restart 

Now. • To restart your computer at a different time, specify the time in the scheduling fields. 

PEER-TO-PEER DOWNLOADS FOR UPDATES ARE ENABLED, EVEN OVER THE INTERNET 

To speed up updating, Windows now uses peer-to-peer downloads for updates. For example, if you have more than 

one Windows 10 at home, you don’t necessarily have to download the same update several times. Instead, the first 

PC to update would download it and the other PCs could download it from the first PC. 

You can control whether peer-to-peer downloads are enabled from the Choose how updates are delivered link 

under Advanced options. 

By default, Windows 10 enables peer-to-peer downloads over the Internet as well, and your PC will use some of 

your upload bandwidth to send those Windows updates to other PCs. You can disable this by selecting only “PCs 

on my local network.”  See snipped page below. 
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If you run Disk Cleanup (type disk cleanup at the search bar) and clean up the Windows Update files lying around 

on your PC to free up space, your PC won’t be able to provide peer-to-peer downloads because the files won’t be 

available. 

CONFIGURE WINDOWS UPDATES 

You can now quickly download apps and updates from multiple sources. For example, you can download them 

from PCs on your local network as well as from PCs on the Internet. Here’s how to configure this behavior:  

1. Open Settings. 

2. Click Update & Security.  

3. In the list of settings that appears, click Windows Update. Windows Update is now shown on the screen.  

4. Click Advanced Options.  

5. In the list with advanced options, click Choose How Updates Are Delivered.  

6. Set the Download Windows Updates and Apps from Other PCs in Addition to Microsoft switch to On. 

7. Choose from the following sources for downloading apps and updates: • PCs on My Local Network • PCs on 

My Local Network, and PCs on the Internet.  

8. Close Settings. 
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YOU CAN VIEW YOUR UPDATE HISTORY  

To view your update history, type windows update settings at the search box, select “Advanced options,” and select 

“View your update history.” You’ll see a list of updates, and you can select “Uninstall updates” to view a list of 

updates you can uninstall. 

REMOVE UNWANTED WINDOWS UPDATES 

Generally, Windows updates are a good thing. They fix security problems and bugs, or they add new features and 

improvements to Windows. However, from time to time, Microsoft botches an update or a fix, causing all kinds of 

headaches for users. If you’ve installed an update that causes problems, you can uninstall it at any time. Here’s 

how:  

1. Open Settings.  

2. Click Update & Security.  

3. In the list of settings that appears, click Windows Update.  

4. Click Advanced Options.  

5. In the Advanced Options window, click View Your Update History. The View Your Update History window 

appears. 

6. Click Uninstall Updates. The Installed Updates window appears. 

7. Select the update that you want to remove.  

8. Click Uninstall.  

9. When asked to confirm that you want to uninstall the selected updated, click Yes. 

10. After the update is removed, close Installed Updates and Settings. Removing some Windows updates may 

require you to restart your computer. Before you restart the computer, don’t forget to close all your opened 

files and apps, so you don’t lose your work during the process. 
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IF YOU HAVE TO RESET YOUR COMPUTER, YOUR UPDATES WILL FOLLOW 

When you use the PC Reset feature to restore your PC, you won’t have to re-download every single Windows 

update that’s ever been released. Instead, the new PC Reset feature will give you a fresh, up-to-date Windows 

system.  

UPDATES TO MODERN APPS OCCUR AUTOMATICALLY 

Windows 10 is configured, by default, to automatically update apps in the background, so everything is always up 

to date. This applies only to Windows 8/10 apps (not legacy apps), of course, but it's a welcome improvement over 

all earlier editions of Windows. 

USE UAC (USER ACCOUNT CONTROL) 

The User Account Control (UAC) is a security feature that helps prevent unauthorized changes to your computer. 

These unauthorized changes can be initiated by users, apps, viruses, or other types of malware. UAC ensures that 

these changes are made only with the administrator’s approval. If these changes aren’t approved by the 

administrator, they will never be executed, and the system will remain unchanged. 

Desktop apps in Windows 10 don’t run with administrator permissions and consequently can’t make automatic 

changes to an operating system. When a desktop app wants to make system changes (such as modifications that 

affect other user accounts, modifications of system files and folders, or installation of new software), Windows 10 

issues what’s called a UAC confirmation dialog box, where users can confirm whether they want those changes to 

be made. If the user clicks No, the changes won’t be made. If the user clicks Yes, the app receives administrator 

permissions and makes the system changes it’s programmed to make. 

These permissions will be granted until the app stops running or the user closes it. When using Windows Store 

apps, UAC is never triggered because, by design, these apps can’t modify system settings or files. If you’re on a 

locked computer and your user account doesn’t have administrator permissions, the UAC prompt asks you to enter 
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the password for an administrator account. If you don’t type the correct administrator password, then you can’t run 

desktop apps that require administrator permissions. 

When you encounter UAC prompts, it’s important to pay attention to them. Look at the information displayed and 

determine which app wants administrator permissions. If it isn’t an app that you started and want to run, click No. 

CONFIGURE UAC 

To change how UAC prompts are shown. Follow these steps: 

1. Click in the search box on the taskbar.  

2. Type uac. A list of search results appears.  

3. Click “Change User Account Control settings”. The User Account Control Settings window appears.  

4. Set the UAC switch to the position you want. You can choose one of the following options: 

a. Always notify. The UAC prompt is shown when apps try to install software or make changes to your 

computer and when you try to change Windows settings. The Desktop is dimmed when a UAC 

prompt is shown.  

b. Notify me only when apps try to make changes to my computer. This is the default setting for UAC. 

UAC prompts aren’t shown when you try to make changes to Windows settings. The Desktop is 

dimmed when a UAC prompt is shown.  

c. Notify me only when apps try to make changes to my computer (do not dim my desktop). UAC 

prompts are not shown when you try to make changes to Windows settings, but the Desktop isn’t 

dimmed when a UAC prompt is shown. 

d. Never notify. This is the equivalent of turning off UAC. (not recommended) 

5. Click OK. The User Account Control prompt is shown. 6. Click Yes. Your settings are applied. 
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CHAPTER FOURTEEN 

THE CONTROL PANEL (WINDOWS + X) AND SETTINGS (WINDOWS + I) 

The Settings option (Windows + I) (also found in the Start menu) takes you straight to the new Settings app, which 

has evolved from the PC Settings app on Windows 8. This is designed to be a more user-friendly way to configure 

your computer. 

It still doesn’t contain every setting, however. The old Windows Control Panel is still a part of Windows 10. Some 

older settings may only be available in the Control Panel, while some newer settings may only be available in the 

Settings app. To quickly access the Control Panel and other advanced options, you can right-click the Start button 

or press Windows Key + X. This menu is a useful holdover from Windows 8. 

While the Control Panel is still alive and well, it seems the writing is on the wall for it. You will still be able to find 

almost all the old control panel icons to which you are accustomed, but some have been renamed, some eliminated, 

while others have migrated to Settings. 

More details about Settings (Windows + I) see snipped page below 
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If you can’t find a setting you’re looking for, enter it in the search box in the upper right corner. 

You'll find settings by going to Start  and selecting Settings. (The Windows key + I is a fast alternative!) Then 

browse the categories or use search to find any setting including advanced settings in Control Panel.  

ACCESS ANY OF THE FIFTY CONTROL PANEL ITEMS. 

Press Windows + X and then press P. (Note that Control Panel has the P underlined.) 

An alternative method is to right-click on the Windows icon on the left side of the Taskbar and then left-click on 

the control panel. 
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CHAPTER FIFTEEN 

NOTIFICATIONS AND ACTIONS 

In the past, we’ve been able to change which icons and notifications appear on the Taskbar using the appropriate 

control panel.  This however, has been completely removed in favor of the new notifications settings, which can be 

accessed by going to Settings (Windows +I), then System, then Notifications and Actions. From there, click on 

either or both of the links: Select which icons appear on the taskbar or Turn system icons on or off. 

It’s not remarkably different from the old control panel version. You can show all the icons at once, or go through 

and turn them “Off” or “On” one-by-one. 
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NOTIFICATIONS WILL ADVISE YOU OF IMPORTANT ISSUES AT A GLANCE  

When a notification appears on your desktop or when you view it in Action Center, expand it to take action without 

having to open the related app. If you don't want to take any action, just clear the notification by pressing the X 

button that appears to the right of the notification. 

ACTION CENTER (WINDOWS + A)  

The Action Center is represented by an icon that is located on the Taskbar and rests to the immediate left of the 

time/date/calendar icon.  The icon will show as white letters on a dark background when there are no notifications. 

It will show dark letters on a white background when there are new notifications. 

The Action Center , located immediately to the left of time and date on the Taskbar, is a brand new feature of 

Windows 10.  The Action Center is where you will receive notifications concerning various programs.  Click the 

icon to open (or press Windows + A). The icon lights up white when you have a new notification waiting. The 

icon is by default black, and active tiles on it take their color from your system color choices.  

The Action Center puts important notifications—from your applications and from Windows—right on the taskbar, 

along with new quick actions, which get you to your most-used settings and applications instantly. 

Select the action center icon  to see your notifications and quick actions. 

QUICK ACTIONS  

Quick actions take you right to the settings and applications you're likely to use often. Open Action Center to see 

your top picks (tiles). 



Page 152 of 271 

 

 

 

MORE DETAILS ON USING THE ACTION CENTER 

To display the Action Center, click on the new icon or use Windows + A: 
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The icon shows black lines on a white background when you have a new notification waiting. The Panel is by 

default black, and active tiles on it take their color from your system color choices (Settings > Personalization > 

Colors). 

In the Notifications and Action section of Settings > System, you can choose which apps are allowed to pop in 

notifications. (see screen snip on next page) 

E  

If you want a break from being pestered by notifications, the Quiet Hours tile (the one showing a crescent moon in 

the first snip above) is available. You can also silence the Action Center by right-clicking on its taskbar icon and 

choosing "Turn on quiet hours." 
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Quick Actions 

As you can see from the first screen capture above, in addition to notifications, the Action Center gives access to 

frequently used settings called Quick Actions (the tiles at the bottom of the column). You can easily collapse the 

settings tiles down to one row of four tiles using the Collapse caret. To change which four Quick Actions appear 

when you do this, you can head to Settings/System/Notifications & actions. 

 

ADJUSTING THE ITEMS THAT APPEAR IN THE NOTIFICATION AREA 

The Notification Area (formerly known as the Systray or System tray) sits on the far right side of your taskbar. 

This is where you look to verify your Internet connection, to check your anti-virus program, to check the time and 

date, to control your speaker volume, and check out the Action Center (the white or black box) for any current 

issues, to name just a few. 

You can control what appears in the Notification Area, by following these steps: 

1. Click the right mouse button on the Windows task-bar 

2. Click Properties 

3. In the Notification area, click Customize. 
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4. This action will bring up a Notification and Action area box that looks something like the one below. 

 

5. Select which icons appear on the taskbar and Turn system icons on and off buttons will make it easy to 

control what’s in the notification area. 
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CHAPTER SIXTEEN 
SOME NEW FEATURES 

BOOT TO THE START MENU (TABLET MODE) 

When Windows 8 used to boot to the Start Screen, people wanted to boot directly to the Desktop. Now when 

Windows 10 boots to desktop, there are some who want to boot to the Start Menu. If you are in Tablet Mode when 

you turn off your computer, your computer will boot to the Start Menu at the next startup. 

To enable a Start Menu boot, you will need to enable Tablet Mode. To enable Tablet Mode, click on the 

Notifications icon on the far right side of the Taskbar (or use Windows + A). You will see the Notifications panel 

open.  Click on Tablet mode. The Start Menu will be enabled. To see the Start Menu, click on the Windows key or 

your Start Button.  

To turn off the Tablet mode, select Windows + A, then click on the Tablet Mode tile. (The tile acts as a toggle 

switch and has a light background when turned on. In addition, the background of the Taskbar changes to black.) 

TASK VIEW AND THE SEARCH BOX 

The very first time you start Windows 10 you will notice two additions to the Taskbar. The first is a search box 

which you can shrink to a button and the other is an odd-looking new icon (the Task View) . Click the Task 

View icon on your Taskbar (or use the shortcut alternative, Windows key + Tab). Also, if the Task View has 

disappeared, get it back by right-clicking on a blank area of the Taskbar, then clicking on Show Task View button. 

You’ll get a quick view of all your open tasks. You can switch tasks by clicking on them in the window. When 

you’re in Task View, you’ll notice a + icon with New desktop underneath it in the lower-right corner of the page.  

This is where you can take advantage of one of another new feature of Windows 10 – adding virtual desktops.  
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To shrink the search box to a small button, right-click on the search box, click on Search, and then click on Show 

Search icon. 

To expand the search box, right-click on the search button, left-click on Search, and then click on Show search box. 

MAKE YOUR COMPUTER BOOT FASTER 

Windows 10 offers a startup application manager that’s integrated into the operating system and simple to 

understand — it even shows which programs are slowing down your computer’s startup the most. 

Windows computers tend to boot slower over time as you install more applications, many of which add themselves 

to startup and contribute automatically to the slow-down process. The Task Manager will help you trim down 

many of them that do not have to run at startup. 

There are several ways to access the Task Manager. One way is to right-click the taskbar and select Task Manager. 

You can also press Ctrl + Shift + Escape to open the Task Manager directly, or press Ctrl + Alt + Delete and click 

Task Manager. An approach that was introduced in Windows 8.1 is to access the Task Manager by holding down 

the Windows key and X key at the same time, then press T.) 

The Task Manager normally just shows a list of open programs, so you’ll need to click “More details” after 

opening it. Then click the Startup tab after accessing the Task Manager’s full view. 

Disable Startup Programs 

You’ll see the name of a program along with its application icon at the left, and the program’s publisher name to 

the right. 

You’ll also see the “Startup impact” of each startup program — either Low, Medium, or High. If you see “Not 

measured,” that’s because it was recently added and Windows hasn’t had a chance to observe the program’s 

behavior yet. Reboot your computer and you’ll see an impact statement appear. 
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To disable a program, click it and click the Disable button — or right-click it and click Disable. 

The real challenge here is deciding what to disable. Some programs are obvious — for example, if you have 

Dropbox or Google Drive installed, they normally start when your computer starts up so they can sync files. You 

could disable them, but then they wouldn’t automatically sync files in the background. You could disable a chat 

program like Skype here, but then you wouldn’t be automatically logged in when you boot your computer. 

Other programs will be less obvious, especially system utilities and driver-related software that came with your 

computer. Much of this manufacturer-installed bloatware is unnecessary, but you may want to do a bit of quick 

research so you understand what you’re disabling. 

For additional help, you can right-click a program and select “Search online.” Windows will open a web search 

page with the name of the program and its .exe file, allowing you to determine exactly what the program is and 

what it’s doing if you’re not sure. The “Open file location” option will show you exactly which .exe file on your 

computer is starting at boot. 

FIND RESOURCE-HUNGRY PROGRAMS THAT SLOW DOWN YOUR COMPUTER 

Your PC is running slow because something is using up your CPU resources. If it’s suddenly running slower, a 

runaway process might be using 99% of your CPU resources, for example. Or, an application might be 

experiencing a memory leak and using a large amount of memory, causing your PC to swap to disk. Alternately, an 

application might be using the disk a lot, causing other applications to slow down when they need to load data from 

or save it to the disk. 

To find out, open the Task Manager. You can right-click your taskbar and select the Task Manager option or 

press Ctrl+Shift+Escape to open it.  This tool provides an upgraded interface that color-codes applications that are 

using a lot of resources. Click the “CPU,” “Memory,” and “Disk” headers to sort the list by the applications using 

the most resources. If any application is using too much resources, you might want to close it normally — if you 

can’t, select it here and click “End Task” to force it to close. 
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CHAPTER SEVENTEEN 
EDGE, THE NEW BROWSER 

To launch Microsoft Edge (Windows + F1), select the Microsoft Edge button (it’s the solid blue E) on the 

Windows Taskbar. 

EDGE REPLACES INTERNET EXPLORER 

Internet Explorer is no longer the default browser. In its place is a modern browser named Edge. Microsoft’s Edge 

browser should be more standards-compliant and perform better. It also no longer supports ActiveX controls, so all 

those old Internet Explorer toolbars and browser plug-ins will no longer function. If you’ve been using Internet 

Explorer, this is the browser you’ll probably be using instead. If you have used Internet Explorer before upgrading 

to Windows 10 and were satisfied with it, you don’t have to use Edge. It’s easy to place Internet Explorer on your 

Taskbar and use it as your default browser. If you were using Chrome or Firefox before the upgrade, you will want 

to continue browsing normally with one or the other.  

If you want to use your familiar Internet Explorer browser, click on Start >All apps > Windows Accessories > 

right-click on Internet Explorer > Pin to Taskbar. 

EDGE IS NOT A FINISHED PRODUCT 

Expect more from Edge in the future as Microsoft continues adding features to their new browser. In particular, 

browser extensions will be arriving at some point, making Edge more competitive with Chrome and Firefox. 

WORK WITH MULTIPLE TABS IN WINDOWS EDGE 

Tabbed browsing is an Edge feature that allows you to open multiple websites in a single browser window. You 

can open web pages in new tabs and switch between the pages by clicking their tabs and the top of the page.  

Here’s how to do so: 
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1. Open Windows Edge. 

2. Click on the + at the top of the opening page. 

3. Type the web address of your first selection and press Enter. 

4. Once your first selection opens, click on the + tab at the top of the page. You will be asked “Where to 

Next?” 

5. Type the web address of your second selection and press Enter. 

6. To add tabs for additional websites, simply follow steps #4 and #5. 

7. You can now bounce back and forth from one website to another by clicking on the representative tab. 

8. To close one of the websites, click on the X for the tab that the website represents. 

9. When you are done, close the browser. 

SEARCH FASTER IN THE ADDRESS BAR 

Enter your search in the address bar that appears either at the top of the page or the middle of the page, depending 

on how you have your home page organized. You’ll get search suggestions, results from the web, your browsing 

history, and favorites right on the spot. 

HUB  IS A COLLECTION OF ALL YOUR WEB THINGS 

Think of the Hub as the place where Microsoft Edge keeps the things you collect on the web. Select Hub  (a 

set of three horizontal lines near the upper right corner of the window) to view your favorites, reading list, 

browsing history, and current downloads.  

SAVE ARTICLES TO READ LATER  

Reading list gives you a place to save web articles you want to read later. Just select  from the Menu bar, then 

Reading list, and then Add. Later, when you’re ready to read, go to the Hub , and select Reading list . This 

new feature will let you separate your web reading list from your web favorites. 

A CLEAN AND SIMPLE READ IN THE FONT SIZE YOU PREFER 
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For a clean and simple layout, select in the address bar to turn on reading view. This will bring whatever you're 

reading front-and-center. You can even change the reading view style and font size to suit your mood—select (… 

identified by three dots in upper right corner of the window) followed by Settings. From there, scroll down to 

Reading section. 

SHARING WEB PAGES 

The Edge browser has an integrated sharing feature with a Share button (indicated by three small circles on the 

outer edge of a larger circle) on its toolbar. Tapping the Share button will open the system Share panel. You can 

extend the list here and share to more services by installing the appropriate apps from the Windows Store. 

For example, if you want to share on Facebook, install the Facebook app. If you want to share on Twitter, install 

the Twitter app. This provides you with an easy way of sharing web pages without any browser extensions. 

You can also tap the title of the page in the Share panel and choose to share a screenshot of the current web page 

rather than a link to it. 

More Tips: 

BROWSE THE WEB USING INPRIVATE BROWSING 

InPrivate Browsing in Windows Edge enables you to surf the web without leaving a trail in your browser. This 

helps prevent others using your computer from seeing what sites you visited and what you looked at on the web. 

When you start InPrivate Browsing, Windows Edge opens a new browser window. The protection that is provided 

is in effect only during the time that you use that window. You can open as many tabs as you want in that window, 

and they’re all protected. However, if you open another browser window, that window isn’t protected by InPrivate 

Browsing. While you’re surfing the web using InPrivate Browsing, Windows Edge stores some information like 

cookies and temporary Internet files so that the web pages you visit work correctly.  

However, at the end of your InPrivate Browsing session, this information is discarded. 



Page 163 of 271 

 

Here’s how to start InPrivate Browsing in Edge: 

1. Open Windows Edge. The window that opens is not protected by InPrivate Browsing.  

2. Click the More button (the three horizontal dots in the upper right corner). 

3. Click on New InPrivate window. 

4. On the next screen, type the name of the website you wish to browse in private. 

5. When you arrive at that website, note that the word “inprivate” will appear in the upper left corner of the 

screen. Navigate the web as usual in this window. 

PIN TO START: Edge allows you to open the menu (designated by … three dots in the upper right corner) and 

select Pin to Start to pin the current web page to the Start menu as a tile, allowing you to open it quickly. Clicking 

the tile will open the web page in Edge, not its own browser window. 

OPEN WITH INTERNET EXPLORER: If you do need to open a web page with Internet Explorer, you can just 

click the menu button (three dots in the upper right corner) and select Open with Internet Explorer. As mentioned 

earlier, Internet Explorer is also buried in the All Apps menu under the “Windows Accessories” folder. For 

example, you may need to do this if you need to use a legacy web app that requires a browser plug-in like Java or 

Silverlight. 

DARK THEME: Like many other modern Windows 10 apps, Edge includes a dark theme as well as its default 

light theme. To activate it, open the menu (three dots in the upper right corner), click on Settings, and then select 

“Dark” under “Choose a theme.” 

DISABLE FLASH: Microsoft Edge includes an integrated Flash Player, just as Google Chrome does. This is the 

only browser plug-in that works in Microsoft Edge. If you’d like to disable it for security reasons, you can do so by 

opening the settings menu (three dots in the upper right corner), clicking View advanced settings, and setting “Use 

Adobe Flash Player” to “Off.” 
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You’ll find a variety of other ways to customize Edge’s interface in its Settings menu, too. For example, you can 

enable a Home button to quickly take you back to your preferred home page. You can activate the “Show the 

favorites bar” setting to get an always-present toolbar for easier access to your favorite web pages. 

You can also configure which web pages Edge opens when you launch it, and what exactly appears when you open 

a New tab page. For example, you can make the New tab page largely blank without the “suggested content.” 

CHANGE YOUR DEFAULT SEARCH ENGINE 

To change your search provider, open Microsoft Edge and click the menu button (that’s the button with three 

horizontal dots at the top-right corner of the Edge window). Select “Settings” in the menu. It is located at the 

bottom of the list. 

Scroll down in the Settings panel and click the “View advanced settings” button near the bottom. 

Scroll down again in the Advanced settings list and you’ll see the “Search in the address bar with” box. Click it and 

select “Add new.” 

You’ll see a list of available search providers. Select the search engine you want to use and click “Add as default.”  

If the search engine you want to use doesn’t appear here, be sure you’ve visited the search engine’s homepage first. 

If you have and it still doesn’t appear, that search engine doesn’t support OpenSearch yet. You may want to contact 

the search engine and ask it to support OpenSearch so you can use it as your default search engine in Microsoft 

Edge. 

CHANGE THE HOMEPAGE  

The homepage in Windows Edge is the page that loads automatically each time you start this browser. You can 

easily change the homepage and make it anything you want. It can be any web page on the Internet. It can be the 

default page provided by Edge when you install Windows 10, the current page that’s loaded in the active tab, or a 

new, empty tab.  
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To change the Edge homepage, follow these steps: 

1. Open Edge. 

2. Click on the three horizontal dots that appear near the upper right corner. 

3. Move down to Settings. 

4. Click on Open with a specific page or pages. 

5. Select Custom from the list that appears immediately below. 

6. In the Enter a Web Address box, type the address of your target homepage. 

7. Finally, click the + sign to the right of the homepage you just selected. 

8. When you close and then reopen the Edge browser, you will be taken to your preferred homepage. 

CHANGE YOUR DEFAULT WEB BROWSER 

It is not surprising that Edge is the default browser in Windows 10. However, you may wish to use Internet 

Explorer 11, Google Chrome, or Mozilla Firefox. Here’s how to accomplish the change in five steps. 

1. Click Start and type in default browser. 

2. Click the link that says Choose a default web browser when it appears in the list of your Start menu. 

3. The Settings window will appear; click the Default apps heading on the left (it should already be 

highlighted). 

4. On the right of the screen, look for the heading Web browser and click the icon. 

5. A new window will appear with the title Choose an app. Select Internet Explorer 11 or whichever browser 

you wish to use as your default. 

CHANGE THE DOWNLOAD LOCATION OF A LINK IN THE EDGE BROWSER 
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By far the easiest way to change the download location is to right click a link to a file you intend to download, then 

choose "Save Target As". You will then be prompted with a "Save as" window, which will allow you to navigate to 

any folder on your system to save the file.  

 

TURN ON AUTOCOMPLETE IN EDGE 

 

From within your Edge browser, AutoComplete makes suggestions in a pull-down menu as you type information 

into your search bar.  

If this feature has been disabled in your Edge browser, you will certainly want to turn it back on. Follow these 

steps to do so: 

Open Microsoft Edge. 

Click on the Menu icon (three horizontal dots near the upper right corner). 

Click on Settings. 

Click on View Advanced Settings. 

Turn on the toggle switch to Show search and site suggestions as I type. 

 

ADD FREQUENTLY USED WEB PAGES TO YOUR FAVORITES 

When you find a Web page that you would like to add to your Favorites for quick access later on, follow these 

steps. 

Add a Web Page to Your Favorites List 

1. Open the Edge browser. 

2. Display the page that you would like to store as a Favorite. 
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3. Click on the STAR on the menu bar. 

4. Assign a name to the favorite. 

5. Click on either Favorites or Favorites Bar. 

6. Favorites that you pin to the Favorites Bar will appear on a bar near the top of the browser. 

7. Click on the Hub tab (three horizontal lines) on the browser’s menu bar to view all the webpages in the 

Favorites list. 

 

WHEN WEBSITES CONSTANTLY OPEN VERY SLOWLY IN YOUR BROWSER 
 

Pinpointing the exact reason for sluggish performances from your browser is difficult. However, resetting Edge to 

its original settings can help clear corruptions that can impact performance. 

Resetting Microsoft Edge is not like resetting other browsers, however. Edge is a part of the Windows operating 

system, and cannot be uninstalled. There are different ways to tackle this problem, but you should try the basic 

methods first. 

Open the “Settings” menu by clicking the three horizontal dots in the upper right corner of the Edge window and 

choose “Settings.” 

Under Clear browsing data, click “Choose what to clear” and then click “Show more.” There are a lot of data types 

here. Select them all and click “Clear.” Restart your PC and re-open Edge for a clean slate. 

 

WHAT’S A BROWSER CACHE? HOW DO YOU CLEAR IT? WHY WOULD YOU WANT TO? 

Even when following instructions to empty the cache, many people aren’t clear on what this piece of magic really 

is, or why clearing the cache does anything at all. 



Page 168 of 271 

 

THE BROWSER CACHE 

The cache exists because of a basic assumption made by browser designers: the Internet is slow. More accurately, 

your internet connection is slower than your computer. 

What that means is that it’s faster to get something from your hard disk than it is to get it from the Internet.  

Browser designers noticed that most web sites had many of the same elements on multiple pages. For example, if 

you look at a Web page, you may see a  logo at the top. It may be at the top of every page on the site. So the 

thinking was, why download the same logo for every page? Why not just download it once and then keep it so we 

can use it again? 

That’s what the browser cache is for. The cache is nothing more than a place on your hard disk where the browser 

keeps things that it downloaded once in case they’re needed again. 

When you first visit a page on a Website, the browser downloads the logo into the cache, and then displays it on 

the page you’re viewing. For each additional page you visit on that Website, the logo doesn’t need to be 

downloaded again; as long as the same logo is displayed, it’s already on your hard disk. 

The cache has a size limit, which you can usually configure. When the cache gets full, the items in it that haven’t 

been used in a while are discarded to make more space. 

And it’s all happening silently and transparently to you. Until something breaks, of course. 

CLEARING THE CACHE 

Clearing the cache just means emptying it, so that the next time you display a web page everything must be 

downloaded anew. 
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The cache sometimes gets confused. This seems to happen to all browsers and at random and inexplicable times. 

What you’ll see are partially loaded or badly formatted web pages, incomplete pictures, or, in some cases, the 

wrong picture in the wrong place. 

It’s not always a caching problem, but because it happens often enough, “clear your browser cache” is often one of 

the first diagnostic steps you’ll hear from techs. 

Here’s how to empty the cache. 

CLEARING EDGE’S CACHE 

Select the ... icon in the top right corner of the browser window to get to the settings menu. 

In the settings menu, towards the bottom, click on Choose what to clear. 

Select Cookies and saved website data and Cached data and files. After the two are marked click on clear. 

CLEARING INTERNET EXPLORER’S CACHE 

Click the Tools menu (or click the gear icon in the upper right of the Internet Explorer window), and then the 

Internet Options menu item. In the resulting dialog box, under Browsing History, click the Delete… button. 

In the resulting Delete Browsing History dialog, it’s the Temporary Internet files and website files item that 

specifically refers to the browser cache, so check it. You can select or deselect other items as you see fit. 

Once you’ve done so, click the Delete button. Your browser cache is now empty. 

CLEARING FIREFOX’S CACHE 

Click on the “hamburger menu” in the upper right, and then click on History. 
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In the resulting pop-up, click on the Clear Recent History… item. 

In the resulting dialog box, change the “Time range to clear” to be Everything, and then make sure that only 

“Cache” is checked. 

If you like, you can check other items to be cleared at the same time, but this focus is on the cache.  

Click Clear Now. Your browser cache is now empty. 

CLEARING CHROME’S CACHE 

Click the hamburger menu icon at the top right of Chrome, and then click Settings. 

On the resulting page, click on Show advanced settings… at the bottom of the page, and then, under Privacy, 

click on Clear browsing data. 

In the resulting dialog, ensure that Cached images and files is selected (others are optional, but the focus here is 

on only the cache). 

Also make sure that the “Obliterate the following items from:” drop-down menu is set to the beginning of time to 

clear the entire cache. 

Click Clear browsing data. 

Your browser cache is now empty. 

AN EMPTY BROWSER CACHE 
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Your browser cache is empty. An empty cache means there’s no confusion. As you visit webpages hereafter, the 

browser will download fresh copies of everything you see on each page. You have simply forced your browser to 

rebuild its cache from scratch as it loads or re-loads web pages. Any cache-related issues should be cleared up. 

VIEW AND DELETE BROWSER HISTORY IN MICROSOFT EDGE 

Your browsing history—including info you've entered into forms, passwords, and sites you've visited—is the 

information that Microsoft Edge remembers and stores on your computer as you browse the web. To delete your 

browser history: 

1. Open Windows Edge. 

2. Click the three horizontal lines (Hub) near the upper right corner. 

3. Click on History. 

4. Select Clear all history. 

5. Choose the types of data or files you want to remove, then click Clear. 

WHY YOU SHOULD CONSIDER MORE THAN ONE BROWSER 

An Internet browser is your window to the web, where you can find almost anything from the comfort of your own 

computer. Today, the Internet is widely used for media, research, communication, shopping and entertainment. The 

better your browser, the more you will see and experience. 

Why should you use more than one browser? The main reason is that you will have a backup resource. If one 

browser fails and breaks down, you will always have another one to back you up. Another big advantage is that 

when you're trying to access a Web page and it's giving you trouble, you can always test it on another browser. 

That way, you will be able to see if it's the actual browser, the Web site or if it's some problem with your 

connection or firewall. 

If you are interested in an evaluation of the “10 best” browsers, go to 

http://tinyurl.com/389gct. 

http://tinyurl.com/389gct
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TURN ON AUTOCOMPLETE IN INTERNET EXPLORER/EDGE 

From within your Edge browser, AutoComplete makes suggestions in a pull-down menu as you type information 

into your locator bar. You can choose to have Edge search browsing history, favorites or feeds. 

If this feature has been disabled in your IE, you will certainly want to turn it back on. Follow these steps to do so: 

1. Click Tools in the upper right corner of your browser (it’s a cog wheel) or Tools from the Menu bar. 

2. Click on Internet Options. 

3. Click on the Content tab. 

4. From within the AutoComplete area, click Settings. 

5. Select Address bar and any of the four subsets. 

6. Click OK. 

From within the Edge browser, click on the three horizontal dots that appear in the upper right corner of the menu 

bar. 

1. Click on Settings. 

2. Click on View advanced settings. 

3. Turn on Show search and settings suggestions as I type 

WORK WITH MULTIPLE TABS IN WINDOWS EDGE 

Tabbed browsing is an Edge feature that allows you to open multiple websites in a single browser window. You 

can open web pages in new tabs and switch between the pages by clicking their tabs and the top of the page.  

Here’s how to do so: 

1. Open Windows Edge. 

2. Click on the + at the top of the opening page. 

3. Type the web address of your first selection and press Enter. 



Page 173 of 271 

 

4. Once your first selection opens, click on the + tab at the top of the page. You will be asked “Where to 

Next?” 

5. Type the web address of your second selection and press Enter. 

6. To add tabs for additional websites, simply follow steps #4 and #5. 

7. You can now bounce back and forth from one website to another by clicking on the representative tab. 

8. To close one of the websites, click on the X for the tab that the website represents. 

9. When you are done, close the browser. 

PIN A WEBSITE TO THE ALL APPS MENU 

Using Internet Explorer: 

10. Open Internet Explorer. 

11. Press CTRL + T to access a new tab. 

12. Access the target website. 

13. Click on the Cog Wheel in the upper right corner of the window. 

14. Click Add site to apps. 

15. Click Add. 

16. Click on Start button (lower left corner of Taskbar). 

17. Click All apps. 

18. The target website is now listed in alphabetical order on the All apps list. 

Using Microsoft Edge: 

11. Open Edge from the Taskbar. 

12. Click on the X tab at the top of the Edge window (or press CTRL + T). 

13. Access the target website. 

14. Click on the three horizontal dots in the upper right corner of the page. 

15. Click on Open with Internet Explorer. 
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16. Click Add site to apps. 

17. Click Add. 

18. Click on Start button (lower left corner of Taskbar). 

19. Click All apps. 

20. The target website is now listed in alphabetical order on the All apps list. 

Using Google Chrome: (this action will place the icon only on the Taskbar) 

9. Open Google Chrome. 

10. From within the search bar, access the target website. 

11. Click on the three horizontal bars in the upper right corner of the page. 

12. Click on More tools. 

13. Click on Add to Desktop. 

14. Click Add. 

15. Click Windows + D to return to the Desktop. 

16. Left drag the new target icon to the Taskbar. You can now delete the shortcut icon from the Desktop if you 

wish. 

 

MANAGE YOUR FAVORITES IN EDGE 

Download this program to manage your favorites the “old fashion way.” 

http://www.emmet-gray.com/Articles/EdgeManage.html 

The new Edge browser was released with Windows 10 in July 2015. However, it is considered by some to not be 

"feature complete". For example, it lacks an easy way to manage Web favorites.  

http://www.emmet-gray.com/Articles/EdgeManage.html
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The first version of Edge stored the favorites as files. So, you could use the File Explorer to add, delete, rename 

files to manage your favorites. Although Edge could import favorites from other browsers, it could not export 

them.  

After the "November Update" to Windows 10, the Edge browser no longer stores them as files, and instead uses an 

internal Extensible Storage Engine (ESE) database to store favorites. So, this means that you can no longer use the 

File Explorer to manage your favorites. The location of this database file is buried 15 folders deep: 

C:\Users\YourName\AppData\Local\Packages\Microsoft.MicrosoftEdge_8wekyb3d8bbwe\AC\MicrosoftEdge\Use

r\Default\DataStore\Data\nouser1\120712-0049\DBStore\spartan.edb  

The "native" way to access your favorites is, of course, to open Edge, expose the favorites "pane", and use Edge to 

rename, delete, or rearrange the folders and favorites. However, that means that you would not be able to: edit 

URLs, sort favorites, import/export bookmarks.html, export to Internet Explorer, backup/restore the database, 

create Internet shortcuts, and resurrect deleted items.  
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CHAPTER EIGHTEEN 

CORTANA, YOUR PERSONAL DIGITAL ASSISTANT 

Cortana is a voice-activated personal assistant that was first developed by Microsoft for its Windows Phone mobile 

operating system. Since its launch in April 2014, Cortana has been improved and fine-tuned, and Windows 10 

includes a more-advanced incarnation that can do a lot more than the original version.  

You can use Cortana on your Windows 10 devices, including computers, laptops, tablets, and smartphones. Once 

you set up Cortana on all devices, your data are automatically synced between them, and you can interact with 

Cortana on any of your Windows devices. Cortana is named after an artificial intelligence character in Microsoft’s 

Halo video game series.  

With Cortana, you can set reminders, check the weather, schedule appointments, set alarms, add notes, places, ask 

for directions, find songs, and so on. With each new update, she is capable of doing more and more.  

Cortana gets to know you and helps you get things done, letting you interact with her in a way that’s easy and 

natural. She can search the web, find things on your PC, show you the local news, and provide reminders based on 

time or location. Just tell Cortana what you want, and she’ll be there to help you out. Note: You must have a 

microphone attached to your computer. (Most newer laptops have built-in microphones.) 

CONFIRM THAT CORTANA IS TURNED ON 

1. Cortana is turned on by default, but here’s how to check: 

2. Click on the Search Box near the left side of the Taskbar. If Cortana is turned on, the Search box will read 

“Ask me anything.” 

3. If the Search box reads “Search the web and Windows, Cortana is turned off. 

HOW TO TURN ON CORTANA 
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1. Click on the Search Box. 

2. Click on the “hamburger patty” (3 horizontal lines) at the top of the left column.  

3. Click on the Settings icon. 

4. There is an ON/OFF toggle switch for Cortana can give you suggestions…. Turn it to the ON position. 

5. You will know that Cortana is now ON when the search box says, “Ask me anything.” 

6. Close the window by clicking away from the column. 

To use Cortana, just type a question in the search box on the taskbar, or select the microphone icon (that appears on 

the far right of the search box) and talk to her. (Typing works for all types of PCs, but you need a microphone to 

talk.) Speak naturally to Cortana about anything. Cortana can chat, get info, and do things for you. 

Examples: Say or type: How old was Lincoln when he died? 

Say or type: When was Hoover Dam completed? 

HIDE CORTANA FROM THE TASKBAR 

In Windows 10, the Start button isn’t just back — there’s a “Search the web and Windows” field that launches 

Microsoft’s Cortana assistant 

This feature is enabled by default. If you’d like to disable it, just right-click a blank area of the taskbar and click 

Cortana / Hidden. 

HOW TO TURN OFF CORTANA 

1. Click on the “Ask me anything” Search box. 

2. Click on the “hamburger patty” at the top of the left column. 

3. Click on the Notebook icon. 
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4. Click on Settings. 

5. At the ON/OFF toggle switch for Cortana can give you suggestions…., turn it to the OFF position. 

6. Close the window by clicking away from the column. 

If you turn Cortana off, you can still search. Enter what you're looking for in the search box on the taskbar. You'll 

get suggestions and answers to your questions about Windows—and the best search results available from your PC 

and the Internet.  

HOW TO DISABLE CORTANA WHILE IN THE ANNIVERSARY EDITION 

In early editions of Windows 10, it was easy to disable Cortana with just a couple clicks.  How, Microsoft is so 

committed to having its Win10 users use Cortana that it is impossible to disable Cortana in the Anniversary Edition 

(1709) without venturing into the Registry. 

Standard warning: Registry Editor is a powerful tool and misusing it can render your system unstable or even 

inoperable. This is a pretty straight-forward hack and as long as you stick to the steps, you shouldn’t have any 

problem. 

Follow these steps to open the Registry Editor: 

1. Press Windows+R on your keyboard. 

2. Type regedit in the search box and press Enter. 

3. Click yes at User Account Control. 

Navigate to the following key in the left column: 

Expand HKEY_LOCAL_MACHINE 

Go down the list to find and Expand SOFTWARE 
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Go down the list to find and Expand Policies 

Go down the list to find and Expand Microsoft 

Go down the list to find and Expand Windows 

Go down the list to find and Expand Windows Search. 

If you don’t see a “Windows Search” folder below the Windows folder, right-click the Windows folder and select 

New > Key. Name it “Windows Search”. 

Right-click the “Windows Search” folder in the left pane and select New > DWORD (32-bit) Value. 

Name the value AllowCortana. Double-click it and set the value to “0”. 

You can now close the registry editor. You’ll have to restart your computer before the change takes effect. 

To undo your change and restore Cortana in the future, you can just return here, locate the “AllowCortana” value, 

and delete it or set it to “1”. 

 

ENABLE HEY CORTANA (to wake her up with a voice command) 

When setting up Cortana, if you haven’t enabled Cortana to start automatically when you say “Hey Cortana”, you 

can enable this feature later. Here’s how:  

1. Click in the search bar located on the taskbar. Cortana appears. 

2. Click the hamburger button (three stacked lines, like a burger on a bun), at the top-left corner of Cortana. A 

menu appears with several options.  

3. Click Notebook, then Settings.  

4. Scroll down the list of settings until you find the Let Cortana Respond to “Hey Cortana” switch. 

5. Set the switch to On.  
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6. Click anywhere outside Cortana to save this change.  

7. Say “Hey Cortana” to confirm that this feature is turned on. If you want to disable Hey Cortana, follow the 

same steps and set the “Hey Cortana” switch to Off at Step 4. 

INTERACT WITH CORTANA 

Once Cortana is set up, you can interact with her at any time. To start using Cortana, do one of the following:  

• Click the microphone button found on the right side of the search bar.  

• Say “Hey Cortana” if you enabled this feature in the previous section. Once Cortana is up and running, you can 

talk to her and give her voice commands, or if you prefer, you can type your commands in the search bar. 

Example: Check the Weather Forecast 

One of the most popular ways to use Cortana is to check the weather forecast. To do so, you use the “What’s the 

Weather” voice command, followed by the day or time period you are interested in.  

• Ask “What’s the weather today?” to check today’s forecast.  

• Ask “What’s the weather tomorrow?” to check tomorrow’s weather forecast.  

• Ask “What’s the weather this weekend?” to check this weekend’s weather forecast.  

• Ask “What’s the weather on Friday?” to check this forecast for a specific day of the week. 

You can also add locations and days to your commands and check the weather in your destinations. For example, 

you can ask, “What’s the weather in Los Angeles tomorrow?” or “What’s the weather in Dayton, Ohio next 

Tuesday?” or “What’s the weather in Monterey, California on May 17?” 

CONFIGURE HOW CORTANA WORKS 
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You can change settings to maximize how Cortana works. For example, you can turn Cortana off entirely, change 

your name, change whether she calls you by name, delete her tracking information, enable or disable her ability to 

respond when you say “Hey Cortana.”  

To change how Cortana works, follow these steps:  

1. Click in the search bar on the taskbar.  

2. Click the burger button (three stacked lines, like a burger on a bun), at the top-left corner of Cortana. A 

menu with several options appears.  

3. Click Notebook. You’re shown a list of all the settings you can change. 

4. Change the settings you want.  

5. Now click the Question Mark to find additional options.  

6. Click anywhere outside the list of settings to save your changes. 

FIND NEW CORTANA COMMANDS 

With each update of Cortana, Microsoft also updates her Help documentation so that you can use it to find the most 

important commands. Here’s how to find most of the commands that you can use to interact with Cortana:  

1. Click in the search bar on the taskbar.  

2. Click the burger button (three stacked lines, like a burger on a bun), at the top-left corner of Cortana. A 

menu with several options is shown.  

3. Click Help. You’re shown a list of the tasks that you can perform with Cortana.  

4. Click the task that interests you to learn more about it. 

5. Navigate the examples shown by clicking them. 

THE NOTEBOOK 

How does Cortana know about you? One major way is through the Notebook. Cortana's Notebook is one 

aspect that differentiates her from Siri and Google Now. When members of the Microsoft staff were 
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developing Cortana, they interviewed actual human personal assistants, and found that most of them kept 

notebooks of key data on their employers. Cortana's Notebook is where you set up your int erests, calendar, 

and daily routine. Find the notebook by opening Cortana and then clicking on the three horizontal bars in 

the upper left corner. 

HOW TO USE AND CUSTOMIZE CORTANA  

Cortana was specifically designed to have a personality and will answer sassy questions with witty retorts 

and even tell you a joke if you ask her to. 

Cortana gives you control over what she knows about you. Cortana also becomes the default search on 

Windows 10 desktops.  

You don't have to use your voice to use Cortana: You can also simply type your question into her text box. 

Cortana is more than just a question answering or reminder creation tool: Cortana pops up your Daily 

Glance, a digest that includes things like sports results for teams you follow, news stories based on y our 

interests, and local weather. 

HAVE CORTANA CALL YOU BY NAME 

1. Click in the search bar on the taskbar.  

2. Click the burger button (three stacked lines, like a burger on a bun), at the top-left corner of Cortana. A 

menu with several options is shown.  

3. Click Notebook. 

4. Click About me.  
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CHAPTER NINETEEN 
THE WINDOWS STORE 

Microsoft has cracked down on what it considers low-quality apps coming from the Windows Store. It follows 

criticism that many apps in the Windows Store were of low quality. This reflects badly on Microsoft because it is 

effectively promoting the apps, while also taking a cut of any sale price. 

The decision affects applications that can be downloaded and installed directly from the Windows Store. It doesn't 

affect applications which users get elsewhere and install manually, in the same way with all software in Windows 7 

and earlier. Instead, Windows Store apps are displayed prominently in the Windows 8 and 10 user interface, and on 

Windows mobile devices. 

As of late 2015, the Windows Store’s inventory of apps had been culled to 669,000 titles. 

A couple nice features of downloading an app from the Microsoft Store: 1) If an app is updated from the producer, 

it will be automatically updated on your computer; 2) If an app becomes corrupted on your computer, you will be 

invited to return to the store for a working copy. 

HOW TO ACCESS THE STORE (Overview) 

Select Store from Start or the taskbar. (You’ll need an Internet connection and a Microsoft account to download an 

app for which there is a fee. Free apps can be downloaded from a local account.) Search for the application you 

want, or check out top applications, categories, and collections, and Microsoft’s latest featured applications and 

games.  

If you want to purchase applications from the Store, you will need to have a Microsoft account. This is no big 

deal. All you need is a username and password of your choosing. If you have a Hotmail or Outlook account, you 

already have a Microsoft account with a username and password. If you don’t have a Hotmail or Outlook account 

or you have forgotten the “username/password code” just establish a new account. In addition, you can establish a 
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Microsoft account by using your Cox or Gmail email address and password, for example. Many Computer Club 

members have found that a Gmail account is a convenient and easily remembered tool for gaining access to the 

Store. If you are just “window shopping” while in the Store, that is, not making a purchase, but rather walking out 

with a free app, you don’t need to have your Microsoft account handy. 

You can access the Microsoft Store by clicking the Store app located either in the Start Menu, the Desktop, or in 

the Apps section. Navigating the Store is similar to navigating the Start Menu. If you are looking for a particular 

application, simply type its name in the search for apps box in the upper right corner while in the Windows Store 

and all the possible selections will appear. 

As was mentioned earlier, when the Microsoft Store was first “opened”, not all of the thousands of applications 

were properly vetted. Therefore, you will probably want to use the “buyer beware” approach when you are 

considering an application download from the Store. 

When you’re ready to grab and app from the store, select Buy or Try if it’s a paid app, or Install if it’s free.  

After you buy it, you can install it on any PC you sign in to with your Microsoft account. 

App updates are free, and Windows will download them automatically whenever they’re available. (Change this 

setting at any time in the Windows Store.)  

OPEN THE WINDOWS STORE: 

1. Click the Windows logo (Start button) on the taskbar. The Start Menu appears. 

2. Click All Apps.  

3. Scroll down the list of apps until you find Store and then click it. The Windows Store is loaded.  

4. Click Apps to browse the apps that are in the Store.  

5. Scroll down the list of apps. 

6. To read an app’s description, click it. 

7. To get back to the list of apps, click the Back arrow on the top-left corner of the Store. 
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8. Continue browsing the Store by clicking on apps and categories to see what they offer.  

9. Close the Windows Store when you’re done. 

SEARCH FOR APPS IN THE WINDOWS STORE 

The fastest way to find an app in the Windows Store is to search for it. Here’s how it’s done:  

1. Open the Windows Store.  

2. Click in the search box at the upper-right corner of the Windows Store.  

3. Type the name of the app that you’re looking for. 

4. Click the Search button or press Enter.  

5. In the list of search results that appears, click the app that you’re interested in. 

6. When you finish using the Windows Store, close it. 

INSTALL APPS FROM THE WINDOWS STORE 

Installing an app from the Windows Store involves just a few steps: 

1. Open the Windows Store.  

2. Browse the Windows Store until you find the app that you’re looking for or search for that app, using the 

steps given earlier. 

3. Click the app that you want to install. 

4. Read the app’s description to confirm it’s the one you want. 

5. Click the Install button to install the app. A progress bar appears below the app’s name and description. 

6. When the app is installed, close the Windows Store. (At Step 5, if an app is a paid app, you don’t see an 

Install button. Instead, you see a button with the app’s price on it. Click it to purchase and install that app. 

Some apps offer a free trial so you can test them before purchasing. If you want to try an app before buying 

it, click Free Trial to install it. Note that some apps are actually free! 

MANUALLY UPDATE APPS FROM THE WINDOWS STORE 
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The Windows Store is set to handle app updates automatically. However, at times, you may want to force an app 

update rather than wait for the Windows Store to do so later. 

To manually trigger an update for all your installed apps, follow these steps:  

1. Open the Windows Store. At its upper-right corner, you see the search bar.  

2. Click the second icon at the left of the search bar (it’s a downward-pointing arrow with a number beside it). 

A list of apps appears.  

3. Click Check for Updates. It takes the Windows Store a couple of seconds to find the available updates. 

4. To update individual apps, click their Download icon (a downward-pointing arrow), or click Update All to 

update all the apps.  

5. When the update finishes, close the Windows Store. At this step, if you don’t see a downward-pointing 

arrow with a number beside it, all your installed apps are up to date. You don’t have to update any of them.  

UNINSTALL APPS FROM THE WINDOWS STORE 

To remove an app from your Windows 10 computer or device, follow these steps:  

1. Open Settings. (Windows + I) 

2. Click System. The list of system settings appears.  

3. Click Apps & Features. A list with all installed apps appears. 

4. Scroll down the list of apps until you find the one you’re looking for.  

5. Click the app that you want to remove to select it.  

6. Click Uninstall. 

7. Click Uninstall again to confirm your choice.  

8. If you’re asked for an administrator password, click Yes and go through the Uninstall wizard. When you 

remove desktop apps, a UAC prompt appears. You must have the administrator password to remove the app. 

If you don’t have the administrator password, you can’t remove the desktop app from your computer. Your 

only choice is to click No and stop.  
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9. When the app is uninstalled, close the Settings window. 

PINNING APPS 

After an app is installed from the Store, you'll find it listed in the All Apps area of the Start menu with all the other 

apps on your PC. With a right-click, you can pin the app to your Start Menu or your desktop taskbar, so it’s easier 

for you to find and use later. You can also drag it to your Desktop where it will become a shortcut icon. 

Here’s a couple of free applications to install if you want to practice 

Multimedia8 is a competent and polished application that is available free. It does what you might expect a native 

app to do, which is to enable you to enjoy media content from any source on your computer or the cloud. 

Solitaire. Microsoft stripped basic solitaire from Windows 8. But now, there are 464 versions of solitaire (most are 

free) that you can install on your computer from the Windows Store.  

Here are some more apps that are interesting to view: 

 Burger recipes 

 Best sandwich recipes 

 Dessert mania 

 Cookie monster and lovers 

 Adobe Photoshop Express 

 Police Radio Scanner  

 Network Speed Test 

UNIVERSAL APPS AND THE WINDOWS STORE 
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Many of the apps that come with Windows 10 are “universal apps,” which are the successors to Windows 8’s 

“Metro apps” or “Store apps.” Unlike on Windows 8, these apps actually run in windows on the desktop, so you 

may actually be interested in using them. 

To get more of these apps, you’ll need to open the Microsoft Store from within your Microsoft Account and 

download them from there. There’s no way to “sideload” these types of apps by downloading them from the 

Internet, although you’re free to avoid them entirely and install traditional Windows desktop (legacy) applications 

from the web. You can also mix and match traditional Windows desktop applications and new apps from the Store. 

They’ll all run in windows on your desktop. 

RESET WINDOWS STORE APPS IF THEY ARE NOT WORKING 

Windows 10 (v1607) lets you easily, with a click, reset your Windows Store app, if it is not working properly. 

Earlier if apps did not work properly, the solution was to re-register it using PowerShell. With this new feature, you 

can reset apps easily. 

Open the Start Menu and click on the Settings icon. Next, click on System and then on Apps & features in the left 

panel. Having done that, you will see the following window. 
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Next, identify the app which is not working properly and click on it. the panel will expand and you will see options 

to Move and Uninstall. Here you will also see Advanced options. Click on it and the following window will open. 
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You will have to click on the Reset button to reset the app. Clicking on it will open the following warning window, 

telling you that the app’s data will be deleted and preferences reset. 

 

Click on Reset. In a few seconds, you will see a check mark next to the reset button, indicating that the operation has 

been completed successfully. 
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Now return to the app and confirm that it is now working properly. 
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CHAPTER TWENTY  
USE YOUR PC LIKE A TABLET 

TABLET MODE  

Activating Tablet Mode (which you can do in the Action Center) strips all apps off your screen, leaving only icons 

for Task View, the Start Menu, and Cortana/search in your taskbar. Those icons are more spread out in Windows 

10, which is nice for fat-fingered folks who don’t use a stylist. Even open and pinned apps disappear from the 

taskbar to “reduce clutter and simplify the experience,” though you can disable that by firing up the Settings app, 

searching for Tablet Mode, then toggling “Hide app icons on the taskbar when in Tablet Mode” to off. 

That same Tablet Mode settings screen also contains an option to boot directly into Tablet Mode, rather than the 

desktop (though the latter is still the default). You can select your default interface from the “When I sign in” drop-

down menu. 

Tablet mode makes Windows easier and more intuitive to use with touch on devices like 2-in-1s, or when you don't 

want to use a keyboard and mouse. To turn on tablet mode, select the action center icon on the taskbar and then 

select Tablet mode. 

In tablet mode, Start and any application (including older programs) open full screen, giving you more space to 

work in. To use two application side-by-side, drag and app to one side. You'll see where it'll snap, along with any 

open application that can snap right next to it. When you're done with an app, drag it to the bottom of the screen to 

close it. 

If your device has a smaller screen, the taskbar will automatically adjust to fit it. 

TOUCH GESTURES FOR TOUCHSCREENS 
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If you have a tablet with Windows 10, a 2-in-1 device such as Microsoft Surface, or simply a laptop with touch, 

you can use all kinds of touch gestures to interact with the operating system and the apps that you’re using. Here is 

a list of the touch gestures  

• Tap: Tap once on an item to open, select, or activate it. This gesture is similar to a left-click with a mouse. 

• Press and hold: When you press and hold your finger on an item, Windows shows information about the item or 

opens a menu that is specific to what you’re doing. For example, if you press and hold on a tile on the Start menu, 

options to rearrange and resize it appear. In File Explorer, if you press and hold on a file, the right-click menu pops 

up.  

• Pinch or stretch: Touch the screen or an item with two or more fingers, then either move the fingers toward each 

other (pinch) to zoom in or away from each other (stretch) to zoom out This is especially useful when you work 

with pictures in the Photos app or in similar apps.  

• Slide: Drag your finger on the screen to the left, right, top, and bottom to scroll and move through what is on the 

screen. The slide gesture is similar to scrolling with the mouse. It’s especially useful when working with 

documents in such apps as Excel and Word.  

• Drag: To move an item, press and briefly drag it opposite the way the page scrolls and then move it wherever you 

want (this is similar to the way you drag with the mouse). For example, if the page scrolls left or right, drag the 

item up or down. After you move the item to the new location, release it. 

• Swipe: When you swipe an item with a short, quick movement opposite the direction the page scrolls, you select 

that item. Depending on the app you’re using, the app’s commands appear. For example, if the page scrolls left or 

right, swipe the item up or down to select it. If the page scrolls up or down, swipe the item left or right to select it.  

• Swipe from edge: When you swipe your finger quickly, without lifting it, from the right side of the screen to the 

left, the Action Center appears. If you swipe your finger quickly, without lifting it, from the left side of the screen 
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to the right, a list of all the open apps appears. You can then switch between apps by tapping the app that you want. 

This action is somewhat like pressing Alt+Tab on your keyboard.  

• Rotate: When you put two or more fingers on an item and turn your hand, you rotate the item in the direction that 

your hand turns. This gesture works only in a few apps, and mostly with images. 
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CHAPTER TWENTY-ONE 
Great Free Windows Programs You May Have Missed 

WINDOWS ESSENTIALS 2012 (hyperlink) 

Windows Essentials 2012 is a suite of five programs. You can install the entire suite or the individual programs. 

The programs are Photo Gallery, Movie Maker, Windows Live Writer, Windows Live Mail and OneDrive. 

Go to Microsoft.com to download Windows Essentials. Choose Download Now to download and install the whole 

suite.  

Once the package has been installed it will appear on the All Apps screen (scroll down to the Ws) where it can be 

pinned to the Start screen and/or the Desktop’s taskbar. 

GET MICROSOFT WORD FOR FREE (hyperlink) 

GET MICROSOFT EXCEL FOR FREE (hyperlink) 

Microsoft is quietly offering a free online version of some popular Office products, including Word and Excel. 

They don't have every feature found in their desktop counterparts, but for most tasks they'll get the job done.  

The new office suit is called OFFICE ONLINE (hyperlink) and probably the best part (besides the absence of a price 

tag) is that cloud-based software requires no download, installation or updates. You just login to a website, and the 

software runs right in your web browser. 

So what can this free online version of Microsoft Office do for you? For starters, you have free access to cloud-

based, lightweight versions of four popular Office modules: Word, Excel, PowerPoint, and OneNote. In addition 

you have Outlook, Calendar, People (contacts), and OneDrive for cloud storage. All the components are available 

for those who register for a free Microsoft account. 

http://windows.microsoft.com/en-US/windows/essentials
https://office.live.com/start/Word.aspx
https://office.live.com/start/Excel.aspx
https://www.office.com/
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Cloud-based services are being taken for granted by the upcoming generation of users. They expect to be able to 

share their work with others easily; to have access to their work on any of their mobile or desktop devices; and to 

let someone else take care of upgrading and maintaining the security of their applications. And more and more, 

people expect software to be free, too.  

DETAILS ABOUT OFFICE ONLINE SOFTWARE 

Access Office Online 

To access Office Online, open any popular web browser and follow these steps:  

1. Navigate to https://office.live.com.  

2. Click Sign In.  

3. Type the email address and password of your Microsoft account.  

4. Click Next.  

5. Click Submit.  

6. Click the icon of the Office app that you want to use: Word Online, OneNote Online, PowerPoint Online, 

Excel Online, or Sway. 

Office Online works with almost any web browser. You don’t have to use Internet Explorer or Microsoft Edge in 

order to edit your documents online. 

Upload Your Documents to Office Online 

Once you open Office Online in your browser, you can use Office Online to open your documents, but only if 

they’re uploaded to OneDrive or Dropbox. If you’re using Dropbox, you must also connect your Office Online 

account with your Dropbox account.  

Here’s how to upload a document to OneDrive, using your web browser:  

1. Sign in to Office Online.  

https://office.live.com/
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2. Click OneDrive. The OneDrive website is loaded in your web browser.  

3. Navigate to the folder where you want to store that document.  

4. Click Upload.  

5. In the Choose File to Upload window, navigate to the document that you want to upload. 

6. Select the document.  

7. Click Open to upload the document. 

Open Your Documents in Office Online 

After the documents you want to work with are uploaded to OneDrive, you can access and work with them using 

Office Online in your web browser.  

Here’s how to open documents in Word Online, after it’s uploaded to OneDrive:  

1. Sign in to Office Online.  

2. Click the Word Online app. Word Online loads in your web browser.  

3. Click Open from OneDrive. The OneDrive website is loaded in your web browser. 

4. Navigate to where you uploaded the document that you want to work on.  

5. Click that document, and it opens in the appropriate Word Online app.  

INSTALL A FREE FULL-FEATURED OFFICE APPLICATION THAT WILL 

COMPETE SUCCESSFULLY WITH MICROSOFT OFFICE 2016 (TWO POWERFUL 

PROGRAMS ARE LISTED HERE) 

Sooner or later, nearly everyone whose work involves computers will need basic office tools such as a word 

processor or spreadsheet program. Since Microsoft's powerful Office suite sets the standard, alternatives need to 

demonstrate their compatibility with the latest versions of Office. KINGSOFT OFFICE FREE (hyperlink) is the 

freeware version of Kingsoft Office Professional. It's a fraction of the size of some similar programs and it's free. 

https://www.wps.com/wps-office-personal
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From its start menu to its individual tools, Kingsoft is enough like Office in features and options to be familiar to 

many users. You will be able to create, save, edit, open, and re-edit documents from both Microsoft Office 2016 

and Kingsoft Office 10 in each of the comparable tools. 

Another excellent FREE full-featured office product is LIBREOFFICE (hyperlink).  

SEARCHING FOR A GOOD DAILY NEWS SOURCE (Need a Home Page?) 

Of course you could just browse news sites on your Windows 10 Edge browser (and there are apps for many leading 

large papers), but USAToday stands out for having created a well-designed, reasonably rich, click-friendly news app. 

You scroll through sections for News, Sports, Life, Money, Tech, and Travel, each with buttons to call up relevant 

photos, videos, and "snapshots" or infographics. For Sports and Money, sections are added for scores and markets. 

Your local temperature and weather icon appear at top right, and clicking this opens a map and ten day or hourly 

temperature and precipitation forecasts. 

Go to the Microsoft Store for this free gem. 

AN IMPROVED VERSION OF WORDPAD IS AVAILABLE. 

Wordpad, Microsoft’s basic word processing program, has been around since the early days of Windows. 

However, it has been much-improved since it was added to the Window 7 operating system and the application that 

is available in Windows 10 may serve your word processing needs quite adequately. 

While at the Ask me anything search box, type wordpad. The application will appear at the top of the column where 

you can right-click on it and then pin it to the Start screen or pin it to the taskbar. 

PROGRAMS TO RECOVER DELETED FILES 

So you lost an important file. If you simply deleted the wrong file, you can usually get it back by opening the 

Recycle Bin and restoring it. The happy secret here is that in most cases, deleted files really aren't gone at all. 

http://www.libreoffice.org/
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They're just moved into the Recycle Bin and can be restored to their original folders with a few clicks. But if that 

doesn't do the trick, try one of these free tools. 

Piriform's Recuva will help you to find files and images on your computer that were deleted by human error, 

including those deleted from your digital camera memory card or MP3 player. Recuva can also restore files deleted 

from the recycle bin or those that were deleted by a bug, virus or crash. Recuva comes from the same people that 

developed the popular CCleaner, so the reputation is rock solid. 

FreeUndelete has no charge for personal usage, although they charge for businesses. The program is spyware 

and adware free and can restore files from your Recycle Bin or NTFS, FAT32 or FAT16 hard drives. Once 

recovered, they will be saved in a new user-selected location to prevent overwriting files. 

Obviously, all of these tools are most useful if you install them BEFORE you lose the data, because 

downloading a file can possibly overwrite the very file(s) you want to recover. Check out one or both of these 

and download them to a flash drive or other portable storage, so you'll be ready in case you do need to 

recover lost files.  

SPELL CHECKER IN ANY WINDOWS APPLICATION 

Although it’s called Tiny Spell, what it does isn't tiny at all. Tiny Spell can correct your spelling in any application 

within Windows. If you're working in a program that doesn't support Microsoft Office, you can still have 

confidence knowing you're spelling everything correctly. No more dumping a word into a Word document just to 

see if it is spelled right. With Tiny Spell's simple to use interface, you'll cruise through misspelled words easily and 

quickly.  

Tiny Spell sits in your system tray on the right side of the taskbar) and turns from white to yellow when it 

recognizes an incorrectly spelled word. 

http://www.recuva.com/
http://www.officerecovery.com/freeundelete/
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A quick click on the icon and a list of possible spelling choices pops up. Highlight the correct entry and you're on 

your way. This may be easier to use "on the fly" in Word than the actual built in spellchecker.  

Since Microsoft’s Wordpad does not have a spell checker, this program is a “must have” if you are using this old 

warrior as your word processing program. You can also add words to Tiny Spell's database that it may not be 

familiar with (for example: proper nouns) and it will then recognize them in the future. 

http://tinyspell.numerit.com/ 

Add the Free Merriam-Webster Dictionary to Your Taskbar 
 

If you are working in a Microsoft Office program (Word, Excel, or PowerPoint), you probably know that you can 

check on a word‘s spelling by highlighting the target word and then pressing F7. In addition, you can do a grammar 

check by using Alt+F7. By right-clicking on a word in Microsoft Office, you have access to a lookup function as 

well as a list of synonyms for the target word. 

 

There are times, however, when it would be great to have an outstanding dictionary ready for your immediate 

access, especially if you are reading an article from the Internet. This is one of the best and is available for free 

from http://www.merriam-webster.com/. Once you access the Website, grab (hold down on the left mouse button) 

the small red and blue logo that appears in the extreme left side of the address bar and drag it to an empty slot on 

your Taskbar. 

http://tinyspell.numerit.com/
http://www.merriam-webster.com/
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Now whenever you open your dictionary, you will be treated to a resource that looks like this: 

 
 

FREE PROGRAMS THAT YOU WILL WANT TO HAVE ON YOUR COMPUTER 

Here are some programs that many experts recommend that you install on your computer. Note that all of these 

applications are accessible via your favorite search engine. Simply type in the key word or phrase into the address 

(locator) bar. 

Have at least two browsers installed, in addition to Internet Explorer and Edge (the default that comes with 

Windows). Try Google Chrome and Mozilla Firefox. 

Install one of the following free anti-virus programs: Avira or Avast.  Remember, here is a case where more is not 

better!  (Windows 10 users may wish to stay with Windows Defender.) 

Ninite makes loading a computer with new applications a breeze. Simply head to the Ninite website, select which 

programs you’d like to install on your PC—it offers dozens of options—and click Get Installer to receive a single 

https://www.google.com/chrome/index.html
https://www.mozilla.org/en-US/firefox/new/
http://www.downtoad.com/landing/bing2/aviraantivirus/index.php?kw=avira
https://www.avast.com/en-us/lp-ppc-win-02c?cha=ppc&sen=bing&ste=avast&var=7197302013&omcid=EN-US_Search_Brand_Bing&utm_source=bing&utm_medium=cpc&utm_campaign=EN-US_Search_Brand_Bing&utm_term=avast
https://ninite.com/
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file containing the installers for those programs. Run the executable and Ninite installs all of them in turn. (Run on 

demand.) 

Malwarebytes has created an easy-to-use, simple, and effective anti-malware application. Whether you know it or 

not your computer is always at risk of becoming infected with viruses, worms, Trojans, rootkits, dialers, spyware, 

and malware that are constantly evolving and becoming harder to detect and remove. Only the most sophisticated 

anti-malware techniques can detect and remove these malicious programs from your computer. By the way, this 

application can run at the same time with your anti-virus program and will not be in conflict. (Run on demand.) 

SlimComputer finds unneeded files, the ones that slow your computer down over time. There's also an uninstaller 

that offers advice on which software you might want to keep, and which to uninstall. It rates each program on your 

system as to whether you likely need it or not. You can then use that as part of your decision about whether to keep 

the program. The program itself doesn't actually do the ratings; instead, everyone who uses SlimComputer can rate 

their own programs, and that information is then collated and presented by SlimComputer. Don't expect it to be 

definitive, but it will help you decide whether to keep each program. (Run on demand.) 

Unlocker. What if Windows refuses to uninstall some software and tosses up the dreaded ‘Program is in use’ 

message? Unlocker can neutralize pesky active processes that leave programs open and unable to be removed. 

Once Unlocker is installed, simply right-click the software you want to uninstall, select Unlocker from the context 

menu, and then unlock or kill all the processes that are preventing the uninstall.  

Just be careful when installing Unlocker. It tries to install lots of bloatware on your PC. Don’t click on “next” 

until you have read the related window carefully. If there is a “decline” button, you are not declining to download 

the program. You are just declining the offer to install the bloatware! 

Data Recovery will help you to find files and images on your computer that were deleted by human error, 

including those deleted from your digital camera memory card or MP3 player. Data Recovery can also restore files 

deleted from the recycle bin or those that were deleted by a bug, virus or crash. (Run on demand.) 

PrivaZer. According to nationally recognized tech expert Bob Rankin, this program is a hard drive clean-up utility 

on steroids. It gets rid of junk files and wipes away traces of activity that could compromise your privacy.  

http://www.malwarebytes.org/
http://slimcomputer.com/
http://unlocker.en.softonic.com/
http://www.wondershare.net/ad/data-recovery/index-bing.html?utm_source=bing&utm_medium=ppc&utm_campaign=DataR&utm_term=recuva
http://privazer.com/
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The "clean and optimize your PC" field has been crowded for years with programs like CCleaner, Advanced 

System Care, and many others. PrivaZer leaves them all gasping in its dust. The first time you run PrivaZer, you 

will be impressed by the number of clean-up options it gives you. But you won’t be confused, because they are 

clearly and cogently explained. A recommended option doesn’t just have the word “recommended” next to it; it 

includes a brief explanation of why it’s recommended and what it will do that’s different from other options.  

The first scan and clean-up of your desktop or laptop will probably take over six hours, not because PrivaZer is 

slow but because it does an enormous amount of work. Rankin has run Advanced System Care Pro on his machine 

at least once a week for a long time, but PrivaZer still found about a gigabyte of stuff it could trash or fix. (Run on 

demand.) 

PowerTools Lite, a freeware version of a professional grade jv16 PowerTools utility package, will help all 

Windows users easily yet effectively fix Windows registry errors and delete unneeded data. 

This application enables even the least technically skilled computer owner to benefit from a safe system and 

registry cleanup. It also clears unnecessary data from the registry and history data from all major applications and 

Windows itself, along with deleting any unnecessary temporary files. (Run on demand.) 

Secunia Personal Software Inspector (PSI) at your command will check all the software on your computer for 

vulnerabilities. This free program will tell you which programs need updating and provide links to sites where you 

can download patches. The software you use every day is the biggest source of danger to your personal 

information. Keeping your software up to date is your best defense. You cannot afford to let vulnerabilities go 

unpatched. (Run on demand.) 

Sumatra PDF. Although Adobe Reader is the go-to PDF reader that’s pre-installed on all laptop and desktop 

computers, it’s clunky, constantly updating, and frequently targeted by malware peddlers. If you need only basic 

functionality, go with Sumatra PDF instead. Sumatra lacks the fancy extras found in many full-featured PDF 

readers, but when it comes to straight-up reading Portable Document Format files, Sumatra PDF is blazing-fast and 

completely accurate. Oh, and since it’s less popular than Adobe’s offering, hackers tend to stay away from Sumatra 

PDF. (Note that PDF files can be opened safely by using Microsoft Edge. 

http://privazer.com/
http://www.macecraft.com/powertools-lite-2013/
http://www.majorgeeks.com/files/details/secunia_personal_software_inspector_(psi).html
http://sourceforge.net/projects/sumatrapdf.mirror/
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LastPass or KeePass. The high-profile hack attacks of the past few years have driven the point home: You need 

strong passwords, and you need a different password for each site you visit. Rather than juggling dozens of 

alphanumeric codes in your head, download a password manager. These two applications are highly recommended. 

KEEP UNWANTED PROGRAMS (PUPS) OUT OF YOUR COMPUTER 

As you download and install software, have you ever felt that the installer is trying to push additional unwanted 

programs at all costs? Have you ever missed a checkbox and then spent hours afterwards removing adware? Ever 

opened your browser after an installation, only to discover that you have a new homepage, a new search engine, or 

even a new browser? 

Unchecky aims to keep potentially unwanted programs out of your computer. 

WWW.UNCHECKY.COM  

 

https://lastpass.com/misc_download2.php
http://keepass.info/download.html
http://www.unchecky.com/
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CHAPTER TWENTY-TWO 

RESTORE, REFRESH, OR RESET YOUR COMPUTER 

How to restore, refresh, or reset windows 

If you're having problems with your PC, you can try to restore, refresh, or reset it.  

RESTORE (System Restore) your computer is a way to undo recent system changes you've made, such as 

installing an application that conflicts with others that are already installed.  

REFRESH your computer reinstalls Windows and retains your personal files, settings, and the applications that 

came with Win10 and apps that you installed from the Windows Store. However, any legacy applications that you 

installed from the Internet or a disc will be lost. 

RESET your computer reinstalls Windows but deletes your files, settings, and applications—except for the apps 

that came with your PC out of the box. 

BACK UP YOUR WINDOWS REGISTRY WITH SYSTEM RESTORE 

The Windows Registry is at the heart of the Windows operating system. The Registry is a group of system files 

constructed into a database that contains system-level and application-level parameters on both a machine and a 

user basis. If the Registry were to become corrupted it could render your system unusable, so it's important to take 

regular backups of it so you can restore a good copy of the Registry if necessary. 

The best way to protect yourself is to take a backup of the complete Registry. This can be done by creating a 

restore point, since the Registry is included in restore points. To create a restore point, follow these steps: 

1. From the Search box, type restore point. 

2. Click Create a restore point from the list that appears in the column above. 
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3. Click on the Create button. 
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4. Select the Local Disk (under the Protection Settings group) and click the Create button. You will then be 

prompted to enter a description for the Restore Point. The date and time of the restore point you create will 

be inserted automatically. 

5. At a later date, if you need to revert back to a restore point, follow steps1 and 2 and click on the System 

Restore button. 

 

 

Restore Your Computer to an Earlier Point in Time (System Restore) 

If you think an app or driver that you recently installed caused problems with your PC, you can restore it back to an 

earlier point in time, called a restore point. System Restore doesn’t change your personal files, but it might remove 

recently installed applications and drivers. 
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To restore your computer using System Restore 

1. From the Search box, type system restore. 

2. From the top of the column, click on create a restore point. 

3. Click System Restore (to go back in time to a previous restore point) or Create (to create a new restore 

point). 

4. In either case, follow the prompts. 

Refresh Your Computer Without Affecting Your Personal Files 

If Windows 10 is crashing, freezing, or otherwise misbehaving, one option is to “refresh” your PC. In the past we 

would have had to find our disk copy of Windows, back up all of our data, and perform a fresh install to enjoy a 

back-to-factory-fresh feeling. But now Windows 10 allows you to perform a fresh install from within Windows 

without losing any data.  

Note, however, that all the legacy programs, including files that piggy-backed from the hardware manufacturer 

(bloatware), plus any that you have installed from disks or the Internet will be lost. On a positive note, all your lost 

apps will be placed in a "Removed Apps" link on your Desktop screen. If the program was originally downloaded 

from the Internet, a direct link to the target site will be available 

To refresh your computer 

If your computer is still working, you can refresh it from the PC Settings application within Windows. Go to 

Settings (Windows + I), Update and Security, and then Recovery. Finally, at Reset this PC, click Get started. From 

there you will have two choices: Keep my files and Remove everything. 

To Remove Everything and Reinstall Windows (Reset) 

All of your personal files will be deleted and your settings will be reset. Any modern applications that came with 

your computer will be reinstalled, but all other apps will be removed.  
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To reset your PC 

If your computer is still working, you can reset it from the PC Settings application within Windows. Go to Settings 

(Windows + I), Update and Security, and then Recovery. Finally, at Reset this PC, click Get started. From there 

you will have two choices: Keep my files and Remove everything. 
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CHAPTER TWENTY-THREE 
OTHER ISSUES OF INTEREST 

PERFORM RECOMMENDED SYSTEM MAINTENANCE 

Windows 10 includes the System Maintenance tool, which is a hidden tool that you can run on demand to find out 

if there are issues with your system. This tool checks for unused files and shortcuts, performs maintenance tasks, 

checks whether the system time is set correctly, and so on. If problems are found, the System Maintenance tool 

fixes them automatically.  

To manually run the System Maintenance tool, follow these steps:  

1. In the search bar on the taskbar, type maintenance. A list with search results appears.  

2. Click the Perform Recommended Maintenance Tasks Automatically search result. The System Maintenance 

wizard starts.  

3. Click Next. The wizard begins the process of detecting possible issues.  

4. If the wizard recommends that you do the troubleshooting as an administrator, click Try Troubleshooting as 

an Administrator. When the wizard finishes, it shows a summary of its findings. If it finds issues, it also 

shows you actions that you can take.  

5. Click Close. 

THREE WAYS TO SPEED UP WINDOWS 10  

No one likes to click a hyperlink, open a program, or type a word…and then wait while his computer ponderously 

considers performing that task. If Windows is taking too much time to do its job, a few modest setting changes can 

help speed it up.  

1. Remove unnecessary autostarters 
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You might be shocked to discover how many programs load automatically every time you boot. Each one slows 

down the boot process a bit, and some may continue to slow down Windows after the boot, as well.  

To see how bad the situation is, right-click the taskbar and select Task Manager. Click the Startup tab. (If you 

don’t see any tabs at the top of the window, click More Details in the lower-left corner.)  

The Startup tab will show you all of the autoloading programs. As you examine the list, think about what programs 

really need to be running at all times. Your Malwarebytes (premium edition) program qualifies, so it’s a valid 

autoloader. But some programs, even good ones (Microsoft Word, for example), don’t really need to run all the 

time. To stop one from loading automatically, right-click its entry on the Startup tab and select Disable.  

Important Note: Windows Defender will not appear on the Startup list because the program is integrated within the 

Windows 10 operating system and starts doing its job the instant Windows 10 is activated.. 

If you don’t recognize the name of an autoloader, right-click it and select Search online. That should help you find 

information on it.  

2. Change power settings 

Windows may assume that you’d prefer an energy-efficient computer rather than a fast one—especially if you have 

a laptop. There are good reasons to go with energy efficiency, but not when the PC’s slow performance is driving 

you crazy.  

Right-click the Start button and in the resulting menu, select Power Options.  

In the resulting window, pull down the Show additional plans option that appears at the bottom of the right 

column. Then select High Performance.  

3. Get rid of fancy animations 
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There’s a lot of code in Windows that just makes things looks nice. If your PC is underpowered, you may want to 

skip the aesthetics and gain some speed.  

Right-click Start, and select System. In the resulting window’s left pane, select Advanced system settings.  

This brings up the System Properties dialog box. Click the Advanced tab, then the Settings button in the 

Performance box (the first of three “Settings” buttons on this tab).  
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This brings up another dialog box. Select Adjust for best performance. Finally, click OK twice and then close your 

open windows. 

If your laptop (or tablet) is underpowered, the performance improvement will be significant. 
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USING THE STORAGE SENSE FEATURE 

If you have a tablet, a hybrid device, or a laptop that has internal storage available on a hard disk and an external 

microSD card, you may want to set where your files are saved by default. Doing so places them where you want 

and helps you keep track of them. Using the new Storage Sense feature, you can easily set where your new apps, 

documents, pictures, music, and videos are stored. 

Here’s how to set up the Storage Sense feature:  

1. Open Settings. 

2. Click System. A list with system settings appears.  

3. Click Storage. A list with storage related settings appears.  

4. In the Save Locations section, select where you want to save your new apps, documents, music, pictures, 

videos, and so on.  

5. Close Settings.  

If your Windows 10 device has little storage space, you may want to save your new apps and games to the 

microSD card  that you’re using, instead of the internal storage provided by your device. Because music and video 

files can take up a lot of space, you may want to store those on the microSD card as well. 

 

ALTER YOUR POWER OPTIONS FOR ENERGY SAVINGS AND CONVENIENCE 

Press Windows + X, then Power Options. Through this screen, you can alter the time for your display to switch off 

when not being used, while advanced options will enable you to alter power settings for your computer. (From the 

left column, select Choose what the power buttons do and Create a power plan.) 

Why should you be concerned about Power Options? Here are some considerations: 
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If you have finished using your computer for the day, do you shut it down (turn it off), power it down into a Sleep 

mode, put it into hibernation (if the function is available), or just leave it on? All the evidence suggests that you 

will save wear-and-tear on your computer as well as save on your electrical costs by not keeping it on 24/7.  

Factoring in both energy savings and convenience, experts suggest that you turn off both your computer and 

monitor if you don’t plan to use your computer within the next two hours.  

If you don’t plan to use your computer within 20-30 minutes, you should place it into sleep mode 

immediately upon leaving and return from sleep mode with no delay at the touch of a key or a shake of the mouse. 

It is also a good plan to set up your Display to turn off after 10 minutes of not being used and have your computer 

go into sleep mode after 20 minutes. 

HOW TO CONNECT TO A WI-FI NETWORK 

To connect to a network, click Windows + I. An icon for Network and Internet appears. If you haven’t yet 

connected to a Wi-Fi network and at least one is available, you will find it listed along with its signal strength.  

Click on that icon and select the option to have your computer remember the connection, if you plan to access it 

again in the future. After that, you'll be prompted to enter the network security key, if necessary. 

SCREEN CAPTURES VIA THE SNIPPING TOOL 

Screenshots, aka screen captures, are images copied straight from your monitor’s screen. Screenshots can provide 

an opportunity for people to better describe computer problems. If you are getting an error message, and would like 

to be able to explain the error to a tech, that explanation is much more effective when an image is included. It’s 

much better and much faster than writing down the message in long-hand. 

In Windows 10, there's a feature called the Snipping Tool, which will allow you to select just what you want 

included in your screenshot. 
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To find the Snipping Tool, type snipping in the search box. This will cause the Snipping Tool application to 

appear at the top of the column. By right-clicking on the Snipping Tool app, you can pin it to either the Start Menu 

or the Taskbar of the Desktop, or both, for easy access. 

Click on the Snipping Tool and select an area of the screen you'd like to capture. The Snipping Tool will offer you 

options about where and how to save the image. 

Just go to File, then Save As, and you can choose a location, along with one of several file types. Once the file is 

saved, you can go to that location and open it, just as you would any other picture. 

DETAILS FOR CAPTURING CUSTOM SCREENSHOTS WITH THE SNIPPING TOOL 

The best tool for taking screenshots is the Snipping Tool. With the Snipping Tool, you can take full-screen 

screenshots, screenshots of a specific window, and rectangular or free-form screenshots. Once you’ve taken a 

screenshot, you can edit it and use tools such as pens, highlighters, and erasers.  

Here’s how to use the Snipping Tool to take a screenshot of a specific app window: 

1. Open the app for which you want to take a screenshot.  

2. In the search box on the taskbar, type the words snipping tool. A list with search results appears. 

3. Click the Snipping Tool search result. The Snipping Tool desktop app opens. 

4. In the Snipping Tool window, click the downward-pointing arrow located to the right of the New button.  

5. In the menu that appears, click Window Snip (or the rectangular snip). 

6. Click the window that you want to capture (or draw a rectangular box around the part of the window that you 

wish to capture.) The screenshot is loaded into the Snipping Tool’s clipboard, from where it can be 

transferred to a separate document. 

ADD YOUR GMAIL ACCOUNT TO THE TASKBAR FOR QUICK ACCESS 

USING INTERNET EXPLORER: 
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1. Open Internet Explorer from the Desktop’s Taskbar. 

2. Access the address bar by clicking on the + (plus) sign at the top of the browser. 

3. From within the address bar, type gmail.com. 

4. Sign-in with your username and password. 

5. If you do not have a gmail account, click create an account. 

6. Click on the stay signed in box and then click sign in. 

7. When your gmail account appears as the active page, then click on the cog wheel in the upper right corner of 

the page. 

8. Click on add site to apps. 

9. Click on the Start button on the far left side of the Taskbar. 

10. Click on All Apps. 

11. Find the Gmail app and right-click on it. 

12. Now right-click on More, then click pin to Taskbar. 

 

USING WINDOWS EDGE: 

1. Open Edge from the Desktop’s Taskbar. 

2. Access the address bar by clicking on the + (plus) sign at the top of the browser. 

3. From within the address bar, type gmail.com. 

4. Sign-in with your username and password. 

5. If you do not have a gmail account, click create an account. 

6. Click on the stay signed in box and then click sign in. 

7. When your gmail account appears as the active page, click on the three horizontal dots in the upper right 

corner and then click on open with Internet Explorer. 

8. Now follow steps #7 through #11 in the first set of steps above. 
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USING GOOGLE CHROME: 

1. Open Google Chrome from the Desktop’s Taskbar. 

2. From within the address bar, type gmail.com 

3. Sign-in with your username and password. 

4. If you do not have a gmail account, click create an account. 

5. When your gmail account appears as the active page, then click on the three horizontal bars in the upper 

right corner of the page. 

6. Click on More tools, then Add to Desktop. 

7. Return to your Desktop where you will find a shortcut icon for your Gmail account. 

8. You can now drag it (left-drag) to your Taskbar. Once the icon is on the Taskbar, it can be removed from the 

Desktop. 

ADD YOUR GMAIL ACCOUNT TO ALL APPS AND/OR THE TASKBAR 

1. Open Internet Explorer from the Desktop’s Taskbar. 

2. From within the address bar, type gmail.com. 

3. Sign-in with your username and password. 

4. If you do not have a gmail account, click create an account. 

5. Click on the stay signed in box and then click sign in. 

6. Click on the cog wheel that appears near the upper right corner of the screen.  

7. Click on Add site to Apps. 

8. Now find the Gmail tile in the All Apps screen, right-click on it, and pin it to Start and/or the Desktop’s 

Taskbar. 
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ACCESSING TWO GMAIL ACCOUNTS ON THE SAME COMPUTER 

You can easily access two or more of your personal Gmail accounts on the same computer. (If you have only one 

Gmail account, this procedure will show you how to create additional accounts with unique usernames.) 

1. Open one of your existing Gmail accounts. 

2. Click on the colored circle that appears to the far right of the Google search bar. (If you entered a personal 

photo when you set up your gmail account, that photo will appear in place of the colored circle.) 

3. Click Add Account (lower left corner). 

4. At the next screen, you can either add an existing account or create a new gmail account from scratch. 

5. If you wish to remove any of the multiple gmail accounts, return to step #2 and click Sign Out. All the 

multiple gmail accounts that you have assigned to the target computer will be shown. Click on the Remove 

box and note that an X will appear to the right of each account. Click on the X for the account you wish to 

remove and then click Done. 

 

TRACK YOUR COMPUTER’S RELIABILITY 

The chart you will find here is interactive. If you click a column, you will see detailed text below. It may show you 

if a particular application stopped working and why. It also keeps track of when you have installed or updated 

applications and drivers so you can pinpoint exact dates and use that information for troubleshooting. 

1. From the Start button, type reliability. 

2. Select View reliability history in the box at the top of the column. 

UNLOCKING THE LOCK SCREEN 

The first screen you see on your computer after Windows 10 boots is the Lock Screen (Windows key + L). This 

concept was introduced in Windows 8 and continues in Windows 10. The Lock Screen is basically a full-screen 

wallpaper. By default, it shows you the time and the date and whether you’re connected to a network. You can 
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customize it to also show the detailed status of an app as well as small icons of your favorite apps so that you can 

see the status of those apps without leaving the Lock Screen. Along with all that, you can customize the Lock 

Screen’s image. 

How you unlock the Lock Screen and move on to the Login screen depends on the type of computer you’re using: 

A Windows 10 desktop computer without touch: 

• Press any key on the keyboard.  

• Click the mouse anywhere on the screen.  

• With your mouse, drag upward from the bottom of the screen. 

A Windows 10 laptop with a touchpad:  

• Press any key on the keyboard.  

• Click the mouse or the left-click trackpad button anywhere on the screen.  

• Hold down the left trackpad button and drag your cursor upward. 

Any Windows 10 device with a touchscreen (such as a tablet or a 2-in-1 device): 

• Place your finger anywhere near the middle or bottom of the screen and flick upward. 

YOU CAN AUTOMATICALLY SIGN IN TO A LOCAL ACCOUNT WITHOUT NEEDING A 

PASSWORD 

Initially, Windows 10 throws up both a Lock screen and a login screen in front of you before you can access the 

operating system, but if you don’t need to shield your Local account from prying eyes, you can bypass both the 

Lock screen and the login screen entirely.  
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Follow these steps to delete the password from a local account. Once you delete the password, your login screen 

will be bypassed at startup. 

(You only need to do this function once.) 

1. Type netplwiz at the search box. 

2. From the search results that will appear at the top of the column, click on the button for netplwiz. 

3. In the User Accounts Control Panel, deselect the checkbox that says “Users must enter a user name and 

password to use this computer.” 

4. Click OK. 

5. Type your password once (if you have one) and then again to confirm it. 

6. Click OK again to close the User Accounts tool. 

7. When you restart Windows, you’ll now avoid the need to use a password to access your local account.  
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HOW TO DISABLE THE LOCK SCREEN  

 

When you start your computer, a Lock Screen welcomes you. Your Lock Screen consists of a full-screen picture 

of your choosing. (Pressing Windows + L will bring the Lock Screen to view. If the Lock Screen does not appear, 

it is already disabled.)  

1. Press Windows+R and type MSConfig in the run box. Press Enter. 

2. System Configuration Dialogue box opens. Press Boot tab on the top. 

3. Check the box for No GUI and press the OK button in Boot options and then press OK. 
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4. You will get a confirmation pop up. Click the Restart button. 
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5. Your computer will Reboot. Your computer boots without getting any Lock Screen. 

6. You can re-enable the Lock Screen by repeating steps 1-4 above and unchecking No GUI Boot followed by 

OK. 

ANOTHER WAY TO DISABLE THE LOCK SCREEN  

Although the Lock Screen cannot be avoided when you boot to your Microsoft account, it is easy to turn off when 

you boot to your local account by carefully maneuvering through certain registry settings. You need to do these 

steps only once. 

While you are in your local account, follow these steps. 

1. Press the Windows key + R to access the run box. 

2. Type regedit, press Enter and then Yes. This action will open the registry. 

3. Expand (click on the lever to the left) the HKey Local_Machine key. 

4. Find and expand (lever) the software key. 

5. Find and expand (lever) the policies key. 

6. Find and expand (lever) the Microsoft key. 

7. Find and expand (lever) the Windows key. 

8. Find and expand the Personalization key. (If it isn’t available inside the Windows key, click on the 

Windows key to show its contents in the right pane. Then right-click on a blank area and select New > Key. 

Name the key Personalization.) 

9. Right-click on a blank space in the right pane and select DWord (32bit value). 

10. Right-click on the DWord file and rename it NoLockScreen. 

11. Right-click on NoLockScreen and change its value to 0. 

12. Close the Registry. 

13. This registry change will be permanent until you change the value back to 1 at a future date. 

14. Now when you boot your computer to your Local Account, you will be taken directly to your Desktop. 
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A THIRD WAY TO ENABLE OR DISABLE THE LOCK SCREEN 

1. Press Windows + I to get to the Settings menu. 

2. Click on the System tile. 

3. Click on the Power & Sleep button in the left column.  

4. Find and click on Additional Power Settings. 

5. Then click on Choose what the power buttons do 

6. Next click Change settings that are currently unavailable. 

7. You can now move down to the bottom of the screen to find the Shutdown Settings section. Placing or 

removing a tick mark in the box next to the Lock option will enable or disable this feature. 

CHANGE THE PICTURE SHOWN ON THE LOCK SCREEN 

If you’re bored with the picture used for the Lock Screen, you can change it. If you have your Lock Screen turned 

off, all the picture choices will be greyed out.  

Follow these steps:  

1. Open Settings.  

2. Click Personalization. All the available personalization settings are shown. 

3. Click Lock screen. The lock screen-related settings are shown.  

4. In the Choose Your Picture section, select another picture from those that are included in Windows 10, by 

clicking on it. 

5. Close Settings. 

If you want to use your own picture, at Step 4, click Browse, navigate to the picture that you want to use, click on 

the picture, then Choose Picture. 
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CHANGE THE APPS THAT SHOW THEIR STATUS ON THE LOCK SCREEN 

You can set one app that shows its detailed status on the Lock Screen and seven other apps that show a quick 

status. To change which apps show their status on the Lock Screen, follow these steps:  

1. Open Settings. 

2. Click Personalization. All the available personalization settings are shown.  

3. Click Lock screen. The lock screen-related settings are shown.  

4. Click the app icon shown in the Choose an App to Show Detailed Status section. A list of apps appears.  

5. Click to select a new app from the list. 

6. In the Choose Apps to Show Quick Status section, click the icon of an app that you want to change. A list of 

apps appears.  

7. In the app list, click the replacement app.  

8. Close the Settings window. 

YOUR COMPUTER'S NUMBER ONE ENEMY IS HEAT 

If your computer shuts down without warning at random times, there are several possible causes, but overheating 

is the most likely, and easiest to solve.  
 

Signs of Overheating - And What to Do 

1. Electronic components in your computer and other devices generate heat. The harder they work the more heat 

they generate. So it's important to be alert to temperature spikes in your computer, and take steps to cool it 

down when necessary. 

2. Sudden, inexplicable shutdowns of your computer are often due to overheating. Other symptoms of overheating 

include declining performance after running processor-intensive tasks for several minutes or hours. Games may 

run sluggishly, videos may skip, and response to mouse clicks may be delayed.  

3. More alarming are sudden software crashes, random reboots, and the dreaded Blue Screen of Death. These 

symptoms may have multiple causes, but overheating is one suspect that needs to be confirmed or eliminated. 
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4. The computer will detect when the CPU, motherboard, hard drive, or graphics adapter is approaching its 

maximum operating temperature and shuts things down to avoid damaging that vital and expensive part. If you 

are experiencing shutdowns, measure your computer's temperatures and do something to lower them 

immediately. 

5. Temperature sensors are built into many computer components; the trick is accessing these sensors to read 

temperatures. Unfortunately, Microsoft Windows does not have built-in utilities to let users read temperatures. 

You have to find third-party software. Fortunately, there are several free temperature-monitoring utilities. Some 

can not only monitor temperatures but also do something to lower them. 

6. One of the easiest and safest tools to display temperature readings is Speccy (hyperlink). In addition to that, 

Speccy also gives you detailed information on every hardware component inside your Windows computer. 

RUN A FAVORITE PROGRAM AUTOMATICALLY AT STARTUP 

When you boot (start) your computer each day, chances are that the first thing you will do is either access the 

Internet via your favorite browser or open your email program to read your incoming email. Wouldn't it be great to 

have your Web browser’s home page and maybe your e-mail program, begin to load the moment you start the 

computer?  

All you need to do is copy and paste some shortcuts into the Startup Folder that is hidden within File Explorer?  

Here's how:  

1. Click the Start button and open All apps. 

2. Find the target program, e.g., your Gmail account. 

3. Right-click on the target and select Copy. Although nothing appears to have happened, this action places a 

copy of the icon onto the invisible Clipboard.  

4. Now click on the shortcut combination Windows + R. This action will take you to the run command. 

5. At the run command, type shell:startup, then Enter. This action will take you to the hidden startup folder. 

6. Right-click on an empty space anywhere within the open Startup folder and select Paste. Your target 

program is now ready to start when you boot your computer. 

7. If you want your computer to open to your favorite browser, click the Start button and open All apps. 

https://www.piriform.com/speccy
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8. Find the target program, e.g., Microsoft Edge. 

9. Right-click on the target and select Copy. Although nothing appears to have happened, this action places a 

copy of the icon onto the invisible Clipboard. 

10. Now click on the shortcut combination Windows + R. This action will take you to the run command. 

11. At the run command, type shell:startup, then Enter. This action will take you to the hidden startup folder. 

12. Right-click on an empty space anywhere within the open Startup folder and select Paste. Your target 

program is now ready to start when you boot your computer. 

13. Which program will be the active program and appear first will be determined by the order of the program 

icons in the Startup folder. The second program will be open and ready for immediate access from the 

Taskbar. 

PROBLEM STEPS RECORDER 

This little-known tool creates an HTML slideshow of your actions, recording your moves step-by-step so that you 

can show your favorite geek exactly what you're doing when you run into a problem. It's a huge boon during 

especially tricky troubleshooting situations. 

To open the Problem Steps Recorder, simply search for psr in the Window 10 Search bar. The tool should appear 

at the top of the search column. Click on the tool and it will pop up on the screen. It is very straightforward to use. 

UNDERSTANDING REMOTE ASSISTANCE 

The Remote Assistance application built into Windows enables you to both ask for assistance from others and to 

offer assistance to others. The only requirement is that both of you are on the network (which could be the Internet) 

at the same time. 

You invoke Remote Assistance by typing remote assistance at the search box and pressing Enter. Click on the 

Invite someone… option that appears near the top of the column. Windows displays the Remote Assistance dialog 

box. 
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The dialog box presents two options: You can invite someone to help you or you can help someone else. If you're 

inviting someone to help you, it's important that you trust them. You will essentially be turning control of your 

computer over to them, so be sure you're comfortable with this. 

Asking for Help 

To ask someone to help you, click the first option shown in the Remote Assistance dialog box. The options within 

the dialog box change based on your selection.  

You now need to create an invitation file to give to your helper. If you use web-based mail (like Gmail), click the 

first option, which allows you to create an invitation file and save it on your computer. If you use an e-mail client 

that's on your local computer (like OE Classic), click the second option, which mails the invitation file directly. In 

either case, your invitation file is created so that you can e-mail it to your helper. 

Once you've given the password to your helper and emailed the invitation file, you'll be placed in a "waiting state" 

where you're waiting for your helper to connect to you. During this wait time you'll see a dialog box informing you 

that it is waiting for a connection. 

All your helper has to do is start Remote Assistance and follow the steps detailed in the next section of this tip. If 

you decide that you don't want to wait, or if you've changed your mind about asking for help, click the Close button 

and answer "Yes" to the dialog box prompt. 

Helping Someone Who Has Invited You 

To help someone who has invited you to help them, click the second option in the Remote Assistance dialog box. 

The contents of the dialog box change so you can respond to the assistance invitation. 

Click the top option, open the invitation file, and enter the password that was given to you. Your systems will then 

be connected and you can proceed to give assistance. 
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Even though Remote Assistance is built into Windows (and therefore free to use), some people find it difficult or 

overly complex to use. If you fall into this camp, or if you have the need to work with dissimilar computer systems 

over the Internet, then you may be better served by looking for a third-party remote-access program. There are 

many of them available, but most charge fees. One free and highly rated one is TeamViewer. More information is 

here: http://www.teamviewer.com 

Barricade Your Computer from Strangers by Turning Off Remote Assistance 
 

All of us value our privacy, both in our home and on our computer. It seems that we all tend to think that just 

because we are using our computer at home and no one can access it unless they are given permission, our private 

documents and files are safe. However, that's not always the case. We all know about Trojan horses and other 

malware programs that can compromise our privacy and security. We also know how to set up and manage anti-

virus and anti-spyware programs to protect ourselves from these nasties.  

Even after setting up all these privacy and security barriers, however, there is still a possibility, as remote as it may 

be, that a stranger could access your personal information on your computer from anywhere in the world. A 

stranger could use your computer remotely, without your permission or knowledge. They can track every move 

you make (including your keystrokes) and could even have access to your credit card numbers, social security 

number and other valuable personal information that you may have stored on your computer. In order to help 

protect you from identity theft and snooping in general, you may wish to establish one more protective layer 

around your computer. Just follow these simple steps.  

1. From the Windows Search bar, type Advanced System Settings. 

2. Click on View Advanced System Settings at the top of the column. 

3. Click on the Remote tab.  

4. Under the Remote tab, make sure the box is unchecked for remote assistance. 

5. Click the OK button at the bottom of the box.  

 

http://www.teamviewer.com/
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3 WAYS TO SPEED UP WINDOWS 10  

No one likes to click a hyperlink, open a program, or type a word…and then wait while his computer ponderously 

considers performing that task. If Windows is taking too much time to do its job, a few modest setting changes can 

help speed it up.  

1. Remove unnecessary autostarters 

You might be shocked to discover how many programs load automatically every time you boot. Each one slows 

down the boot process a bit, and some may continue to slow down Windows after the boot, as well.  

To see how bad the situation is, right-click the taskbar and select Task Manager. Click the Startup tab. (If you 

don’t see any tabs at the top of the window, click More Details in the lower-left corner.)  

The Startup tab will show you all of the autoloading programs. As you examine the list, think about what programs 

really need to be running at all times. Your Malwarebytes (premium edition) program qualifies, so it’s a valid 

autoloader. But some programs, even good ones (Microsoft Word, for example), don’t really need to run all the 

time. To stop one from loading automatically, right-click its entry on the Startup tab and select Disable.  

Important Note: Windows Defender will not appear on the Startup list because the program is integrated within the 

Windows 10 operating system and starts doing its job the instant Windows 10 is activated.. 

If you don’t recognize the name of an autoloader, right-click it and select Search online. That should help you find 

information on it.  

2. Change power settings 
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Windows may assume that you’d prefer an energy-efficient computer rather than a fast one—especially if you have 

a laptop. There are good reasons to go with energy efficiency, but not when the PC’s slow performance is driving 

you crazy.  

Right-click the Start button and in the resulting menu, select Power Options.  

In the resulting window, pull down the Show additional plans option that appears at the bottom of the right 

column. Then select High Performance.  

3. Get rid of fancy animations 

There’s a lot of code in Windows that just makes things looks nice. If your PC is underpowered, you may want to 

skip the aesthetics and gain some speed.  

Right-click Start, and select System. In the resulting window’s left pane, select Advanced system settings.  

This brings up the System Properties dialog box. Click the Advanced tab, then the Settings button in the 

Performance box (the first of three “Settings” buttons on this tab).  
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This brings up another dialog box. Select Adjust for best performance. Finally, click OK twice and then close your 

open windows. 

If your laptop (or tablet) is underpowered, the performance improvement will be significant. 
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REMOVE UNWANTED BROWSER TOOLBARS THAT MAY BE SPYWARE OR ADWARE 

The Internet is awash in free browser toolbars that promise better searches, instant access to your favorite social 

networks, and other supposed conveniences. By some estimates, there are hundreds of different toolbars out there. 

Some are legit, such as the Google Toolbar, and similar offerings from Bing and Yahoo. But unfortunately, most of 

them are spyware or adware. 

 

Install one of these spyware toolbars and you will quickly be overwhelmed by pop-up windows advertising 

anything from fake security software to porn and "men's health" drugs. Some toolbars pop up ad after ad so rapidly 

they make it impossible to navigate or even close your browser in the normal way. The only option is to kill the 

web browser via Task Manager. 

Other spyware toolbars are more subtle. They may not annoy you with pop-ups but, in the background, they are 

quietly logging your Web surfing activity. Information about the sites you visit, links you click, and keys you press 
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is collected and transmitted to the spymasters. This data may be used to target ads to your interests, or it may be 

used to steal your usernames and passwords. Spyware toolbars can get even more aggressive. 

A toolbar may include a botnet Trojan that gives its master control of your computer. Email contact lists may be 

stolen and used to spam your friends. Credit card numbers and other personal data may be sniffed out wherever it 

resides on your hard drive.  

Steps to Remove a Toolbar 

Clearly, spyware toolbars should be removed. But that can be difficult. Right-clicking in the toolbar area may bring 

up a prompt to remove a toolbar from the browser. But don't rely on that to get rid of anything. At best, it will 

simply hide the offender. 

Start with the Windows uninstall app. Right-click on the Start button and then click on Programs and Features. 

Find the spyware toolbar in the list of installed programs and attempt to uninstall it. But even if the toolbar appears 

to be uninstalled, it may come back. 

Spyware toolbars sometimes install a hidden program or registry key that is not removed by its uninstall file. When 

you reboot your computer, this hidden program re-installs the spyware toolbar. You have to take extra steps to 

remove such malware. 

After uninstalling a toolbar, run a registry cleaner such as Privazer to remove leftover traces of the spyware 

installation from your registry. Also scan your hard drive with Malwarebytes. You may have to try several 

different anti-malware programs because no one program recognizes every breed of spyware toolbar. One such 

program is SuperAntiSpyware. 

There are free programs online that claim to specialize in removing toolbars. Some of these have been discovered 

to be "rogue anti-malware" that actually installs malware while claiming to remove toolbars. "Antimalware.com" is 
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one example fingered by Symantec as such a deceptive program. If a solution seems to be tailored exactly to your 

problem, it may actually be trying to take advantage of your pain and desperation to remove annoying toolbars.  

The best way to avoid the headaches of spyware toolbars is not to install toolbars from unknown sources. If you 

must install a Google search toolbar, get it directly from toolbar.google.com and not from some free app that you 

found online. The same goes for Yahoo and Windows Live toolbars. Avoid toolbars bundled with other free 

software, even if they appear to be from a trusted source. If you pay careful attention to all the prompts that appear 

during a software installation (especially pre-checked boxes), you can avoid many of these nuisances. 

ADD A GMAIL OR COX EMAIL ACCOUNT TO THE WINDOWS 10 MAIL APP 

The Mail app is a simple way to have all your email under one roof. The key is to sign in to your computer with 

your Microsoft account. You can create one using an email address you already have, or sign up for a new one—

it’s free.  

If other people also use your PC, make sure each person signs in to the PC with his own Microsoft account. That 

way, each person will only see his own mail. 

You probably already have a Microsoft account—it’s the email address you use to sign in to your Microsoft 

account in Windows 10. You might have used that Microsoft account when you set up your computer, so you 

might already be signed in with it. But if you’re not sure, here's how to check. 

Click Windows key + I for Settings, then click Accounts. Finally, click Your Email and Accounts. 

If you're already signed in with a Microsoft account, your screen should look like this. You’re all set!  

http://windows.microsoft.com/en-us/windows-8/microsoft-account-tutorial
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If you're signed in with a local account, your screen should look like this. Click Sign in with a Microsoft account 

instead and follow the instructions. 

 

HOW TO ADD A COX OR GMAIL ACCOUNT TO THE WIN10 MAIL APP 

If your email address ends in gmail.com or cox.net, here's how to add it. 

1. Open All Apps from the Start button. 

2. Click Mail.  

3. From the left column, click Accounts. 
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4. From the right column, click Accounts, click Add an account, and then click the type of account you'd like 

to add. Note that Google stands alone. Use Advanced Setup to add a Cox account. 

 

 

TO SETUP YOUR COX ACCOUNT: 

1. After clicking Add an Account, click on Advanced setup at the bottom of the list. 

2. Click on Internet email. 

3. Enter the account name (Cox). 

4. Enter your name. 

5. Enter Incoming email server: pop.west.cox.net. 

6. Under Account type, choose Pop3. 
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7. Enter your Cox email address. 

8. Enter your Cox username. 

9. Enter your Cox account password. 

10. Enter your Outgoing mail: smtp.west.cox.net. 

11. Four buttons at end of setup: Keep all four buttons checked. 

12. Click Done and watch synchronization copy files from Windows Live Mail to Win10 Mail. 

13. It may several minutes for sync to take place. To sync manually, click the icon that appears at the top of the 

column. 

 

 

TO SETUP YOUR GMAIL ACCOUNT: 

1. Click on Add an Account. 

2. Click on Google. 

3. Enter your Gmail email address and password. 

4. In the “Windows would like to…” box, click allow. 

5. Click Done and watch synchronization move your files from your gmail account to Win10 Mail. 

TO GET YOUR CONTACTS  

The Mail and People apps work together—you can see, add, and edit contacts for your accounts in the People app 

while managing email for the same account in the Mail app. For either your Cox account or your Gmail account, 

here’s how you add contacts. 

1. From All Apps, click People.  
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2. Click Settings. Click Accounts, click Add an account, click the type of account you'd like to add, and then 

follow the instructions on the screen. 

 

OE CLASSIC IS A GREAT ALTERNATIVE TO WINDOWS LIVE MAIL 2012 

 

Emails are one of the most used means of communication today, with millions of them sent on a daily basis. With 

the development of webmail services (ie, Gmail, Yahoo, Outlook.com) many people have switched from standard 

email clients even if webmail isn’t always the best option. Some users are unsurprisingly used to their favorite 

email client (Cox, perhaps) and prefer not to switch to webmail. If you’re one of those users, you might be 

interested in an email client called OE Classic (HYPERLINK). 

 

One of the best known email clients was Outlook Express, a workhorse that came with Windows XP, a program 

that was eventually replaced by Windows Live Mail in Windows 7. Microsoft released Windows Live Mail as an 

Outlook Express successor, with the upgraded and renamed email client receiving an enthusiastic reception from 

Windows users. Even though Windows Live Mail was released way back in 2007, it quickly became one of the 

most used email clients on a Windows platform. 

 

Microsoft kept working on Windows Live Mail for five years, but eventually the development of this email client 

was canceled. The last patch for this email client was released in 2012, and ever since Windows Live Mail has 

remained unchanged, leaving many of its bugs and vulnerabilities intact. Since Windows Live Mail isn’t being 

developed anymore, it might not be the best application to use.  

 

OE Classic is a small, simple email client, and its development team is constantly working on it— making it one 

of the safest and secure email clients available. The application takes the simplistic and minimalist design of 

Outlook Express and brings it to the Windows 10 platform. The email client is constantly being improved with new 

features, with the development team even entertaining feature requests.  

 

http://www.oeclassic.com/
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Before installing OE Classic, open your Windows Live Mail client and export both your messages and your 

contacts to your Desktop for easy access. 

 

 

Step 1: Copy Your Contacts from Windows Live Mail to Your Desktop 

1. Open Windows Live Mail. 

2. Click on Contacts. 

3. From the Menu bar, click on Export Contacts and Export contacts to a csv file. The following dialogue box 

will appear. 

 
4. Type Contacts in the box and click browse. 

5. The new empty Contacts file should be assigned a position on the Desktop so that it can be found easily.  
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6. Click on Next and then Save. The following dialogue box will appear 

 
7. At a minimum, make sure Name and Email Address are checked. It’s a good idea to uncheck many of the 

others. 

8. Finally, click Finish. 

9. The file (called Contacts) will appear as an Excel spreadsheet on your Desktop. (Note: you do not have to 

have the Excel program on your computer.) 

Step 2: Copy Your Messages from Windows Live Mail to Your Desktop 

Open your Windows Live Mail account. 

From the File tab, click on Export email, then email messages. 
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Select Microsoft Windows Live Mail, then click Next. 

In the next Window, click on Browse. 
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Click on the Desktop and then click Make New Folder. 

Rename the New Folder: Messages, then click OK. 

At the next window, click Next. 
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At the next window, click Next. 

At the following window, click on the All folders bullet, then Next. 
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Finally, click Finish. 

A file folder called Messages now appears on your Desktop, ready to be imported to the OE Classic application. 

Step 3: Download and Install the OE Classic Application  OE Classic (HYPERLINK). 

 

Once the application has been installed, locate it in All Apps on the Start Menu. 

Right-click on the App, click on More, then Pin to Taskbar. 

Now open the application from the Taskbar. 

Step 4: Import Your Contacts List from Windows Live Mail 

Click on the File tab, then Import. 

http://www.oeclassic.com/
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For your Address Book, click CSV file, then Next. 

 

Now, browse to your Desktop where you will locate your Contacts file. 
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Click Next. 

The snip of the next window that will appear during the Import has been omitted in order to protect the privacy of 

the names and email addresses of the author’s contacts list. 

Click Next. This action will install your contacts. 
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Click Finish 

 

Step 5: Import Your Email Messages from Windows Live Mail 

Click on the File tab, then Import. 
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Click on Multiple .EML files, then Next. 

Browse for the Message folder on your Desktop that you created earlier. Then click Next. 



Page 251 of 271 

 

 

This action will cause your messages from Windows Live Mail to be imported to OE Classic. 

Step 6: Import your Cox account into OE Classic. 

Click on the Tools tab, then Accounts. 
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Click on Add. 

On the next screen, click on Email Account, then Next. 
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Fill in the three boxes for your Cox account. 

Open and close the next three screens and your Cox account will be set up. 

Step 7: Change the order and number of columns listed for your messages. 

By default, your email messages have eleven columns of information about each message. Typically, most users 

want to have column headings of FROM  SUBJECT  SENT in that order, from left to right. 

Note that the program permits the user to reorder the column headings as well. Note also that you will probably 

want to personalize the columns in each folder. 

To get to the following window, click on the View tab, then Columns. 
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Step 8: Change the font type and size for outgoing mail. 

Click on the Tools tab, then Options, then Compose, which will take you to the screen below titled Compose. 

When you are done changing the type and size of the font you want, click OK. 

Step 9: If you want to have a Preview Pane for each selected message. 

Click on the Tools tab, then Options, then Layout, which will take you to the second screen below titled Layout.  

When you are done, click OK. 
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General: If you have a question for online user support: 

The F1 key will take you to a Program Table of Contents and Index. 

To communicate via email, click the Help tab on the Menu, then Contact. 
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COPY YOUR CONTACTS AND MESSAGES FROM WINDOWS LIVE MAIL TO YOUR GMAIL 

ACCOUNT 

Since Microsoft is doing to Windows Live Mail what it did to Outlook Express six years ago (namely, end support 

for the popular email client), you may want to transfer all your incoming and outgoing email messages, plus your 

contacts, to your gmail account. According to official (but very secretive) announcements from Microsoft, support 

will end for Windows Live Mail on June 30, 2016. Clearly, the Redmond, WA folks want us to move to the two 

new apps of Windows 10 for our email and contacts (Mail and People). 

Here’s how to make the transfer: 

1. Open your gmail account. If you don’t have one, it would be wise to do so. 

2. Click the Gear icon near the upper right corner. 

3. Click Settings. 

4. Click on the Accounts and Import tab. 

5. Click on Import Mail and Contacts. 

6. Type the name of your Windows Live Mail account, then continue. 

7. Finally, enter the necessary information that follows and choose what to input. 

 

SAVE EMAIL MESSAGES FROM WINDOWS LIVE MAIL FOR ARCHIVAL 

PURPOSES 

EXPORT ALL EMAIL MESSAGES FROM WINDOWS LIVE MAIL 

1. Launch Windows Live Mail. 

2. Click File on the Menu bar. 

3. Click Export Email. 
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4. Click Email messages. 

5. Click Microsoft Live Mail, then Next. 

6. Select folder to store exported messages. 

7. Click “make new folder.” Make sure the folder will be created on the Desktop so that it will be easy to locate 

later. 

8. Name the file “WLM MESSAGES”, then OK, then Next. 

9. Select All Folders, then Next. 

10. Click Finished. 

 

HOW TO CHANGE THE SIZE OF FONTS AND ICONS IN WINDOWS 10  

The Windows 10 operating system can run on PCs, laptops, notepads, and even mobile phones. However, to each 

device, the operating system possesses a specific font size and it’s not perfect for every application. Fortunately, 

you can adjust the size of the screen content to suit your needs. 

If you feel the displayed font size is too small or does not match the screen of the device you're using, you can 

customize the font size for the best fit.  

Here’s how. 

1. Press the WinKey + I to display Settings. 

2. Click on System. 

3. Click on Display. 

http://feedproxy.google.com/~r/Windows10Insider/~3/PSMsqQANqts/how-to-change-font-size-in-windows-10.html?utm_source=feedburner&utm_medium=email
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4. In the Change the size of text, apps, and other items box, move the lever to the right to create a size 

greater than 100%. 
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5. Once you change the size to over 100%, the following message will appear. 

 

6. Click on Sign out now. 

7. Your changes will take place after your computer reboots. 

 

CONNECT A WIRELESS PRINTER 

Windows 10 offers an easy way to install wireless printers at home. The procedure for installing them is easy and 

works the same for all printers and models. Just follow these steps: 

1. Open Settings.  

2. Click Devices. The settings related to devices are shown.  

3. Click Printers & Scanners. A list of available printers and scanners appears.  

4. Click Add a Printer or Scanner.  

5. Wait for Windows 10 to detect all the network printers that are available for installation.  
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6. When Windows 10 displays the printer that you want to install, click to select it.  

7. Click Add Device  

8. Wait for Windows 10 to install the printer and its drivers.  

9. When Windows 10 notifies you that the printer is ready, close Settings.  

10. Now you can start using the printer. 
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CHAPTER TWENTY-FOUR 

ISSUES WITH LAPTOPS 

Controlling Battery Drain on Your Laptop or Tablet 

Windows 10 includes a new “Battery Use” screen that shows you what’s draining your laptop’s battery. It will tell 

you exactly what apps–both legacy and modern apps–are using too much power. 

Note: This feature is not present in desktop computers, since they are not powered by battery. 

Find the Battery Use Screen 

Go to Settings (either from the Start menu or using Windows key + I), select “System” and then select “Battery 

saver.” You can also type “Battery saver” into the search box and select the “Battery saver” option. 
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On the right side of the screen, you will see an overview that displays how much battery life you have remaining, 

and how much time Windows estimates you’ll get from that. Click the “Battery use” link under this heading to see 

more details. 

Analyze Your Power Usage 

By default, the Battery Use screen will show information from the last 24 hours. However, you can also have it 

show information from the last 48 hours, or from the last week. 

To change this setting, click the dropdown box under “Showing battery use across all apps from the last” at the top 

of the screen and select “24 Hours,” “48 Hours,” or “1 Week.” 
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Below this box, you’ll see “System,” “Display,” and “Wi-Fi” percentages. This shows how much battery power 

has been used by system processes, the display (screen), and your Wi-Fi connection. 

You’ll probably see that the display is using quite a bit of power. To alleviate that, try lowering your 

screen’s brightness, or tell your display to go to sleep more often in Settings > System > Power & Sleep. 

The “In use” and “Background” options show how much power is used by applications while you’re using them, 

compared to applications running in the background. 

If apps are using power in the background, you can click the “Change background app settings” link and configure 

apps to not run in the background. This only works for universal/modern Windows 10 apps. They won’t 

automatically receive notifications, fetch new data for live tiles, or perform other background tasks. This can help 

you save battery power, especially if you don’t actually use those new Windows 10 apps. 
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Scroll down further and you’ll see a list of applications. This is the most useful part of the list, as it lists your 

legacy applications (Windows 7 and earlier) as well as modern apps (more recent than Windows 7). It’ll display a 

list of the apps that have used battery power in that period, and show you what percentage of your battery power 

each app has used. 

If an app doesn’t appear in the list here, you never used it while you were on battery, so it never consumed any 

battery power. 
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You can view more information about a specific application’s energy usage by clicking it and then selecting the 

“Details” button. You’ll be able to see what percentage of power the app used for system processes, the display, 

and Wi-Fi. You’ll also be able to see how much power the app used while you were actively using it, and how 

much it used when running in the background. 

As with the overview of all apps on the main screen, you can choose to view details for the last 24 hours, 48 hours, 

or one week. For example, here’s how much battery Google Chrome used on a demonstration laptop in the past 48 

hours: 
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You may see the word “Allowed” beneath some Windows 10 modern apps in the list. This indicates they are 

allowed to run in the background. You can select an app and then select the “Details” button to see more details. 

From here, you can disable the “Allow this app to run in the background” option and prevent the app from using 

power in the background. 
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How to Increase Your Laptop or Tablet’s Battery Life 

There’s no way around it: All applications you use will drain battery, and whatever applications you use the most 

will likely rank high in the list. Demanding applications–for example, PC games or video programs–will also use a 

lot of energy. 

The Battery usage screen provides options for controlling whether Windows 10 apps can run in the background, 

which should help you if you’re using that type of app. But there’s no way to control Windows desktop apps from 

the Settings screen. 

If a desktop application is sucking down a lot of power while running in the background, you may be able to save 

power by closing it when you’re not using it. If an application is using a lot of power while you’re using it, there’s 

not much you can do. You could try looking for an alternative application that isn’t as power hungry, or try to 

make the application more lightweight–for example, by uninstalling browser extensions, enabling click-to-play 

plug-ins, and having fewer tabs open at once in your web browser. 

http://www.howtogeek.com/240090/how-to-uninstall-extensions-in-chrome-firefox-and-other-browsers/
http://www.howtogeek.com/188059/how-to-enable-click-to-play-plugins-in-every-web-browser/
http://www.howtogeek.com/188059/how-to-enable-click-to-play-plugins-in-every-web-browser/
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It’s not just apps, either–plenty of other settings can affect your battery life. The display backlight uses quite a bit 

of power, so lowering your display brightness will help. Having your PC automatically sleep more quickly can also 

help if you’re not in the habit of putting it to sleep when you step away.  

The Battery usage screen isn’t a one-stop shop for making applications use less power. However, it is a convenient 

way–and the only way in Windows–to see which apps are using the most power. This information doesn’t even 

appear in the Task Manager. 

With this information, you can get an idea of where your power is going and make informed decisions to help 

stretch your battery life. 

 

DISABLE YOUR TOUCHPAD WHILE TYPING 

When you are typing a text on your laptop and your thumb accidentally brushes the touchpad, this contributes to an 

unwanted change in the position of the cursor in your document and you need to start typing again.  

Some touchpads can be turned off by opening the mouse in the control panel and disabling the function. 

Most laptops recognize the keyboard shortcut of either Fn + F6 or Fn + F8 to temporarily disable the touchpad. 

Unfortunately, this approach is not permanent and must be done after each reboot. 

To find out how you can turn off the touchpad on your laptop, go to the manufacturer’s Website and type disable 

the touchpad in the search or find box. 

Some laptops don’t have dedicated buttons but you can use Function keys (like Fn + F5 on Dell computers) to 

toggle the state of your touch pad.   In the case of HP laptops, you can hold the top-left corner of the touchpad for a 

few seconds and it will disable the touch pad – repeat this to re-activate it. 
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New laptop computers either have a physical on/off button to easily disable the touch pad or there’s an icon in the 

system tray that lets you manage the various settings of the touchpad. If you don’t have that icon, you can go to 

Control Panel – > Mouse Properties – > Touch Pad   to enable or disable the touchpad. 

The touch pad can also be disabled through the device manager (Windows + X, then M). Expand “Mice and other 

Pointing devices”, right-click and disable the driver entry that says Touch pad or something similar. 

If none of the above solutions work for your brand of laptop, try TouchPad Pal – it’s a free Windows utility that 

will temporarily disable the touchpad of your laptop as you go into typing mode. The utility runs in the system tray 

and requires no configuration. 

SUGGESTIONS FOR EXTENDING YOUR LAPTOP’S BATTERY LIFE 

It's important to understand what drains the most power in your laptop. In modern laptops, the monitor consumes 

about 43 per cent of normal operating power. Inside the unit, the video, graphics, audio, math coprocessor, etc. eat 

another 22 per cent. The central processing unit accounts for 9 per cent of power consumption, while a graphics 

processor takes another 8 per cent. The hard drive takes only 5 per cent, and network adapters consume only 4 per 

cent. So obviously, power conservation efforts should focus first on the monitor.  

How to tweak your settings to save battery power on your laptop 

Microsoft Windows has a Power Options section (Windows + X, then O) that can help you optimize your laptop's 

performance with regard to the trade-off with power consumption. You can use one of the pre-defined Power Plans 

that will be activated depending on whether you're operating on battery or wall power. The plans control how 

bright the display is; when to turn off the display during periods of inactivity; when to turn off the hard drive to 

save power; and what CPU performance level to use when on battery power. Tweaking these plans to fit your 

computing habits and performance needs can extend battery life significantly. 

You can also manually adjust the display brightness to suit the environment; you don't really need the brightest 

setting in a dim family room or den. On most laptops, you can change the screen brightness by holding down the 
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Fn button and pressing one of the function keys on the top row of the keyboard. On a Toshiba laptop, for example, 

Fn+F6 reduces the brightness, and Fn+F7 will make it brighter. On Lenovo laptops, it’s the up arrow and down 

arrow. When power is low, turn it down as much as possible. 

To further stretch your battery time, avoid video games, listening to music, watching videos (especially high-

resolution videos) and other graphics-intensive applications while on battery.  

Turn off the wifi adapter if you don't need to access the Internet.  

Don't try to charge your smart phone via the laptop’s USB, if your computer's battery life is dwindling. 


